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1 About TeslaSCADA IDE

TeslaSCADA IDE is an integrated development environment used for con?guring,

developing and managing HMI/SCADA applications. In this manual you will ?nd everything

you need to create a full-featured SCADA (Supervisory Control and Data Acquisition) project

visualization. With this tool you can create and manage TeslaSCADA projects, con?gure

connections with devices, enter tags, alarms, and trends. 

A simple to use interface allows for easy manipulation of the project’s con?guration and

data processing. The project data are stored in a single ? le (based on xml) for easy backup and

restoration. 

TeslaSCADA IDE has an integrated GUI (Graphical User Interface) visualization editor for

easy creation of professionally looking graphics.

Main features of TeslaSCADA projects

§ Use on MacOS, Windows, Linux, Android and iOS.

§ Supports many industrial protocols - Modbus RTU and TCP(UDP), Siemens ISO/TCP,

Ethernet/IP, Omron FINS/TCP(UDP) devices, OPC UA and MQTT servers.

§ Lots of graphical objects for developing screens.

§ Supports user-defined images in *.png, *.jpg and *.gif format.

§ Supports creating group objects.

§ Supports scripts based on FBD and ST language.

§ Supports events. Use SQL Lite or MySQL databases to store tag's event information.

§ Supports event notifications by E-mail, Telegram messenger and third part HTTP

services.

§ Supports history. Use SQL Lite or MySQL databases to store tag's history information.

§ Configure user permissions.

§ Web-server.

§ Report system in Excel.

§ Direct printing reports.

§ Supports Import/Export screens, tags (including excel format), scripts. 

§ Supports touch panel.

§ Supports sound notification on alerts. 

Also information about TeslaSCADA2 you can find on our site:

https://teslascada.com/products/teslascada2

There are 2 possible ways to use TeslaSCADA:

§ Direct architecture .

§ Client-server architecture .

11
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1.1 Direct architecture

In the simplest process control system based on TeslaSCADA, every device (computer or

mobile) is, in fact, a server, since it reads and writes tag values from/to devices, works with a

database, etc. 

The advantage of this architecture is that there is no need to use some intermediate

device for the server. All connections are made directly to industrial devices and servers. A PC or

mobile device can be used as an HMI.

The disadvantages of such a system are that with a large number of devices (PCs and

mobiles) with TeslaSCADA, there is a load on the controller, the exchange of data when

communicating with the controllers is via an unencrypted channel, and all the necessary

calculations in scripts are carried out on each device.

1.2 Client-Server architecture

If your process control system is large and you want to use many devices (PC or mobile) with

TeslaSCADA for display and control. You can use Client-Server architecture:
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A built-in (or third-party) OPC UA server or built-in HTTP-server or a third-party MQTT broker

can be used as a server. 

The advantage of this architecture is to reduce the load on the controller when using a large

number of devices with TeslaSCADA, encryption when exchanging data with the server

(especially important for mobile devices used remotely) and the ability to perform all

calculations on the server. 

The disadvantage of this architecture is the need to use an intermediate device with an installed

OPC UA server, HTTP-server or MQTT broker.
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2 System requirements

TeslaSCADA IDE requires Windows, Mac OS or Linux operating systems. 

2.1 Windows

Processors: Intel Pentium 4, Intel Centrino, Intel Xeon, or Intel Core Duo (or compatible) 1.8

GHz minimum. 

Operating systems: Windows 10, Windows 8 (Modern UI (i.e. Metro Mode) is not supported),

Windows 7, Windows Vista, Windows XP (not recommended but supported). 

Memory: 1 GB (2 GB recommended). 

Disc Space: 2 GB of free disc space (4 GB of free disc space). 

2.2 MacOS

Processors: Dual-Core Intel, PowerPC G5 

Operating systems: 10.7.3 or greater 

Memory: 1 GB (2 GB recommended). 

Disc Space: 2 GB of free disc space (4 GB of free disc space).

2.3 Linux

Processors: Intel Pentium 4, Intel Centrino, Intel Xeon, or Intel Core Duo (or compatible) 1.8

GHz minimum. 

Operating systems: Ubuntu 10.4 + gtk2 2.18+ Memory: 1 GB (2 GB recommended). 

Disc Space: 2 GB of free disc space (4 GB of free disc space). 

Media: You must install the following in order to support AAC audio, MP3 audio, H.264 video,

and HTTP Live Streaming:

libavcodec52 and libavformat52 on Ubuntu Linux 10.04, 10.10, 11.04 or equivalent.

libavcodec53 and libavformat53 on Ubuntu Linux 11.10, 12.04 or equivalent.

Important: We've tested Linux version only on Ubuntu 14, Ubuntu 20, РЕД ОС and Astra

Linux (Orel) OS. Unfortunately we didn't test it on other Linux OS.

2.4 Raspberry PI

Processors: processors on Raspberry PI 3,4

Operating systems: Raspbian

Memory: 1 GB (2 GB recommended). 

Disc Space: 2 GB of free disc space (4 GB of free disc space)..
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3 Installation

Installation depends on operating system.

3.1 Windows

To install TeslaSCADA IDE download EXE package for your operating system, then you need to

run the installation file:

Then the window for selecting directories for the main program files and user data will be

displayed. It is recommended to install the "system" part of TeslaSCADA IDE to the system

drive in the "C:\TeslaSCADA_IDE\" folder, and the folder with user files can be selected at the

user's discretion. The main thing is that the OS allows the creation, modification and deletion of

files in this folder without requiring administrator rights. Also if you want to use Web Server the

path shouldn't contain white spaces. After selecting the directories, click "Next":
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After clicking "Next" application will be installed:

After the installation is complete, TeslaSCADA IDE will be started automatically:
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To study folder where you install TeslaSCADA IDE open it:

Consider its contents:

§ app - contains application information.

§ runtime - contains JRE. TeslaSCADA based on Java language. The folder runtime contains

JRE for Windows environment. If you don't use Web server in your project you no need to
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install Java separately. TeslaSCADA IDE will work any way. If you want to use Web server

in your project you have to install Java on your PC.

Let's study app folder:

Consider its contents:

§ Projects - default project folder of TeslaSCADA IDE. You can save projects in other folders.

§ DB - project contains SQL Lite databases. If you use SQL Lite databases for history, events

and recipes there will be stored in this folder.

§ private - contains certificates and keys for OPC UA and MQTT protocols if you use OPC

UA or MQTT clients in your project.

§ Certs - contains certificates and keys for OPC UA server if you use it.

§ TeslaSCADA_IDE-debug  - contains Log information about application working.

§ Other folders and files - related to working of application and Web server.
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Install TeslaSCADA2 on Windows

3.2 MacOS

To install TeslaSCADA IDE download DMG package for your operating system. DMG package

provides a simple possibility to install application by double clicking on it:
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By using left mouse button of the mouse drag and drop TeslaSCADA IDE in Applications. No

you can open it in Applications.

Important! Sometimes you've got error message: “TeslaSCADA_IDE.app is damaged and
can’t be opened. You should move it to the Trash.” Like in the picture below: 

To solve this problem you should open Terminal and execute the command below:

sudo xattr -rd com.apple.quarantine /Applications/TeslaSCADA_IDE.app

To study folder in Applications click by right mouse button on TeslaSCADA_IDE and choose

Show Package Contents. You'll see:



TeslaSCADA2 IDE User manual20

© 2023 LLC Tesla

Consider its contents:

§ Java - contains application information.

§ PlugIns - contains JRE. TeslaSCADA based on Java language. The folder runtime contains

JRE for MacOS environment. If you don't use Web server in your project you no need to

install Java separately. TeslaSCADA IDE will work any way. If you want to use Web server

in your project you have to install Java on your PC.

§ MacOS and Resources - related to working application.

Let's study Java folder:

Consider its contents:

§ Projects - default project folder of TeslaSCADA IDE. You can save projects in other folders

(it's not shown in this picture).

§ DB - project contains SQL Lite databases. If you use SQL Lite databases for history, events

and recipes there will be stored in this folder.

§ private - contains certificates and keys for OPC UA and MQTT protocols if you use OPC

UA or MQTT clients in your project (it's not shown in this picture).

§ Certs - contains certificates and keys for OPC UA server if you use it (it's not shown in this

picture).

§ TeslaSCADA_IDE-debug  - contains Log information about application working.

§ Other folders and files - related to working of application and Web server.
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Installation TeslaSCADA2 on MacOS

3.3 Linux

To install TeslaSCADA IDE download RPM package for your operating system. Right click

mouse button on RPM package and choose Extract Here:
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 By default RPM package will install the application to /opt, add a shortcut to the application

menu. RPM package does not have any UI for installation (normal behavior for Linux). Let's

study opt folder. In this folder you can find TeslaSCADA_IDE folder. When you open it:

Consider its contents:

§ app - contains application information.

§ runtime - contains JRE. TeslaSCADA based on Java language. The folder runtime

contains JRE for Linux environment. If you don't use Web server in your project you no

need to install Java separately. TeslaSCADA IDE will work any way. If you want to use

Web server in your project you have to install Java on your PC.

Let's study app folder:

Consider its contents:
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§ Projects - default project folder of TeslaSCADA IDE. You can save projects in other

folders (it's not shown in this picture).

§ DB - project contains SQL Lite databases. If you use SQL Lite databases for history,

events and recipes there will be stored in this folder.

§ private - contains certificates and keys for OPC UA and MQTT protocols if you use OPC

UA or MQTT clients in your project  (it's not shown in this picture).

§ Certs - contains certificates and keys for OPC UA server if you use it  (it's not shown in

this picture).

§ TeslaSCADA_IDE-debug  - contains Log information about application working.

§ Other folders and files - related to working of application and Web server.

Important: We've tested Linux version only on Ubuntu 14, Ubuntu 20, РЕД ОС and Astra

Linux (Orel) OS. Unfortunately we didn't test it on other Linux OS.

Install TeslaSCADA2 on Linux

3.4 Raspberry PI

Package for Raspberry PI doesn't contain JVM. First you have to install Java 11 with Java FX. We

recommend to install Java 11 from Bell Soft for ARM 32 bit. You can do it by downloading

installation from the link. Then you can install Java 11 with Java FX libraries by using command:
sudo apt-get install ./bellsoft-jdk11.0.11+9-linux-arm32-vfp-
hflt-full.deb
After that you can download archive from our site and unpack it: 

https://bell-sw.com/pages/downloads/#/java-11-lts
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You can start TeslaSCADA2 IDE by double clicking on the script TeslaSCADA2IDE.sh.

You can start TeslaSCADA2 Runtim by double clicking on the script TeslaSCADA2Runtime.sh.

Install TeslaSCADA2 on Raspberry PI
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4 Databases

The databases in TeslaSCADA2 are necessary for archiving alarms, operator actions, trends and

recipes. When archiving into a database, the subsequent retrieval of data (viewing trends,

messages) is much faster, especially over long time intervals. TeslaSCADA2 supports 2 types of

databases:

§ SQLite

§ MySQL

§ MSSQL

§ PostgreSQL

Event database

The database for collecting events you can setup in Project properties->Events/History

tab  in Events DB name field. There are several types of events saved in database:

§ Tag's events. You can setup them in Tag properties->Alarms tab .

§ Server events. This information about connection, disconnection and lost connection

servers  in the project.

§ User  login/logout information.

§ If you setup in User settings  it's possible to save user operation.

You can show all events by Events log  graphical object from Events library.

General history database

The database for collecting history information you can setup in Project properties-

>Events/History tab  in History DB name field. If you want that tag's history information is

saved in this database you have to Enable history in Tag properties->History tab , setup

Storage period and check Store in DB.

The history values will be saved every storage period during execution if the value of the tag is

changed (if Use deadband is enabled the delta between current value and value last saved

should be greater Deadband).

You can show history information collected in General history database by using Trend

DB  graphical object from Trends and charts  library.

History database

It's another way for collecting history information. The differences between General

history database and History database , that is in History database you save only selected

tag's values and values are saved in two ways:

§ Time interval. Tags values are saved every time interval independently values are changed

or not.
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§ Tag. Tags values are saved when set tag's value become TRUE independently saved

values are changed or not.

You can create history database in Project Window  -> Databases  or in the menu item

Project ->New Database  of the Main menu . 

Tag's value will be saved in the History database if you check Enable history in Tag properties

(you no need to check Store in DB in this case) and include this tag in History database

properties collection of tags.

 Like for General history database you can use as SQLite  as MySQL  databases. 

You can show history information collected in History database by using History DB

table  and History DB trend  from History DB  library. History Excel Report  and

History Max and Min Report also work with this database.

Recipe database

The database for working with recipes and parameters. You can create recipe database

in Project Window  -> Databases  or in the menu item Project ->New Database  of

the Main menu .

Like for events and history databases you can use as SQLite  as MySQL  recipe

databases.

You can show recipe information collected in Recipe database by using graphical

objects from Recipes library.

4.1 SQLite

If you want to use SQLite database in your project you no need to install any additional

software on your PC. All databases create automatically during application running. Databases

are stored in the folder DB  in the place where installed TeslaSCADA2. If you want to open

database use some SQLite DB browsers. For example for Windows you can use this one:

https://sqlitebrowser.org/dl/. How looks SQLite database in this browser you can watch here:
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DB data looks like here:
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4.2 MySQL

To work with MySQL databases you have to install it on your PC. This chapter provides a step-

by-step overview of the MySQL database installation process on Windows PC - this does not

require special skills and knowledge, everything is quite simple. TeslaSCADA2 works with

MySQL versions 5.6.2 and higher. The current MySQL version can be found on the official

download page: https://dev.mysql.com/downloads/windows/installer/

Important! On Windows 7 x32 only MySQL 5.7.25 can be installed.

After going to the download page at the bottom you can see the "MySQL Installer" block -

click "Download":

To download MySQL without registration, click on the link "No thanks, just start my download":

https://dev.mysql.com/downloads/windows/installer/
https://dev.mysql.com/downloads/windows/installer/5.7.html
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After the download is complete, you should make sure that the components necessary for

installing MySQL are installed on the system:

• Microsoft .NET Framework 4.5.2

• Microsoft Visual C ++ Redistributable for Visual Studio 2015

We select the default installation type "Developer Default" and click "Next":

https://www.microsoft.com/ru-ru/download/details.aspx?id=42642
https://www.microsoft.com/ru-ru/download/details.aspx?id=48145
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Next, the installer will show a list of components in the "For Product" column and a list of

software required to install them in the "Requirement" column. For example, this list might

include MySQL Workbench if Microsoft Visual C ++ Redistributable for Visual Studio 2015 is

not installed on the system.  If you ignore the warning and continue with the installation,

MySQL Workbench will not be installed. To install Microsoft Visual C++ Redistributable for

Visual Studio 2015 click "Execute".  Installation of other components is not required - you can

continue the installation by clicking "Next":
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A warning will appear - press "YES":

Then the installer will show you what exactly it will install, click "Execute":
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Important! If during the installation MySQL Server does not install with the error "This

application requires Visual Studio 2015 Redistributable. Please install the

Redistributable then run this installer again", then you need to install the 32-bit

package Microsoft Visual C ++ Redistributable for Visual Studio 2015 (vcredist_x86)

even if you are using a 64-bit operating system.

The installation process begins. After installing all the components, the "Next" button will

appear, click it:
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Next, you need to configure the MySQL server, click "Next":

Select the "Standalone MySQL Server / Classic MySQL Replication" item and click "Next":
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Next, in the "Config Type" parameter, select "Server Computer" and click "Next":

Select "Use Strong Password Encryption for Authentication" and click "Next":
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In the next window, you need to set a password for the root user (administrator). Also, here

you can add other users (by clicking the "Add User" button), if necessary. After entering the

password, click "Next":
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At the next step, we leave all the default settings, click "Next":

Next, you need to apply the MySQL server settings by clicking "Execute":



Databases 37

© 2023 LLC Tesla

MySQL server is configured, click "Finish":

Next, let's move on to configuring MySQL Router. Click "Next":
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Leave all the default settings and click "Finish":

Now you need to check the created database, click "Next":
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Check the connection. Enter the password, click "Check", then click "Next":

Next, click "Execute" and then "Finish":
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Installation is almost complete, click "Next":
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Installation is complete - click "Finish". If you check the "Start MySQL Workbench after Setup"

box, the MySQL Workbench  program will start, in which you can make additional database

settings.
You have to create a database  in MySQL server by using MySQL Workbench manually. After

creating database you can use it for collecting event and history information. To do this open

Project properties and in Event/History tab  setup My SQL database by using jdbc:mysql: at

the beginning of the Events DB name and History DB name:

42
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In our case it's: jdbc:mysql://192.168.1.6:3306/test

Where:

1. jdbc:mysql: - beginning for MySQL. 

2. 192.168.1.6:3306 - IP address and port.

3. test - name of the database (created in MySQL Workbench ).

Also you can use My SQL database in Databases - Recipes and History DB. To do this in Db

name of the database use jdbc:mysql: at the beginning also.

Important! If you get during first running TeslaSCADA2 IDE or TeslaSCADA2 Runtime

the Error message like this: java.sql.SQLException: The server time zone...You have to

setup time zone for your My SQL server to do this open MySQL Workbench .

4.2.1 MySQL Workbench

MySQL Workbench is a visual database design tool that integrates database design, modeling,

creation and operation. Its capabilities will be useful to us for:

• backing up and restoring the database (also useful for transferring the database to

another PC).

• settings for connecting to a remote database.

44
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https://ru.stackoverflow.com/questions/902721/java-sql-sqlexception-the-server-time-zone-mysql-8
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• changing the path of saving the database - "by default" is saved to disk "C".

• viewing database statistics.

If the database was installed according to the instructions in the previous section, then MySQL

Workbench was installed along with MySQL, otherwise it can be downloaded from this link:

http://dev.mysql.com/downloads/workbench/

After starting MySQL Workbench, you need to select an instance of the MySQL server in order

to connect to it. In our case, it is only one (local) - click on it:

Enter the root user password (which was invented when setting up MySQL):

After connecting to the MySQL server, we will see the start page:

http://dev.mysql.com/downloads/workbench/
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1. Administration - Settings of the MySQL server.

2. Schemas (Database area) - the list of created databases is displayed here. Also, when you

first turn it on, test databases can be displayed here - they can be deleted by clicking on the

name of the database with RMB - a pop-up menu will appear in which you need to select

"Drop Schema".

Create database

You have to create database manually:

Open "Schemas" tab. Click "Create a new schema in the connected server" icon:

Enter "Name" of the schema and click Apply:
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"Apply SQL script to Database" window will be appeared. Click Apply:

Then click "Finish":
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Change server time zone

If you get during first running TeslaSCADA2 IDE or TeslaSCADA2 Runtime the Error message

like this: 

You can fix it in 2 ways:

1. Set global by SQL query (it's a temporary solution, after restart your MySQL server the

problem will return).

To do this uou have to setup time zone for your My SQL server to do this open MySQL

Workbench and click icon "Create a new SQL tab for executing queries":
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Enter: SET GLOBAL time_zone = '+3:00'; 
Where instead of '+3:00' you have to enter your time zone. And then click "Execute..." icon:

Now you can try Run TeslaSCADA2 project again in TeslaSCADA2 IDE or in TeslaSCADA2

Runtime.

2. Change my.ini (Windows) or my.inf (Linux) file. 

2.1 Find my.ini or my.inf file. It's an initialization file for MySQL server. Usually it's placed in

C:/ProgramData/MySQL/MySQL Server 8.0/:
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2.2. Open file my.ini and add this line: default-time-zone='+03:00' Where instead of '+3:00'

you have to enter your time zone.

2.3. Save file (your current user should have access to this folder).

2.4. Restart your MySQL server.

Now you can try Run TeslaSCADA2 project again in TeslaSCADA2 IDE or in TeslaSCADA2

Runtime.

Settings required for connecting to a remote database
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1.Select the item "Users and Privileges".

2. Select the user "root".

3.In the "Limit to Hosts Matching" field, enter "%".

4. Save the changes by clicking the "Apply" button.

Now you can connect to the database from a remote PC.

Changing the database save path

To change the path for saving the database, you must do the following:

• stop the MySQL service via Windows services.

• move the entire "data" directory from the current location (by default "C: \ ProgramData \

MySQL \ MySQL Server 5.x \ data") to a new one (cut - paste).

Next, you need to run MySQL Workbench "as administrator" and change the "datadir"

parameter to a new location for the data directory:
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4.3 MSSQL

To work with MSSQL databases you have to install MSSQL server on your PC. How to install

MSSQL server you can find in the Internet. For example how to install Express version you can

find here. Important! For TCP / IP connection, the user must be created in SQL Server with the

ability to authorize through the SQL server (not through Windows!):

https://www.sqlshack.com/how-to-install-sql-server-express-edition/
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And you have to provide user possibility to create tables, read, write into database and other

function. The most easy way to is to provide sysadmin server role:
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And SQL Server itself should allow more than just Windows authentication:



Databases 53

© 2023 LLC Tesla

Also don't forget to check your firewall. Port is used by MSSQL server (default 1433) should be

opened.

4.4 PostgreSQL

To work with PostgreSQL databases you have to install PostgreSQL server on your PC. How to

install server you can find in the Internet. For example here. To setup firewall use this command

in command line (should be started under Administrator rights):
netsh advfirewall firewall add rule name="Postgre Port" dir=in action=allow protocol=TCP localport=5432

Settings required for getting exception in English
If you are getting exceptions with not readable symbols (actual for users who doesn't use

english language) you have to find file postgresql.conf in the directory where install

PosgreSQL server. Find property lc_messages and change it into 'en-En.utf-8'. Save the file and

restart postgresql service (you can find it task manager ->Services tab).

Settings required for connecting to a remote database
In order to remotely access a PostgreSQL database, you must set the two main PostgreSQL

configuration files:

postgresql.conf

https://www.sqlshack.com/how-to-install-postgresql-on-windows/
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pg_hba.conf

Here is a brief description about how you can set them (note that the following description is

purely indicative: To configure a machine safely, you must be familiar with all the parameters

and their meanings). First of all configure PostgreSQL service to listen on port 5432 on all

network interfaces in Windows machine:

open the file postgresql.conf (usually located in C:\Program Files\PostgreSQL\{your version}

\data) and sets the parameter

listen_addresses = '*' (if it didn't setup)

Open and add in the pg_hba.conf file:

host    all             all              0.0.0.0/0                       md5

Save the files and restart postgresql service (you can find it task manager ->Services tab).
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5 Start TeslaSCADA IDE

After opening the application you will see the start screen. Look at the picture below to brie?y

get to know the TeslaSCADA IDE interface: 

There are several zones: 

§ Main menu

§ Toolbar

§ Project window

§ Canvas

§ Property sheet

§ Screen window

§ Status bar

§ Debug window - you can slide up debug window between Status bar and Canvas to

monitor ST scripts messages by print function.
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Start TeslaSCADA2 IDE

Quick Start TeslaSCADA2

5.1 Main menu

File  - manipulation with project ? les. 

Edit  - manipulation with objects (cut, copy, paste and etc.). 

Arrange  - arrange manipulation with objects (align, rotate and etc.). 
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Project  - possibility to create new objects of the project, change its properties and run/stop

simulation. Also in this menu you can login (change operator) and make screenshots. 

Language - possibility to change language of the interface. 

Help - opens the help menu.

Main menu

5.1.1 File

.

New - create a new project .

Open - open existing project.

Save - save project under the current name.

Save as... - save project under a new name.

Import for iOS  - import project in iOS format. For iOS devices, a different format is used

than the format used for desktop and Android devices.
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Load on Device  - call dialog box for uploading current project on remote desktop or

Android device.

Exit - exit application.

File menu

5.1.2 Edit

Undo - undo the last action.

Redo - redo the last action.

Duplicate - duplicate selected graphical object(s).

Cut - cut selected graphical object(s).

Copy - copy selected graphical object(s).

Paste - paste selected graphical object(s).

426
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Erase - erase selected graphical object(s).

Apply changes... - apply changes of the selected object for all objects with the same name. In

the window that appears, you must choose to replace tags or not.

Apply changes for template... - apply changes of the selected group object for all objects

with the same template name. In the window that appears, you must choose to replace tags or

not.

Edit menu
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5.1.3 Arrange

Send to Back - send to back of the screen selected object.

Bring to Front - bring to front of the screen selected object.

Align  - align selected objects.

Rotate Clockwise - rotate clockwise selected object(s). To current rotation angle 90 degrees

will be added.

Rotate CounterClockwise - rotate counter clockwise selected object(s). From current rotation

angle 90 degrees will be subtracted.

Group Objects - group selected graphical objects.

Ungroup Objects - ungroup selected group of graphical objects.

Lock - lock selected object. You'll not be able to move this object after lock it.

Unlock - unlock selected object. You'll be able to move this object after unlock it.

Zoom out - zoom out screen.

Zoom equal - return to initial screen scale.

Zoom in - zoom in screen.

Snap to Grid - enable/disable the display of the grid on the drawing area.

Set grid step - setup the size of grid cells.

61
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Arrange menu

5.1.3.1 Align

Align Left - align the selected graphical objects to the left.

Align Center - center selected graphical objects horizontally.

Align Right - align the selected graphical objects to the right.

Align Top - align the selected graphical objects to the top.

Align Middle - center selected graphical objects vertically.

Align Bottom - align the selected graphical objects to the bottom.

Space Horizontal - distribute the selected objects evenly horizontally.

Space Vertical - distribute the selected graphical objects evenly vertically.
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5.1.4 Project

New Screen  - create new screen in the project.

New Server  - create new server in the project.

New Script  - create new script in the project.

New Tag  - create new tag in the project.

New User  - create new user in the project.

New Database  - create new database in the project.

New Report - create new report in the project.

New Object  - add new graphical object in the project.

Run simulation - run simulation of the project.

Stop simulation - stop simulation of the project.

Login - logout and login new user.

Properties  - open project properties window.

Number of used tags... - call dialog box with information about number of tags used in the

project. It's useful if you want to check license you need if you want to buy tags dependent

license.

Make screenshot - make screen shot of the project.

Show properties values - check this menu item if you want to monitor properties values by

placing the mouse cursor over the graphical object during run simulation.

Show property sheet - check if you to edit properties of the graphical object in property sheet

or uncheck if you want edit properties only in graphical object dialog boxes.
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Virtual keyboard  - check if you want to use virtual keyboard. It's useful if you want to use

your project on sensor panel.

Style - choose style of the IDE (MODENA or CASPIAN).

Project menu

5.1.4.1 New server

Modbus RTU  - create new Modbus RTU server and open window to edit its properties.

Modbus TCP(UDP)  - create new Modbus TCP(UDP) server and open window to edit its

properties.

Siemens  - create new Siemens server and open window to edit its properties.
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Allen Bradley  - create new Allen Bradley server and open window to edit its properties.

OPC UA  - create new OPC UA server and open window to edit its properties.

MQTT  - create new MQTT server and open window to edit its properties.

Omron  - create new Omron server and open window to edit its properties.

BACnet/IP  - create new BACnet/IP server and open window to edit its properties.

Raspberry GPIO  - create new Raspberry GPIO server and open window to edit its

properties.

HTTP-server  - create new HTTP server and open window to edit its properties.

Cloud  - create new Cloud client and open window to edit its properties.

5.1.4.2 New Database

Recipe  - create database for recipe and open window to edit its properties.

History  - create database for history and open window to edit its properties.

Odoo ERP  - create object to work Odoo ERP and open window to edit its properties.

5.2 Toolbar

The toolbar consists of the following functions:

New project Creates a new project.

Open project Opens an existing project. 

Save Saves your project.

Save as Saves your project with a new name. 

Properties Properties of your project. 

Snap to Grid ON/OFF snap to grid. 

New object Creates a new graphical object. 

Run simulation Start simulation of your project. 

Stop simulation Stop simulation of your project. 

Login Change (logout/login) user.

Cut Cut selected object(s). 
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Copy Copy selected object(s). 

Paste Paste selected object(s). 

Undo Undo the last operation.

Redo Redo the last operation. 

Send to Back Send to back selected object. 

Bring to Front Bring to front selected object. 

Align Left Align to the left side the selected objects. 

Align Center Align the vertical center of the selected objects. 

Align Right Align to the right side the selected objects. 

Align Top Align on top of the selected objects.

Align Middle Align the horizontal center of the selected objects. 

Align Bottom Align to the bottom of the selected objects.

Space Horizontal
Align the horizontal spacing between the selected

objects.

Space Vertical
Align the vertical spacing between the selected

objects. 

Rotate Clockwise Rotate clockwise selected object(s). 

Rotate Counter

Clockwise
Rotate counterclockwise selected object(s).

Group Objects Group selected objects. 

Ungroup Objects Ungroup selected objects. 

Lock Object Lock object to the position

Unlock Object Unlock object from the position. 

Zoom Out Zoom out screen with all objects. 

Zoom Equal Zoom screen with all objects to original sizes.  

Zoom In Zoom in screen with all objects. 

Find Find graphical object. Name you enter in the field.
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Toolbar

5.3 Project window

Project window contains:

·  Project name. You can change project name in the Project properties. If a "*" is displayed

next to the project name, then changes have been made to the project since the last save.

· Tab Screens . This tab contains all screens used in the project.

· Tab Scripts . This tab contains all scripts used in the project.

· Tab Servers . This tab contains all servers used in the project. Server refers to all devices

and servers to which you are connecting.

· Tab Tags . This tab contains all tags used in the project.

· Tab Users . This tab contains all users used in the project.

· Tab Databases . This tab contains all databases used in the project.
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Project window

5.3.1 Screens

The screens are shown in the table. The first column contains the screen name, the second

column contains the screen type - General or Popup:

You can hide or show columns by clicking "+" button:
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By clicking right button on the screen you can call context menu:

List of menu items with their functions:

§ New Screen  - create a new screen. You can also create a new screen in the main menu

Project ->New Screen. Then dialog window will be opened for editing screen

properties.

§ Open Screen - open the screen. It is opened for design purposes. You can also open the

screen by double clicking on it.

§ Copy Screen - copy the screen. It is copied with all graphical objects on it.

§ Delete Screen - delete the screen. It is deleted from the project.

§ Screen properties - open window for editing screen properties.
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62



Start TeslaSCADA IDE 69

© 2023 LLC Tesla

§ New Screen Group - create a new screen group. It's useful to simplify the structure of

the project.

§ New Screen Subgroup - this menu item is shown when your right click on the screen

group. It creates new screen's sub group. It's also useful to simplify of the project

structure.

§ Add to Group - add this screen to the screen group or subgroup from the list.

§ Export Screen - export this screen for another project. File is saved with .tsp2screen

extension.

§ Import Screen - import the screen from the file with  .tsp2screen extension.

§ Export Screen (Sub)Group - export all screens of the group or(and) subgroups

including global images of these screens. File is saved with .tsp2groupscreen extension.

§ Import Screen (Sub)Group - import screens of the group or(and) subgroups, including

global images of these screens, from the file with .tsp2groupscreen extension.

§ Export Screen for Cloud - export screen for cloud. File is saved with .tsp2json extension.

You can upload this file on ESP device and use it for WEB interface if you want.

You can also manage screens in screen groups and subgroups by using drag and drop

technology:



TeslaSCADA2 IDE User manual70

© 2023 LLC Tesla

Screens window

5.3.2 Scripts

The scripts are shown in the table. The first column contains the script name, the second

column contains the script type - General, Screen, Tag or Object, the third column contains the

execution type - OnDataChange, OnStart, OnClick and others:

You can hide or show columns by clicking "+" button:
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By clicking right button on the script you can call context menu:

List of menu items with their functions:

§ New Script  - create a new script. You can also create a new script in the main menu

Project ->New script. Then dialog window will be opened for editing script properties.

§ Open Script - open the script. It is opened for develop script command purposes. If

script use FBD language design screen for FBD objects will be opened. If script use ST

language code area will be opened. You can also open the script by double clicking on it.
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§ Copy Script - copy the script. It is copied with all FBD objects if you use FBD language or

with all code if you use ST language.

§ Delete Script - delete the script. It is deleted from the project.

§ Script properties - open dialog window for editing script properties.

§ New Script Group - create a new script group. It's useful to simplify the structure of the

project.

§ New Script Subgroup - this menu item is shown when your right click on the script

group. It creates new script's sub group. It's also useful to simplify of the project

structure.

§ Add to Group - add this script to the script group or subgroup from the list.

§ Reference to - help to find the script in the project. General and Screen types of the

script will be searched in the screen, Tag type in tags and Object type in objects.

§ Export Script - export this script for another project. File is saved with .tsp2scipt

extension.

§ Import Script - import the script from the file with  .tsp2script extension.

§ Export Script (Sub)Group - export scripts from the group or(and) subgroup. File is

saved with .tsp2groupscripts extension.

§ Import Script (Sub)Group - import scripts with the group or(and) subgroup from the

file with .tsp2groupscripts extension.

§ Export All Scripts - export all scripts for another project. File is saved with .tsp2allscripts

extension.

§ Import All Scripts - import all scripts from the file with .tsp2allscripts extension.

You can also manage scripts in script groups and subgroups by using drag and drop

technology:
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Scripts window

5.3.3 Servers

The servers are shown in the list. The list contains names of the servers used in the project:

By clicking right button on the server you can call context menu:

List of menu items with their functions:

§ New Server - create a new server. You can also create a new server in the main menu

Project ->New Server. Choose server  you want to add. Then dialog window will be

opened for editing server properties.
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§ Copy Server - copy the server.

§ Delete Server - delete the server. It is deleted from the project.

§ Server properties - open window for editing server properties. You can also do it by

double clicking on the server you want to edit.

§ Import tags from Excel - possibility to import tags from PLC through Excel files.

Servers window

5.3.4 Tags

The tags are shown in the table. The first column contains the tag name, the second column

contains the tag's value, the third column contains the tag's input source (pointer in string

format and it depends on server). You can use filter field to find tag you want by entering its

name:

You can hide or show columns by clicking "+" button:
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By clicking right button on the tag you can call context menu:

List of menu items with their functions:
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§ Simulate - this menu is enable only when you run simulation. By using sub menu items

you can Set value of the tag, for some tag's types you can use Random value for

simulation tag's random value, Ramp value for simulation value from 0 to 100. By using

sub menu Cancel you can reset Random value and Ramp value simulation.

§ New Tag  - create a new tag. You can also create a new tag in the main menu

Project ->New Tag. Then dialog window will be opened for editing tag properties.

§ Copy Tag - copy the tag.

§ Delete Tag - delete the tag. It is deleted from the project.

§ Delete all tags - delete all tags from the project.

§ Show system - check this menu item if you want to show system tags in this window.

You can't edit values of this tags, but you can use its in the project.

Table of system tags:

Name Data type Description

SystemCurrentDateTim

e
String

Current date and time in string format

(YYYY.MM.DD HH:mm:ss).

SystemCurrentDateTim

eDay
Integer

Current day of the month.

SystemCurrentDateTim

eHour
Integer

Current hour in 24 format.

SystemCurrentDateTim

eMinute
Integer

Current minute.

SystemCurrentDateTim

eMonth
Integer

Current month (01-January, 02-February...).

366
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SystemCurrentDateTim

eSecond
Integer

Current second.

SystemCurrentDateTim

eYear
Integer

Current year.

SystemCurrentScreen String Name of the current opened screen.

SystemCurrentUserAcce

ssLevel
Integer

Current user access level.

SystemCurrentUserAcce

ssLevelBelow500
Boolean

TRUE if current user's access level below 500.

SystemCurrentUserAcce

ssLevelGreater500
Boolean

TRUE if current user's access level greater or equal

500.

SystemCurrentUserNa

me
String

Current user's name.

SystemPreviousScreen String Previous opened screen.

§ Set editable - check this menu item if you want to change name of the tag or its input

directly in the table.

§ Tag properties - open dialog window for editing tag properties. You can also do it by

double clicking on the tag you want to edit.

§ New Tags Group - create a new tag group. It's useful to simplify the structure of the

project.

§ New Tags Subgroup - this menu item is shown when your right click on the tag group.

It creates new tag's sub group. It's also useful to simplify of the project structure.

§ Add to Group - add this tag to the tag group or subgroup from the list.

§ Reference to - help to find the tag in the project. You can find in which scripts this tag is

used and to which objects this tag is bound.

§ Export tags - export all tags of the project. File is saved with .tsp2tags extension.
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§ Export tags for OPC UA - export all tags of the project for OPC UA client if you want to

use current project in the Client-Server architecture.

§ Import tags - import all tags from the file with  .tsp2tags extension.

§ Export tags to Excel - export all tags to Excel file. File is saved with .xls extension.

§ Import tags from Excel - import all tags from the Excel file with .xls extension.

You can also manage tags in tag groups and subgroups by using drag and drop technology:

Tags window
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5.3.5 Users

The users are shown in the list. The list contains names of the users used in the project:

By clicking right button on the user you can call context menu:

List of menu items with their functions:

§ New User  - create a new user. You can also create a new user in the main menu

Project ->New User. Then dialog window will be opened for editing user properties.

§ Copy User - copy the user.

§ Delete User - delete the user. It is deleted from the project.

§ User properties - open window for editing user properties. You can also do it by double

clicking on the user you want to edit.

Users window

383
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5.3.6 Databases

The databases are shown in the list. The list contains names of the databases used in the

project:

By clicking right button on the database you can call context menu:

List of menu items with their functions:

§ New Database  - create a new database. You can also create a new database in the

main menu Project ->New Database. Choose database  you want to add. Then

dialog window will be opened for editing database properties.

§ Copy Database - copy the database.

§ Delete Database - delete the database. It is deleted from the project.

§ Database properties - open window for editing database properties. You can also do it

by double clicking on the database you want to edit.

385
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Databases window

5.3.7 Reports

The reports are shown in the list. The list contains names of the reports used in the project:

By clicking right button on the report you can call context menu:
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List of menu items with their functions:

§ New report - create a new report. You can also create a new report in the main menu

Project ->New Report. Then dialog window will be opened for editing report

properties.

§ Open Report - open the report for design properties. You can open the report by

double clicking on it also.

§ Copy Report - copy the report.

§ Delete Report - delete the report. It is deleted from the project.

§ Report properties - open window for editing report properties.

§ Export report - export report.

§ Import report - import report.

Reports window

5.4 Canvas

In the canvas, the project is created using the graphical objects. For convenient control and

navigation in the drawing area, you can use the information in the "Hot keys and Tips "

section.

5.5 Property Sheet

When you select any object, the property sheet display the properties available for this object.

"Show property sheet" menu item should be checked in Project  main menu. You can expand

property sheet if you want:

62
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By default only General properties are enabled for new created object. To enable other

properties groups you have to check enable for them:
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It's possible to edit Object's properties not only in Property sheet, but also in Object properties

window. To call this window you have to double click by left mouse button on the object you

want to edit or click by right button on the Object and choose Object properties menu item.

5.6 Screen window

In the same place where the property sheet is located you can find the screen window:

The screen window is useful to find graphical objects that placed on the screen behind other

graphical objects and to find and edit properties of the object inside the group object:
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By clicking right button on the screen object you can call context menu:

List of menu items with their functions:

§ New object  - create a new graphical object and add it in the project and on canvas

and screen window.

§ Delete object - delete selected graphical object from the project.

§ Object properties - call object properties window for selected object.

§ Add to Library - add selected object to the library (preliminary you have to create user-

defined library in Add graphical object  window).

5.7 Status bar

Status bar in all modes contains information about location of the project file in the left.

In design mode contains information about coordinate and dimension of the selected object in

the right.

In simulation mode it contains Run label information about simulation mode and information

about current user.

5.8 Hot keys and tips

Editor

121 82

121



TeslaSCADA2 IDE User manual86

© 2023 LLC Tesla

You can move objects by using arrow buttons of the keyboard (UP, DOWN, LEFT and

RIGHT):

If CAPS LOCK is ON you can change dimension of the object by using arrow buttons of

the keyboard:

You can select multiple graphical objects by holding CTRL keyboard button and clicking

left mouse button on the objects:
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Keyboard shortcut

Windows and Linux

MacOS Function

CTRL+N ^N Create a new project.

CTRL+O ^O Open project.

CTRL+S ^S Save project.

CTRL+SHIFT+S ^+SHIFT+S Save project as...

CTRL+SHIFT+L ^+SHIFT+L Load project on remote desktop or Android device.

TeslaSCADA2 Runtime should be started.

CTRL+Z ^Z Undo last action.

CTRL+Y ^Y Redo last action.

CTRL+D ^D Duplicate selected graphical object(s).

CTRL+X ^X Cut selected graphical object(s).

CTRL+C ^C Copy selected graphical object(s).

CTRL+P ^V Paste selected graphical objects(s).

DEL Fn+Delete(Bac

kspase)

Delete selected graphical object(s).

CTRL+G ^G Apply changes of the selected object for all objects

with the same name.

F9 Fn+F9 Send to back selected graphical object(s).

SHIFT+F9 Fn+SHIFT+F9 Bring to front selected graphical object(s).

CTRL+F3 Fn+^F3 Align the selected objects to the left.

CTRL+F5 Fn+^F5 Center selected graphical objects horizontally.

CTRL+F7 Fn+^F7 Align the selected objects to the right.

CTRL+F4 Fn+^F4 Align the selected graphical objects to the top.

CTRL+F6 Fn+^F6 Center selected graphical objects vertically.

CTRL+F8 Fn+^F8 Align the selected graphical objects to the bottom.

CTRL+H ^H Distribute the selected objects evenly horizontally.
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CTRL+E ^E Distribute the selected graphical objects evenly

vertically.

F6 Fn+F6 Rotate clockwise selected object(s). To current

rotation angle 90 degrees will be added.

SHIFT+F6 Fn+^F6 Rotate counter clockwise selected object(s). From

current rotation angle 90 degrees will be subtracted.

ALT+W ALT+W Create a new screen in the project.

CTRL+SHIFT+R SHIFT+^R Create a new Modbus RTU server.

CTRL+SHIFT+M SHIFT+^M Create a new Modbus TCP(UDP) server.

CTRL+SHIFT+I SHIFT+^I Create a new Siemens server.

CTRL+SHIFT+A SHIFT+^A Create a new AllenBradley server.

CTRL+SHIFT+O SHIFT+^O Create a new OPC UA server.

CTRL+SHIFT+Q SHIFT+^Q Create a new MQTT server.

CTRL+SHIFT+N SHIFT+^N Create a new Omron server.

ALT+S ALT+S Create a new script in the project.

ALT+T ALT+T Create a new tag in the project.

ALT+U ALT+U Create a new user in the project.

ALT+R ALT+R Create a new recipe in the project.

ALT+O ALT+O Add a new graphical object in the project.

CTRL+F11 Fn+^F11 Run simulation of the project.

CTRL+F12 Fn+^F12 Stop simulation of the project.

CTRL+F10 Fn+^F10 Logout and Login new user.

ALT+P ALT+P Open project properties window.

ST script editor

Keyboard shortcut

Windows and Linux

MacOS Function

CTRL+Z ^Z Undo the last action.

CTRL+SHIFT+Z SHIFT+^Z Redo the undone action.

CTRL+SHIFT+-> CMD+SHIFT+->Select the code to the right of the cursor.

CTRL+SHIFT+<- CMD+SHIFT+<-Select the code to the left of the cursor.

CTRL+X CMD+X Cut selected code.

CTRL+C CMD+C Copy selected code.

CTRL+V CMD+V Paste selected code.

CTRL+F11 Fn+^F11 Compile script.

Home/End Move cursor to start / end of line.

CTRL+Home/CTRL+End Move cursor to start / end of script.

Shift + Home / Shift +

End

Move cursor to start / end of line with selection.
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Sensor screen

By checking menu item Project ->Virtual keyboard you can enter values on sensor

screens. If it is checked, then when you click on an object available for entering numeric values,

a numeric keypad will be displayed on the screen:

If you need to enter "-" or "," you have to long touch (or long click) on the virtual button "." and

choose symbol you want.

When you click on an object available for entering characters, a symbolic keyboard with

support for Russian, English and special characters will be displayed on the screen:

62
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6 Project

Create Project

To create a new project TeslaSCADA IDE must be started. Click on the New  icon in the

toolbar or click menu item New from the main menu File . You’ll see the project

properties  window:

 

Save project

To save project: 

1. Click on the Save  or Save as...  icon on the toolbar or select the menu item

File  and Save or Save as.... The ?rst time you save a new project, you will be asked

for a location. 

2. Now select the location and click the button Save (TeslaSCADA project extension

.tsp2). 

64
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Open project

To open project:

1. Click on the Open  icon on the toolbar or select the menu item File  and Open. 

2. Now select the project and click Open (TeslaSCADA project extension .tsp2). 

Open project properties 

To open project properties :

1. Click on the Properties  icon on the toolbar or select the menu item Project  and

Properties. 

6.1 Project properties

 

Project properties are grouped in several tabs - General , Events/History , OPC UA ,

MQTT Publisher , Web-server  and Redundant server .

64 57

91

64 62

92 96 109

111 112 116



TeslaSCADA2 IDE User manual92

© 2023 LLC Tesla

6.1.1 General tab

General tab contains general properties for the project.

Property Description

Project name Name of the project.

Author Author of the project.

Title Title of the project. We'll be shown instead of

TeslaSCADA_Runtime caption.

Start screen

Name of the start screen.  When you create a new project

the Start screen combobox is empty. You can choose the

start screen after creating screens of the project. 

Update interval

 Update interval of the project. It’s an interval for

updating (redrawing) graphical objects of the current

screen. Also with this interval scripts will be executed if

"every cycle" is checked for ST script. For scripts with

execution type "OnDataChange" scripts will be executed if

tag's values is changed, if this tag is used in this script.

Default font
Default font for all texts in the project.  System font lets

you use Chinese, Arabian and etc language symbols.

Screen dimensions

 Default dimensions of your design screen in the screen

dimensions ?elds. These values are also used for scaling

your project. Be careful if these dimensions are differs

from the dimensions of the screens you developing, this

may cause your project to display incorrectly on devices

with different screen resolutions.

Runtime differs If the screen dimensions of your target device differs

check runtime differs  and enter its screen dimensions.

Use project protection

 If you want to protect your project from opening and

editing by non-authorised person check use project

protection. 

Password  Password for protecting your project.

Save tags values

 Check save tags values if you want to save all tag’s values

when you close application and load them when you

open your project. 

Save DB name  Name of the database where tag’s values will be saved. 

Max request attempts
Number of maximum server requests before determining

that the connection with the server has been lost.
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Auto logout
 If you want current user auto logout in setup minutes

after login you have to check this property.

Auto logout time(min) Time in minutes before auto logout is happened.

Global images

Since 2.46 version all images of the project are stored in

one global library. It needs to beneath size of the project.

To edit global images library click Collection button. You'll

see the window:

Where:

· Name - name of the image.

· Image - selected image.

· Download - download selected image to disk.

· Open - open new image file.

· Add - add image to the collection.

· Edit - edit image in the collection.

· Remove - remove image from the collection.

Main menu*

You can use Main menu in your project that helps you to

navigate through general screens of the project. Click

Setup button to configure main menu. After clicking

you'll see the window: 
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Where:

· Y position - Main menu is slid from the left. Y position

of the menu you setup in this field.

· Height - height of the main menu.

· Width - width of the main menu.

· Color - background color of the main menu.

· Spacing - spacing between buttons of the main menu.

· Tail - tail of the main menu that appears on the screen.

· Menu buttons - collection of the main menu buttons.

After clicking button you'll see the window: 
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Where:

· Screen - screen you want to bind to the button. If you

don't want to bind any screen left it empty.

Other properties are the same like general properties

for the Button.

Buttons Add, Edit and Remove let you change main

menu buttons collection.

Description
 Optionally, specify a meaningful description of your

project.

* Main menu works only on PC versions.

158
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Project properties. General tab.

6.1.2 Events/History tab

Events/History tab contains properties for general events and history databases,

notification rules and sounds, report folder. Also it contains properties for E-mail client used for

notifications by E-mail  and for Telegram bot .

Property Description

Storage DB period 
 Select the time period during which data will be stored in

general event and history databases.

Archive since

Select an archive period. The data collected before the

archive period is stored in the archive database. The data

collected for the selected period is stored in the main

database. This improves performance when querying the

underlying database.

Events DB name

The name of the database that stores all information

about events during project execution.

·  If you choose the simple name like events application

will create SQLite database in the application

directory .

· If you choose names beginning with jdbc:mysql: like

jdbc:mysql://192.168.0.104:3306/test the application

will connect to MySQL database and create events

table.  Don’t create big MySQL databases for connecting

from Android devices (MySQL databases need a wide

99 101
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network  bandwidth for sending and receiving data).

How to install and setup MySQL you can read in

MySQL*  chapter.

· if you choose names beginning with jdbc:sqlserver:

like

jdbc:sqlserver://192.168.1.17:1433;databaseName=t

est where test name of the database you want to

connect. The application will connect to MSSQL*

database and create events table.

· if you choose names beginning with jdbc:postgresql:

like jdbc:postgresql://192.168.1.17:5432/test where

test name of the database you want to connect. The

application will connect to PostgreSQL*  database

and create events table.

· if you choose names beginning with jdbc:ucanaccess:

like jdbc:ucanaccess:///C:

\Users\fatkh\Downloads\events.accdb where

events.aacdb name of the file you want to collect

information. The application will connect to MS Access

database and create events table.

History DB name

The name of the database that stores general history

information during project execution. It's also possible to

store history information in History databases.

·  If you choose the simple name like history application

will create SQLite database in the application

directory .

· If you choose names beginning with jdbc:mysql: like

jdbc:mysql://192.168.0.104:3306/test the application

will connect to MySQL database and create history

table.  Don’t create big MySQL databases for connecting

from Android devices (MySQL databases need a wide

network  bandwidth for sending and receiving data).

How to install and setup MySQL you can read in

MySQL*  chapter.

· if you choose names beginning with jdbc:sqlserver:

like

jdbc:sqlserver://192.168.1.17:1433;databaseName=t

est where test name of the database you want to

connect. The application will connect to MSSQL*

database and create history table.

· if you choose names beginning with jdbc:postgresql:

like jdbc:postgresql://192.168.1.17:5432/test where

28
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test name of the database you want to connect. The

application will connect to PostgreSQL*  database

and create history table.

· if you choose names beginning with jdbc:ucanaccess:

like jdbc:ucanaccess:history where history name of the

file you want to collect information. The application will

connect to MS Access database and create history

table.

Use history table for every tag

If you check this property, for every tag that collects

history information table will be created. This is helpful for

big project with a lot of history information.

Username Username for MySQL database.

Password Password for MySQL database.

Notifications (priority <)

Events with a priority lower than this value will be noti?ed

about it by using the dialog box and sound. And also if

E-mail client or Telegram bot are setup by E-mail and

Telegram.

Sounds

 Click  Collection to set up sounds of events noti?cations

depending on priority. After clicking you’ll see the

window:

 

Where:

· Name - name of the sound.

· From priority and To priority -  priority interval within

which sound will play.

· Play - play selected sound.

· Open - open sound (wav) file.

· Add - add sound to the collection.

· Edit - edit sound.

· Remove - remove sound from the collection.

53
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Show servers events

If you check Show servers events property you’ll get

notifications about disconnection, lost or restore servers.

If you uncheck this property you'll not get notifications.

Report folder
 The folder to which all reports will be written by default

and screenshots.

* for mobile version is possible to use only SQLLite databases.

6.1.2.1 E-mail client

If you want to notify users by E-mail you have to setup E-mail client:

Property Description

Use E-mail client 

 Check Use E-mail client if you want to use E-mail

noti?cations about Alarms. All event messages that have

priority less then Noti?cations(Priority<)  will be sent by

E-mail. Or you can use function sendemail in ST script.

Host E-mail host information.

Port E-mail port information.

Type Type of the connection - TLS or SSL.

From E-mail address From which E-mail address the mail will be sent. 

Authentication
 Check Authentication if you use Username and

Password. 

Username Username of the E-mail account.

Password Password of the E-mail account.

98
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Subject

Subject of the E-mail. If you left it empty default subject

will be used (it contains project name, tag name and other

information).

 You can use keywords:

{name} - name of the tag that send an alarm message.

{server} - name of the PV input server.

{message} - message is sent by tag's alarm.

{group} - name of the tag's group.

{subgroup} - name of tag's subgroup.

{description} - tag's description.

{value} - tag's value.

{priority} - tag's message priority.

{datetime} - current date and time (when alarm is

happened).

{projectname} - project name.

{projectdescription} - project description.

Message

Message of the E-mail. If you left empty tag's message

will be sent.

 You can use keywords:

{name} - name of the tag that send an alarm message.

{server} - name of the PV input server.

{message} - message is sent by tag's alarm.

{group} - name of the tag's group.

{subgroup} - name of tag's subgroup.

{description} - tag's description.

{value} - tag's value.

{priority} - tag's message priority.

{datetime} - current date and time (when alarm is

happened).

{projectname} - project name.

{projectdescription} - project description.

To E-mail addresses
To which E-mail addresses the mail will be sent. Use

commas to separate addresses.

Depends on priority

If you want to use E-mail addresses depends on priority

check this property and setup E-mail addresses



Project 101

© 2023 LLC Tesla

depending on priority values:

Where:

· Name - name of the E-mail range.

· From - begin priority of the range.

· To - end priority of the range.

· To E-mail addresses - E-mail addresses separated by

commas.

In some accounts, for example in Gmail you have to make some setups before it would be

possible to send E-mails. For Gmail you have to turn on the access for less secure apps for

example and also some other settings.

6.1.2.2 Telegram bot

If you want to notify users by Telegram you have to setup Telegram bot:

https://medium.com/@pablo127/sending-emails-from-your-java-app-via-gmail-solve-authorization-problems-1f14b8866822
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Property Description

Use Telegram Bot 

  If you want to use Telegram notification in your project

check Use Telegram Bot. All event messages that have

priority less then Noti?cations(Priority<)  will use

Telegram Bot to notify user.

Bot's name
Name of the Telegram bot.  You get Telegram Bot’s name

from BotFather when you creating your bot. 

Bot's token
Token of the Telegram bot.  You get Telegram Bot’s token

from BotFather when you creating your bot. 

Notifications (priority <)

Events with a priority lower than this value will be noti?ed

about it by using Telegram bot. If the value is less than 0

common Notfications (priority<)  will be used.

Message

Message that will be sent to telegram bot. If this field is

empty only tag message will be sent. If not empty this

message will be sent. You can use keywords:

{name} - name of the tag that send an alarm message.

{server} - name of the PV input server.

{message} - message is sent by tag's alarm.

{group} - name of the tag's group.

{subgroup} - name of tag's subgroup.

{description} - tag's description.

{value} - tag's value.

{priority} - tag's message priority.

{datetime} - current date and time (when alarm is

happened).

{projectname} - project name.

{projectdescription} - project description.

Before using telegram for notifications you have to create telegram bot .

6.1.2.2.1  Create Telegram Bot

If you want to get events noti?cation from your project in TeslaSCADA2 Runtime you

can use Telegram messenger for this purpose. To send messages via Telegram, you need to

make a preliminary configuration . First you need to create your own Telegram bot. To do this,

you need to open the Telegram application, find a bot with the name "@BotFather", press the

"Start" button and send the /newbot command to it:

98
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Next, you need to come up with a bot name and username (must end with the word "bot").

After that, the Token will be received:
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Next, in the Project properties->Events/History tab, check "Use Telegram Bot", enter bot's name

and token:
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Then you have to start TeslaSCADA2 Runtime and run this project (in TeslaSCADA IDE telegram

bot doesn't work). After that, users who want to receive notifications should find our bot in

Telegram and write /start:

 To stop getting noti?cation messages enter /stop. Also you can get some information from

your project. To get possible command write /info:

1. Enter /tags to get current values of tags.

 2. Enter name of the tag used in your project. You’ll get information about value of this tag

and if tags supports history you’ll get trend for last hour period. You can choose other

period by clicking proper button. 
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Important! Don’t use underline in the name of the tags. Telegram have problems with

working with this kind of names. 

At this moment you can use Telegram bot only on desktop versions of TeslaSCADA2 Runtime.

6.1.2.3 Push notifications

If you want to notify users by Push notifications messages you have to setup Push notifications

and install TeslaSCADA2 Runtime mobile version on your Android or iOS devices.

Property Description

Use push notifications

Check "Use push notifications" if you want to use push

notifications. All event messages that have priority less

then Notifications(priority<=) will be sent as push

notifications on mobile devices.

Topic
Topic is used to subscribed for mobile devices and send

to this subscription by PC. 

Notifications (priority<=)
If priority of the event message below this value push

notification will be sent.

Title

Title of the push notification.

You can use keywords:

{name} - name of the tag that send an alarm message.

{server} - name of the PV input server.

{message} - message is sent by tag's alarm.

{group} - name of the tag's group.

{subgroup} - name of tag's subgroup.

{description} - tag's description.
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{value} - tag's value.

{priority} - tag's message priority.

{datetime} - current date and time (when alarm is

happened).

{projectname} - project name.

{projectdescription} - project description.

Message

Message of the push notification

You can use keywords:

{name} - name of the tag that send an alarm message.

{server} - name of the PV input server.

{message} - message is sent by tag's alarm.

{group} - name of the tag's group.

{subgroup} - name of tag's subgroup.

{description} - tag's description.

{value} - tag's value.

{priority} - tag's message priority.

{datetime} - current date and time (when alarm is

happened).

{projectname} - project name.

{projectdescription} - project description.
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6.1.2.4 GSM-modem

If you want to notify users by SMS messages you have to setup GSM-modem:

Property Description

Use GSM modem

Check Use GSM modem if you want to use SMS

noti?cations about Alarms. All event messages that have

priority less then Notifications(priority<=) will be sent by

SMS.

Port ID 

ID of the COM port.  If this port can not be open in

TeslaSCADA2 Runtime other port will be tried to ?nd and

open. 

Baud rate Baud rate of the Common RTU server.

Flow control
Flow control of the port. It can be NONE, RTSCTS and

XONXOF. 

Data bits Number of data bits.  It can be 5, 6, 7 and 8. 

Stop bits Number of stop bits. It can be 1, 1.5 and 2. 

Parity
Parity of the Common RTU.  It can be NONE, EVEN, ODD,

MARK and SPACE.

To phone numbers
Phone numbers separated by commas to which SMS with

alarms will be sent.
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Notifications (priority<=)

If priority of the event message below this value SMS will

be sent. If this value <0 global Notifications (priority<=)

will be used

Message

Message of the SMS.

You can use keywords:

{name} - name of the tag that send an alarm message.

{server} - name of the PV input server.

{message} - message is sent by tag's alarm.

{group} - name of the tag's group.

{subgroup} - name of tag's subgroup.

{description} - tag's description.

{value} - tag's value.

{priority} - tag's message priority.

{datetime} - current date and time (when alarm is

happened).

{projectname} - project name.

{projectdescription} - project description.

6.1.3 OPC UA tab

OPC UA client settings

 If you want to use OPC UA client certi?cate to connect to OPC UA servers in your

project on the OPC UA tab enter Name of used/created certi?cate and Period(days) of

validation if you create certi?cate:

 

The certi?cate stored in the {app}/private  directory. 

OPC UA server settings

If you want to use Client - Server architecture  in your system and use it with OPC UA

server you have to check Use OPC UA sever:

17

11
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Property Description

Use OPC UA server 
If you want to enable OPC UA server of TeslaSCADA2

check Use OPC UA server.

TCP port TCP port of your OPC UA server.

None
Check if you want to use None security mode in the

server.

BASIC128RSA15_SIGN
Check if you want to use BASIC128RSA15_SIGN security

mode in the server.

BASIC128RSA15_SIGN_ENCRYPT
Check if you want to use BASIC128RSA15_SIGN_ENCRYPT

security mode in the server.

BASIC256_SIGN
Check if you want to use BASIC256_SIGN security mode

in the server.

BASIC256_SIGN_ENCRYPT
Check if you want to use BASIC256_SIGN_ENCRYPT

security mode in the server.

BASIC256SHA256_SIGN
Check if you want to use BASIC256SHA256_SIGN security

mode in the server.

BASIC256SHA256_SIGN_ENCRYP

T

Check if you want to use

BASIC256SHA256_SIGN_ENCRYPT security mode in the

server.
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Anonymous
Check Anonymous if you want to use this policy in OPC

UA server. 

Username/Password
Check Username/Password if you want to use this policy

in OPC UA server.

Certificate name Certificate name of the OPC UA server.

Period(days)
The period during which the OPC UA server certificate will

be valid.

6.1.4 MQTT Publisher tab

If you want to use Client - Server architecture  in your system and use it with MQTT

broker you have to check Enable MQTT Publisher:

Below description of the properties:

Property Description

Enable MQTT Publisher Check if you want to enable MQTT publisher.

Broker URL Broker URL of the MQTT server.

Username Username of the MQTT broker.

Password Password of the MQTT broker.

11
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Client ID
Some brokers need Client ID. If you left client ID unfilled

publisher will generate ClienID itself.

Write topic format
Some cloud brokers need formatted topic. See IBM cloud

example . You can left this field empty.

Read topic format
Some cloud brokers need formatted topic. See IBM cloud

example . You can left this field empty.

QoS Choose QoS of MQTT messages.

 Enable TLS/SSL
Check Enable TLS/SSL if you want to use server certi?cate

for encryption messages. 

Certi? cate ? lename
 Certi?cate ? lename. File should be placed in /private /

folder in the directory where TeslaSCADA2 is installed. 

Enable Client Certi? cate
 Check it if you want to use client certi?cate for encryption

messages. 

Client certi? cate
 Client certi?cate ? lename. File also should be placed

in /private / folder

Client Private key
Client private key ? lename. File also should be placed

in /private / folder

Private key password Private key password.

PEM formatted
 Check PEM formatted if your certi?cate and key ? les are

PEM formatted. 

 MQTT publisher will send tag's values collected during project running on MQTT broker

you want. MQTT subscribers will collect this values and represent it on devices you want. If you

don't use Write topic format and Read topic format fields publisher’s topics are consists of

the «name of the project +/Tags/+tagname» for tags and «name of the project+/Events/

+tagname» for events. If you use Write topic format and Read topic format tags replace

{tagname} keyword.

6.1.5 Web-server tab

 If you want to use Web-Server in your project click on the tab Web-Server and enable it.

To have possibility to use Web-Server on the PC you want, Java 8(JRE) should be installed on it.

For TeslaSCADA Runtime version below 2.41.2 Java version should be from 8.25 - 8.161. For

TeslaSCADA Runtime starting from 2.41.2 version minimal Java version - 8.281. To check

version of Java you have in command line write command java -version. In the response you’ll

get installed Java version. Also to have possibility to run Web-Server TeslaSCADA should be

installed  in the path without white spaces. You can use any modern browser to access to the

Web-Server. The most recommended browser - Google Chrome.

Important! If you use Mac OS Big Sur and have problems with running Web server

delete /Library/Internet Plug-Ins/ folder on your disk and relogin.

502

502

17

17

17
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Important! Web-Server is possible to use only in Evaluation version (project contains up

to 16 tags) and in the Full version (if you activate a full license). 

Below this list of Web-server properties:

Property Description

Enable Web-server Check if you want to enable Web-server.

Host

 Host of the Web-Server. Usually it’s an IP address of PC

where installed TeslaSCADA2 Runtime and Run

con?gured project. 

HTTP
 Check HTTP if you want to use unsecured HTTP protocol

 to connect to Web-Server. 

HTTP port HTTP port used by Web-Server. 

HTTPS
Check HTTPS if you want to use secured HTTPS protocol

to connect to Web-Server. 

HTTPS port HTTPS port used by Web-Server.

Truestore ? le
 It’s a ? le where stored validated certi?cates. It should be

with .jks or .keystore format. 

Truestore password  Truestore password to have access to truestore ? le. 
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Keystore ? le
 It’s a ? le where stored certi?cates of the server. It should

be with .jks or .keystore  format. 

Keystore password  Keystore password to have access to keystore ? le.

Use other project for WEB client
If you want to use other project for WEB client check this

field.

Project Choose path to the project for WEB client.

If you want to use self-signed certi?cates in keystore you’ll have problems in accessing to

WebServer by using the most popular browsers. You have to use certi?cates signed by CA to

exclude these problems.

Important: Web-server create another instance of TeslaSCADA2 Runtime application to

connect to the servers and databases of the project. It's not possible to use its

functionality if your server doesn't let multiple connection (for example Modbus RTU lets

only one app connects to the port). And it's not possible to use SQLLite database at the

same reason. To escape this problem use HTTP server and use HTTP client for WEB client.

To do this check "Use other project for WEB client" and choose HTTP client project.

6.1.6 HTTP-server

If you want to use Client - Server architecture  in your system and use it with HTTP-server you

have to check Enable HTTP-server:

11
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Below description of the properties:

Property Description

Enable HTTP Server Check if you want to enable HTTP server.

Host Host or IP address of the HTTP server.

Username Username of the HTTP server.

Password Password of the HTTP server.

HTTPS
Check HTTPS if you want to use secured HTTPS protocol

to connect to HTTP-server.  

Keystore ? le

 It’s a ? le where stored certi?cates of the server. It should

be with .jks or .keystore  format. File placed in /private /

folder

Keystore password  Keystore password to have access to keystore ? le.

Create HTTP client
If you want to create HTTP client for connecting to this

HTTP-server click this button. 

17
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6.1.7 Redundant server

If you want to use Redundant server in your project check Enable redundant server.

Redundant server is based on OPC UA client. Primary server should use OPC UA server  with

Security mode is None and Anonymous policy:

Below description of the properties:

Property Description

Enable redundant server Check if you want to enable redundant server.

URI OPC UA URI of the primary server.

Type

Type of the redundant server:

- Direct - redundant server use servers like primary server

to get tag's values of the  project.

- OPC UA - redundant server use OPC UA server of the

primary server to get tag's values of the project.

6.1.8 Cloud

If you want to use Tesla Cloud in your project check Enable cloud (To use cloud you have

opened 7000 and 7001 ports on your device) . Cloud lets you provide tags information from

109
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your project on the Tesla Cloud by using desktop TeslaSCADA2 Runtime and read this

information by using browser or TeslaSCADA2 Runtime for desktop or mobile (only Android at

this moment):

Below description of the properties:

Property Description

Enable cloud Check if you want to enable Tesla Cloud.

Username Username of the user of Tesla Cloud.

Password Password of the user of Tesla Cloud.

Create cloud client
If you want to create Cloud client for connecting to this

Tesla Cloud click this button. 

Create HTTP client
If you want to create HTTP client for TeslaCloud use this

button.
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6.2 Screens

Create screen

To create a new screen select the menu item Project -> New Screen or choose Screens  on

the Project Window, click right button on it and choose New Screen item.

You’ll see the screen properties  window: 

Open screen

To open screen on Screens  tab of the Project window: 

1. Right click on the screen you want to open and choose Open item. 

or

2. Double click on the screen you want to open.

Copy screen

To copy screen on Screens  tab of the Project window right click on the screen you want to

copy and choose Copy item. 

62 67
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Delete screen

To delete screen on Screens  tab of the Project window right click on the screen you want to

delete and choose Delete item.

Open screen properties

To open screen properties  on Screens  tab of the Project window right click on the screen

you want to open and choose Screen properties item.

Export screen

To export screen on Screens  tab of the Project window: 

1. Right click on the screen you want to export and choose Export screen item.

2.  Now select the location and click the button Save (TeslaSCADA2 screen extension

.tsp2screen).

Import screen

To import screen on Screens  tab of the Project window: 

1. Right click on the screen window and choose Import screen item. 

2. Now select the screen ? le and click Open (TeslaSCADA screen extension .tsp2screen). 

See Project Window->Screens  tab for more information about possible operation with

screens.

67
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6.2.1 Screen properties

List of screen properties:

Property Description

Group Select group for the screen.

Subgroup Select subgroup for the screen.

Name Name of the screen.

Comment Optionally specify a meaningful comment. 

Background color Background color of the screen.

Screen type Select screen type of the screen - General or Popup.

Scripts

 Click  Collection to set up screen's scripts . After clicking

you’ll see the window:
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Where:

· Scripts - list of available screen type scripts in the

project.

· Add - add script to the collection.

· Remove - remove script from the collection.

Screen dimension Width and height of the screen.

Coordinates

 If you choose Popup screen you can enter position X and

Y where this screen will be appeared. If you enter value <

0 the screen will appear at the center. 

Access Level

Screen's access level. If this value greater then access level

of the current user the screen couldn't be opened by this

user.

Use password Check if you want to use screen security. 

Password
Only the user who knows the password will be able to

open this window.

6.2.2 Design screen

To start designing the screen you want, you need to double click on it or click right button on

the Project window ->Screens and choose Open screen menu item.

Create graphical object

You can add new graphical object on the screen in several ways:

1. Select the menu item Project  and New Object.

2. Click New Object  button on the Toolbar. 

3. Click right button on the Screen window  and choose New object menu item.

4. Click right button on the Canvas  and choose New object menu item. 
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You’ll see the Add graphical object window:

Select library which object you want to use in your project (all libraries and their objects

described below). Select object you can in several ways: 

1. By double clicking on the object. 

2. By clicking on the object (select rectangle will appear) and then clicking OK button.

3. By clicking right button and choosing Select menu item. 

Add graphical object window will disappear and you can select the location on the screen

where you want to place the object. 

Object information about its dimensions and coordinates you can ?nd in the status bar  on

the right. 

Resize graphical object

You can resize graphical object by clicking on it. Resize squares will be appeared and you can

change dimensions of the object as you want. 

85
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Also you can resize object by using arrow keys  on keyboard.

Select several objects

You can select several objects by using selecting rectangle or by clicking on objects you want to

select and simultaneously holding CTRL  key.

Move graphical object 

You can move graphical objects by using Drag and Drop technology. You can also move

objects by using arrow keys  on keyboard.

Open graphical object properties

You can open graphical object properties on the Screen Window  or on the Canvas .To

open graphical object properties: 

1. Right click on the object you want to open and choose Object properties menu item.

85
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 or

2. Double click on the object, properties which you want to open.

Copy graphical object

You can copy graphical object: 

1. Right click on the object you want to copy and choose Copy menu item of the context

menu. 

2. Select the object you want to copy and choose Edit ->Copy menu item on the main

menu. 

3. Select the object you want to copy and click Copy  button on the Toolbar . 

4. Use corresponding hotkeys  for your operating system.

Cut graphical object 

You can cut graphical object: 

1. Right click on the object you want to cut and choose Cut item of the context menu. 

2. Select the object you want to cut and choose Edit ->Cut menu item on the main

menu. 

3. Select the object you want to cut and click Cut  button on the Toolbar . 

4. Use corresponding hotkeys  for your operating system.

Paste graphical object

You can paste (before you have to cut or copied) graphical object: 

1. Right click on the Canvas  and choose Paste menu item of the context menu. 

2. Choose Edit ->Paste menu item on the main menu. 

3. Click Paste  button on the Toolbar . 

4. Use corresponding hotkeys  for your operating system.

Erase graphical object 

You can erase graphical object: 

1. Right click on the object you want to erase and choose Erase menu item of the context

menu. 

2. Select the object you want to erase and choose Edit ->Erase menu item on the main

menu. 

3. Right click on the object in the Screen Window  and choose Delete object menu

item. 

4. Use corresponding hotkeys  for your operating system.
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Duplicate graphical object 

You can duplicate graphical object: 

1. Right click on the object you want to duplicate and choose Duplicate menu item of the

context menu. 

2. Select the object you want to duplicate and choose Edit ->Duplicate menu item on

the main menu. 

3. Use corresponding hotkeys  for your operating system.

Send to back graphical object

You can send to back graphical object relative to other objects of the screen: 

1. Right click on the object you want to send to back and choose Send to Back menu

item of the context menu. 

2. Select the object you want to send to back and choose Arrange ->Send to Back

menu item on the main menu. 

3. Select the object you want to send to back and click Send to Back  button on the

Toolbar . 

  4. Use corresponding hotkeys  for your operating system.

 

Bring to front graphical object 

You can bring to front graphical object relative to other objects of the screen: 

1. Right click on the object you want to bring to front and choose Bring to Front menu

item of the context menu. 

2. Select the object you want to bring to front and choose Arrange ->Bring to Front

menu item on the main menu. 

3. Select the object you want to bring to front and click Bring to Front  button on the

Toolbar . 

4. Use corresponding hotkeys  for your operating system.

Rotate clockwise graphical object 

You can rotate clockwise graphical object clockwise:

1. Select the object you want to rotate clockwise and click Rotate Clockwise  button

on the Toolbar . 

2. Select the object you want to rotate clockwise and choose Arrange ->Rotate

Clockwise menu item on the main menu. 

3. Use corresponding hotkeys  for your operating system.
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Rotate counterclockwise graphical object 

You can rotate counterclockwise graphical object clockwise: 

1. Select the object you want to rotate counterclockwise and click Rotate

CounterClockwise  button on the Toolbar . 

2. Select the object you want to rotate counterclockwise and choose Arrange -

>Rotate CounterClockwise menu item on the main menu. 

3. Use corresponding hotkeys  for your operating system.

Align graphical objects

 You can align objects relative to each other on the screen. Choose objects you want to align by

selecting square or by clicking on objects you want to select and simultaneously holding CTRL

key  . And: 

1. Choose Arrange ->Align menu items on the main menu. 

2. Click Align buttons  on the Toolbar . 

3. Right click on selecting square and choose Align menu item of the context menu. 

4. Use corresponding hotkeys  for your operating system.

For more information about each alignment operation you can read above in section Start

TeslaSCADA IDE ->Toolbar . 

Group graphical objects 

You can group objects. Choose objects you want to group by selecting square or by clicking

mouse left button and simultaneously holding CTRL button . And: 

1. Select Arrange ->Group objects menu item on the main menu. 

2. Click Group objects  button on the Toolbar . 

3. Right click on selecting square and choose Group objects menu item on the context

menu. 
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4. You can edit properties of this group object by double clicking or by choosing

context menu properties menu item:

You can change name of the group object, coordinates, dimensions and enter

template name. Later you can apply changes for the template by clicking appropriate

main menu item .

Ungroup graphical objects 

You can ungroup objects. Choose group of objects you want to ungroup by clicking on it .

And: 

1. Select Arrange ->Ungroup objects menu item on the main menu. 

2. Click Ungroup objects  button on the Toolbar . 

3. Right click on selecting square and choose Ungroup objects menu item on the

context menu. 

Add object into the Group 

You can add selected object into the group of the objects: 

1. Choose object you want to add into the group. 

2. And in the screen window drag and drop object into the group object. 
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Remove object from the Group 

You can remove object from the group of the objects: 

1. Choose object you want to remove from the group in the screen window. 

2. And in the screen window drag and drop object on the name of the group object.

 

Virtual keyboard

If you want to develop your project on Sensor screen  you can turn on virtual keyboard. You

can do by checking Project ->Virtual keyboard menu item on the main menu.

6.2.3 Graphical objects

Every graphical object has several group of properties. All properties you can edit in Property

sheet  or in Object settings window (you can get this window by double clicking on the

object). The description of every group of properties you can ?nd below in the chapter -

Properties . In this chapter we describe one group for every object - General. 

This group is responsible for the appearance of the object, contains scripts and user-defined

properties. Every object has the following properties: 
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Property ST script field* Description

Name name

Name of the object. You can use indirect name by

using group name. To do this use curve braces {}.

For example if group's name is “group” and you

enter in the ?eld {group}name and you’ll get

name of the object is “groupname”.  

Dimensions

width Dimensions of the graphical object. Enter width of

the object in the W(width) ?eld and enter height of

the object in the H(height) ?eld. height

Coordinates

posx Coordinates of the graphical object. Write x

coordinates of the object in the X(posx) ?eld and

enter y coordinates of the object in the Y(posy)

?eld. 
poxy

Angle angle
Select the rotation angle of the object (0, 90, 180,

270). 

Type  Select the type of the object - 2D or 3D. 

Scripts

Click Collection to add scripts for the Object. After

clicking Collection button you’ll see the following

window:

Where:

§ Scripts  - list of object type scripts.

§ Add - add script to the object.

§ Remove - remove script from the object.

User-Defined**

Click Collection to add user-defined properties for

the Object. After clicking Collection button you’ll

see the following window:

297
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Where:

§ Property - name of the user-defined

property.

§ Value - value of the user-defined property.

§ Add - add user-defined property to the

object.

§ Edit - edit user-defined property of the

object.

§ Remove - remove user-defined property

from the object.

* This field is used in ST scripts. For example: Objects.Button.width = 100. In this script

command width of the object with name Button become 100.

** User-defined properties can be used in indirect properties tag names and in scripts. Below is

described how to do it.

User-defined properties

You have object Button with user-defined property "number":
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Then you have to close Collection window and click OK to close Object properties window add

this user-defined property for this object. Now open object properties window again to bind this

object to the tag (or you can do it in Property sheet ). Open Choose tag window for some of

the property that bind to the tag:

You can use indirect Tag name by using user-defined property number we created and using

curve braces {}. Tag name will be looked Tag{number}. For this object number equal 1. So the

tag name will be Tag1. Now you can copy this object (Button in our case) and change user-

defined property number to bind these objects to other tags. The easiest way to do it change

property number in Property sheet :

82
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This is very helpful if you develop big project with similar objects and tags.

Also you can use user-defined property in ST scripts. For example you have user-defined

property description with some description of the object and want to display it on the screen

with some Text object when for example you click on this object. You have to create ST script

with execution type - OnClick and add this script to the object description which you want to

display. Script code will be looked like below:

Objects.Text.text = Objects.this.description;

Important! If you change user-defined property in ST script it will not affect on the

indirect tag name of the object's property.
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6.2.3.1 Simple objects library

Simple objects library contains the following objects: 

§ Line

§ Rectangle

§ Ellipse

§ Polyline

§ Polygon

§ Sector

§ Text/EditField

§ Border

§ Image

§ Scale

§ Text Area
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6.2.3.1.1  Line

Property ST script field Description

Line width linewidth Width of the line. 

Color color Color of the line.

Line style linestyle

Style of the line:

§ Solid

§ Dash

§ Dot

§ DashDot

Beginmarker beginmarker

Marker of the line's begin:

§ Flat

§ Arrow

§ Square

§ Circle

Endmarker endmarker

Marker of the line's end:

§ Flat

§ Arrow

§ Square

§ Circle
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6.2.3.1.2  Rectangle

Property ST script field Description

Line width linewidth Width of the border's line. 

Color color Color of the border's line.

Fill fill Select fill or not fill rectangle.

Fill color fillcolor Fill color of the rectangle.

6.2.3.1.3  Ellipse
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Property ST script field Description

Line width linewidth Width of the border's line. 

Color color Color of the border's line.

Fill fill Select fill or not fill ellipse.

Fill color fillcolor Color of the ellipse's filling.

6.2.3.1.4  Polyline

Property ST script field Description

Line width linewidth Width of the line. 

Color color Color of the line.

Hotspots

When you click Collection button the Collection

window will appear:
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Where:

§ CoordinateX - X coordinate of the polyline's

node.

§ CoordinateY - Y coordinate of the polyline's

node.

§ Add - add a new polyline's node.

§ Edit - edit the polyline's node.

§ Remove - remove the polyline's node.

You can also edit polyline's nodes on the

Canvas :

6.2.3.1.5  Polygon

82
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Property ST script field Description

Line width linewidth Width of the border's line. 

Color color Color of the border's line.

Fill fill Select fill or not fill polygon.

Fill color fillcolor Color of the polygon's filling.

Hotspots

When you click Collection button the Collection

window will appear:

Where:

§ CoordinateX - X coordinate of the

polygon's node.

§ CoordinateY - Y coordinate of the

polygon's node.

§ Add - add a new polygon's node.

§ Edit - edit the polygon's node.

§ Remove - remove the polygon's node.

You can also edit polygon's nodes on the

Canvas :82
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6.2.3.1.6  Sector

Property ST script field Description

Line width linewidth Width of the border's line. 

Color color Color of the border's line.

Fill fill Select fill or not fill sector.

Fill color fillcolor Color of the sector's filling.

Start angle startangle
Start angle of the sector. 0 degrees is the right

middle point of the dimensions rectangle.

Rotation angle rotationangle Counterclockwise rotation angle of the sector.
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6.2.3.1.7  Text/EditField

Property ST script field Description

Text text Text displayed on the screen by using this object.

Font type fonttype Type of the text's font.

Underline underline Check if you want to underline the text.

Font size fontsize Size of the text's font.

Text placement textplacement

Placement of the text:

§ Left

§ Center

§ Right

Text color textcolor Color of the text.

Border useborder Select use or not use border for the text.

Border width linewidth Width of the border's line. 

Border color bordercolor Color of the border's line.

Fill fill Select fill or not fill text's background.
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Fill color fillcolor Color of the text's background.

Also for all text/editfield objects you can use fields in ST scripts:

§ textbefore - text before the value.

§ textafter - text after the value.

§ decimalpos - decimal position for the value.

6.2.3.1.8  Border

Property ST script field Description

Line width linewidth Width of the border. 

Inner inner Select style of the border - Inner or not.

Fill fill Select fill or not fill the border.

Fill color fillcolor Color of the border.
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6.2.3.1.9  Image

Property ST script field Description

Image

Select image you want to add to the project by

clicking «…» button. File dialog will be appeared.

Choose ? le with image you want to add to the

project and click Open button. You can use GIF

files if you want.
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6.2.3.1.10  Scale

Property ST script field Description

Line width linewidth Width of the line. 

Color color  Color of the border and scale lines.

Border useborder Select use or not use border for the scale.

 Scale ? 2 scale2 Select use or not second scale.

 Scale ? 3 scale3 Select use or not third scale.

 Scale interval ? 1 scaleinterval1 Interval of the main scale.

 Scale interval ? 2 scaleinterval2 Interval of the second scale.

 Scale interval ? 3 scaleinterval3 Interval of the third scale.

Marker ? 1 size sizemarkers1 Width of the main scale.
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Marker ? 2 size sizemarkers2 Width of the second scale.

Marker ? 3 size sizemarkers3 Width of the third scale.

Type type

Type of the scale:

§ Left

§ Right

§ Top

§ Bottom

Use digital usedigit
Check if you want to bind numeration to the main

scale.

Minimum min Minimum value for the main scale.

Maximum max Maximum value for the main scale.

Decimal position decimalpos Decimal position for the scale numbers.

6.2.3.1.11  Text Area

Property ST script field Description
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Text text Text displayed on the screen by using this object.

Font type fonttype Type of the text's font.

Font size fontsize Size of the text's font.

Use file usefile Use or not file to load it in the text area.

Filename filename

Name of the file you want to load in the text area.

If path contains "/" it means we use the full path. If

path doesn't contain "/" the file will be created in

DB  folder of the application.

Editable editable Check if you want to edit the text area.

6.2.3.2 3D Objects library

3D objects library contains the following objects:

§ Sphere

§ Cylinder

§ Cylinder 3D

§ Cone

§ Sector 3D

§ Polygon 3D

§ Tank

§ Border 3D

17
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§ Text/EditField 3D

§ Value with History and Event

6.2.3.2.1  Sphere

Property ST script field Description

Fill color fillcolor Color of the sphere.

154

155
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6.2.3.2.2  Cylinder

Property ST script field Description

Line width linewidth Width of the border's line. 

Color color Color of the border's line.

Fill fill Select fill or not fill cylinder.

Fill color fillcolor Fill color of the cylinder.
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6.2.3.2.3  Cone

Property ST script field Description

Line width linewidth Width of the border's line. 

Color color Color of the border's line.

Fill fill Select fill or not fill cone.

Fill color fillcolor Fill color of the cone.

Aspect ratio aspectratio Aspect ratio of the cone.
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6.2.3.2.4  Sector 3D

Property ST script field Description

Line width linewidth Width of the border's line. 

Color color Color of the border's line.

Fill fill Select fill or not fill sector.

Fill color fillcolor Color of the sector's filling.

Start angle startangle
Start angle of the sector. 0 degrees is the right

middle point of the dimensions rectangle.

Rotation angle rotationangle Counterclockwise rotation angle of the sector.



TeslaSCADA2 IDE User manual150

© 2023 LLC Tesla

6.2.3.2.5  Polygon 3D

Property ST script field Description

Line width linewidth Width of the border's line. 

Color color Color of the border's line.

Fill fill Select fill or not fill polygon.

Fill color fillcolor Color of the polygon's filling.

Hotspots

When you click Collection button the Collection

window will appear:

Where:
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· CoordinateX - X coordinate of the

polygon's node.

· CoordinateY - Y coordinate of the

polygon's node.

· Add - add a new polygon's node.

· Edit - edit the polygon's node.

· Remove - remove the polygon's node.

You can also edit polygon's nodes on the

Canvas :82
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6.2.3.2.6  Tank

Property ST script field Description

Fill color fillcolor Color of the tank.

Ratio ratio  Ratio of the tank.

Vertical vertical  Select vertical or horizontal tank's type.
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6.2.3.2.7  Border 3D

Property ST script field Description

Line width linewidth Width of the border. 

Color color Color of the border.

Fill fill Select fill or not fill the border.

Fill color fillcolor Fill color of the border.

Corner radius cornerradius Radius of the border’s corner.

Glass glass Select use or not glass effect.
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6.2.3.2.8  Text/EditField 3D

Property ST script field Description

Text text Text displayed on the screen by using this object.

Font type fonttype Type of the text's font.

Underline underline Check if you want to underline the text.

Font size fontsize Size of the text's font.

Text placement textplacement

Placement of the text:

§ Left

§ Center

§ Right

Text color textcolor Color of the text.

Border useborder Select use or not use border for the text.

Border width linewidth Width of the border's line. 

Border color bordercolor Color of the border's line.

Fill fill Select fill or not fill text's background.
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Fill color fillcolor Color of the text's background.

Also for all text/editfield objects you can use fields in ST scripts:

§ textbefore - text before the value.

§ textafter - text after the value.

§ decimalpos - decimal position for the value.

6.2.3.2.9  Value with history and event

Property ST script field Description

Text text Text displayed on the screen by using this object.

Font type fonttype Type of the text's font.

Font size fontsize Size of the text's font.

Text placement textplacement

Placement of the text:

§ Left

§ Center

§ Right
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Text color textcolor Color of the text.

Border useborder Select use or not use border for the text.

Border width linewidth Width of the border's line. 

Border color bordercolor Color of the border's line.

Fill fill Select fill or not fill text's background.

Fill color fillcolor Color of the text's background.

6.2.3.2.9.1  Grid

Property ST script field Description

Side side

 Choose side of placement of the trend and event

table:

§ Right

§ Left

§ Top

§ Bottom

§ RightTop

§ LeftTop



Project 157

© 2023 LLC Tesla

Line width Line width of the curve. 

Curve color gridlinecolor Choose curve's color

Line style linestyle

Style of the line:

§ Solid

§ Dash

§ Dot

§ DashDot

Horizontally horizontally Number of trend’s horizontal grid lines.

Vertically vertically Number of trend’s vertical grid lines.

Grid width gridwidth Width of the trend and event table. 

Grid height gridheight Height of the trend and event table.

Font size fontsize Font size of the trend's marks.

Mark color markcolor Color of the marks.

Time format timeformat Time format of the trend's time.

6.2.3.3 Buttons and Switches library

Buttons and Switches library contains the following objects:

§ Button

§ Press button

158
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§ Toggle button

§ Light button

§ Oval light button

§ Image button

§ Oval jump

§ Rectangle jump

§ Right Arrow

§ Left Arrow

§ Switch

§ Switch 3 Pos

§ Apple switch

Some objects have the same General group properties. Below we describe there only for 5

graphical objects - Button, Image button, Switch, Apple switch and Switch 3 Pos.

6.2.3.3.1  Button

Property ST script field Description

Text text Text displayed on the button.

Font type fonttype Type of the button text's font.

Underline underline Check if you want to underline the text.
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Font size fontsize Size of the button text's font.

Text placement textplacement

Placement of the button text:

§ Left

§ Center

§ Right

Text color textcolor Color of the text.

Fill color fillcolor Color of the button.

6.2.3.3.2  Image button

Property ST script field Description

Transparent

background

Make background transparent.

Fill color fillcolor Color of the button.
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6.2.3.3.3  Switch

Property ST script field Description

Text text Text displayed on the switch.

Text color textcolor Color of the text.

Fill color fillcolor Color of the switch background.

Text ON texton Label for ON position of the switch.

Text OFF textoff Label for OFF position of the switch.
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6.2.3.3.4  Apple switch

Property ST script field Description

Text text Text displayed on the switch.

Text color textcolor Color of the text.

Fill color fillcolor Color of the switch background.

Text ON texton Label for ON position of the switch.

Text OFF textoff Label for OFF position of the switch.

Function clicktype

Choose Function type:

§ Toggle

§ Push
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6.2.3.3.5  Switch 3 pos

Property ST script field Description

Text text Text displayed on the switch.

Text color textcolor Color of the text.

Fill color fillcolor Color of the switch background.

Text ON texton Label for ON position of the switch.

Text OFF textoff Label for OFF position of the switch.

Text Neutral textneutral Label for Neutral position of the switch. 
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6.2.3.4 Lights/Indicators library

Lights/Indicators library contains the following objects: 

§ Light

§ Rectangle light

§ Triangle light

§ Triangle light 2

§ Stack light

§ Indicator

§ Rectangle Indicator

§ Oval Indicator

All lights have the same General group properties and all indicators have the same General

group properties. Below we describe it only for two graphical objects - Light and Indicator.
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6.2.3.4.1  Light

Property ST script field Description

Text text Text displayed on the light.

Text color textcolor Color of the text.

Fill color fillcolor Color of the light.
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6.2.3.4.2  Indicator

Property ST script field Description

Color TRUE truecolor  Color TRUE of the indicator.

Color FALSE falsecolor Color FALSE of the indicator.
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6.2.3.5 Pipes library

Pipes library contains the following pipes objects: 

§ Straight

§ End

§ Bow

§ Tee

§ Intersect

§ Elbow

§ Pipeline

§ Straight2

§ End2

§ Bow2

§ Tee2

§ Intersect2

§ Elbow2

All pipes have the same General group properties. Below we describe it only for two graphical

objects - Straight and Pipeline .
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6.2.3.5.1  Pipe

Property ST script field Description

Fill color fillcolor Color of the pipe.
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6.2.3.5.2  Pipeline

Property ST script field Description

Pipe width linewidth Pipe width of the pipeline.

Color fillcolor Color of the pipeline.

Hotspots

When you click Collection button the Collection

window will appear:

Where:

§ CoordinateX - X coordinate of the pipeline's

node.
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§ CoordinateY - Y coordinate of the pipeline's

node.

§ Add - add a new pipeline's node.

§ Edit - edit the pipeline's node.

§ Remove - remove the pipeline's node.

You can also edit pipeline's nodes on the

Canvas :82
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6.2.3.6 Valves library

Valves library contains the following objects: 

§ Valve

§ Round valve

§ Ball valve

§ Position valve

§ Valve ISA

Valve, Round valve and Valve ISA have the same General properties.
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6.2.3.6.1  Valve

Property ST script field Description

Fill color fillcolor Color of the valve.
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6.2.3.6.2  Ball valve

Property ST script field Description

Fill color fillcolor Color of the valve.

Indicator color indicatorcolor Color of the indicator (ball).

Indicator property like indicator property for other graphical object.

Indicator color property like other color properties.
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6.2.3.6.3  Position valve

Property ST script field Description

Fill color fillcolor Color of the valve.

Needle(fill) color indicatorcolor Color of the needle.

Value property like value property for analog meters.

Needle color property like other color properties.
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6.2.3.7 Pumps and Motors library

Pumps library contains the following objects: 

§ Pump

§ Motor

§ Stand-up pump

§ Centrifugal pump

§ Air blower pump

All pumps have the same General group properties. Below we describe there only for one

graphical object - Pump.
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6.2.3.7.1  Pump

Property ST script field Description

Fill color fillcolor Color of the pump.



TeslaSCADA2 IDE User manual176

© 2023 LLC Tesla

6.2.3.8 Fans library

Fans library contains the following objects: 

§ Fan

§ Round fan

§ Square fan  

§ Cool fan

§ Pump blades(gif)

§ Centrifugal fan(gif)

§ Axial fan(gif)

All fans have the same properties. (gif) means that non-vector graphics are used to draw this

graphic object. That means you can't change fill color of this object. For animation gif files are

used.
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6.2.3.8.1  Fan

Property ST script field Description

Fill color fillcolor Color of the fan.

Rotation rotation
Rotation of the fan - clockwise or counter

clockwise.

Set up Rotation ind. properties to rotate fan. Also it's possible to use speed property in ST

script for changing speed animation. For vector graphic it's changed proportional of the value.

For gif animation that depends on the value. For speed below 5000 used fast speed animation,

for speed is equal 5000 used medium speed animation and for speed is greater than 5000

used slow speed animation.
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6.2.3.9 Tanks library

Tanks library contains the following objects: 

§ Vertical tank

§ Horizontal tank

§ Vertical tank with trend

§ Horizontal tank with trend

§ Cone tank

All tanks have the same General group properties. Below we describe it only for one graphical

object - Vertical tank.
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6.2.3.9.1  Vertical tank

Property ST script field Description

Color color Background color of the tank .

Fill color fillcolor Filling color of the tank.

Text text Text displayed on the tank.

Font size fontsize Size of the text's font.
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6.2.3.10Conveyers library

Conveyers library contains the following objects: 

§ Screw conveyer

§ Belt conveyer

§ Screw motion conveyer

§ Screw motion inclined conveyer

§ Auger(gif)

Screw conveyer and Belt conveyer have the same General group properties. Below we describe

it only for one graphical object - Belt conveyer. Screw motion conveyer, Screw motion inclined

conveyer and Auger(gif) have the same General group properties. (gif) means that non-vector

graphics are used to draw this graphic object. That means you can't change fill color of this

object. For animation gif files are used. Below we describe it only for one graphical object -

Screw motion conveyer.
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6.2.3.10.1  Belt conveyer

Property ST script field Description

Fill color fillcolor Color of the conveyr.

Incline inclined  Choose incline or not conveyer.
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6.2.3.10.2  Screw motion conveyer

Property ST script field Description

Fill color fillcolor Color of the fan.

Rotation rotation
Rotation(Motion) of the screw conveyer - right or

left.

Set up Rotation ind. properties to rotate(movement) conveyer. Also it's possible to use speed

property in ST script for changing speed animation. For vector graphic it's changed

proportional of the value. For gif animation that depends on the value. For speed below 5000

used fast speed animation, for speed is equal 5000 used medium speed animation and for

speed is greater than 5000 used slow speed animation.
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6.2.3.11Analog meters library

Analog meters library contains the following objects:

§ Analog meter

§ Analog meter rectangle

§ Analog meter 90 degrees

§ Analog meter 90 degrees 2

§ Analog meter 90 round

§ Analog meter vertical

§ Analog meter vertical ? ll

§ Analog meter horizontal

§ Analog meter horizontal ? ll

§ Range Indicator

§ Gauge

§ Gauge 180 degrees

§ Gauge 90 degrees

§ Gauge 90 degrees 2

Below you can find description 3 objects from analog meters library. The rest objects has the

same properties.
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6.2.3.11.1  Analog meter

Property ST script field Description

Needle(fill) color color Color of the needle.

Fill color fillcolor Color of the meter.

Text text Text of the label.
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6.2.3.11.2  Range indicator

Property ST script field Description

Needle(fill) color color Color of the needle.

Fill color fillcolor Color of the range's background.

Border color bordercolor Color of the border.

Type type

Type of the indicator:

§ Left

§ Right

6.2.3.11.3  Other analog meters

Analog meter rectangle, Analog meter 90 degrees, Analog meter 90 degrees 2, Analog meter

90 round, Analog meter vertical, Analog meter vertical ? ll, Analog meter horizontal and Analog

meter horizontal ? ll have the same General properties: 
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Property ST script field Description

Color color Color of the needle.

Border color bordercolor Color of the border.

Text text Text of the label.

Unit unit Text of the measured value's unit.

?  of intervals interval The number of meter's intervals. 

Use digital usedigital Check it if you want to use also digital meter.
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6.2.3.12Digital meters library

Digital meters library contains the following objects: 

§ Digital meter

§ 4 digit meter

§ 6 digit meter

§ 8 digit meter

§ Meter with history and event

All digital meters have the same general properties.
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6.2.3.12.1  Digital meter

Property ST script field Description

Text text Text of the label.

Text color textcolor Color of the meter's digits.

Fill color fillcolor Color of the meter's background.

Border color bordercolor Color of the meter's border.

Side side

This property only for Meter with history and

event. You can choose where history trend or

event table will be appeared after clicking on

meter.
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6.2.3.13Controls library

Controls library contains the following objects: 

§ Slider

§ Slider vertical

§ Slider horizontal

§ Counter

§ Counter rectangle

§ Apple slider

§ Selector

§ ComboBox

§ CheckBox

§ MenuBox

§ MenuCheckList

§ CheckList
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6.2.3.13.1  Slider

Property ST script field Description

Color color Color of the slider's background.

Fill color fillcolor Color of the slider's filling.
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6.2.3.13.2  Slider vertical and horizontal

Property ST script field Description

Color color Color of the slider's background.

Fill color fillcolor Color of the slider's filling.

Text text Text of the label.

Unit unit This property is not used in slider.

?  of intervals interval The number of slider's intervals. 

Use digital usedigital Check it if you want to use also digital meter.
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6.2.3.13.3  Counter and Counter rectangle

Property ST script field Description

Color color Color of the counter's background.

Text color textcolor Color of the counter's digits.
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6.2.3.13.4  Selector and Combo box

Property ST script field Description

Fill Color fillcolor Color of the selected object's item background .

Color color
Color of the non-selected object's item

background.
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6.2.3.13.5  Menu box

Property ST script field Description

Fill Color fillcolor Color of the selected object's item background .

Color color
Color of the non-selected object's item

background.

Expand type expandedtype

 Expanded type of the menu: 

§ horizontally 

§ vertically 

Animation animation
Check if you want to animate expanding of the

menu.
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6.2.3.13.6  Check box and Check list

Property ST script field Description

Fill Color fillcolor Color of the selected object's item background .

Color color Color of the text.

Line width linewidth Width of the border's line.

Value

After clicking Collection you’ll see window: 

Where:

§ Tag - choose tag for the object's menu item.
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§ Value -  value which will be written after

selecting the item of the object's menu.

§ Uncheck value - value which will be written

after unselecting the item of the object's

menu.

§ Text - enter text for the object's menu item.

6.2.3.13.7  Menu check list

Property ST script field Description

Fill Color fillcolor Color of the selected object's item background .

Color color Color of the text.

Expand type expandedtype

 Expanded type of the menu: 

§ horizontally 

§ vertically 

Animation animation
Check if you want to animate expanding of the

menu.

Line width linewidth Width of the border's line.
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Value

After clicking Collection you’ll see window: 

Where:

§ Tag - choose tag for the object's menu item.

§ Value -  value which will be written after

selecting the item of the object's menu.

§ Uncheck value - value which will be written

after unselecting the item of the object's

menu.

§ Text - enter text for the object's menu item.
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6.2.3.13.8  Parameter list

Property ST script field Description

Fill Color fillcolor Color of the selected object's item background .

Color color Color of the text.

Line width linewidth Width of the border's line.

Value

After clicking Collection you’ll see window: 

Where:

§ Tag - choose tag for the parameter list item.

§ Name - name of the parameter list item.

§ Decimal position - decimal position for the

parameter list item's values.
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Write

simultaneously 
simultaneosly

 Check it to enter values simultaneously in tags.

6.2.3.14Electrical library

Electrical library contains the following objects: 

§ Electrical switch

§ 2-Way Electrical switch

§ 2-Way Electrical switch with neutral

§ Transformer

Below description of the Electrical switch. For the other switches properties are the same.
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6.2.3.14.1  Electrical switch

Property ST script field Description

Line width linewidth Width of the switch line. 

Color color Color of the switch line.

Beginmarker beginmarker

Marker of the switch line's begin:

§ Flat

§ Arrow

§ Square

§ Circle

Endmarker endmarker

Marker of the switch line's end:

§ Flat

§ Arrow

§ Square

§ Circle
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6.2.3.14.2  Transformer

Property ST script field Description

Line width linewidth Width of the transformer's line. 

Color color Color of the transformer's line.
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6.2.3.15Trends and Charts library

Trends library contains the following objects: 

§ Trend

§ Real time trend

§ Trend DB

§ Trend OPC UA History

§ Pie Chart

§ Bar chart

§ HTTP trend

§ Wind chart

Trend and Real time trend draw curves based on tags that used history data collection (check

Enable history  in Tags properties). Trend DB draw curves based on tags that used data

stored in general database  (check Store in DB  in Tags properties). Trend OPC UA History

draw curves based on tags that bind to OPC UA nodes supported Historyzing property. All

trends have the same General and Grid group properties. Below we describe their only for one

graphical object - Trend. 
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6.2.3.15.1  Trend

Property ST script field Description

Line width linewidth Width of the border's line. 

Color color Color of the border's line.

Fill fill Select fill or not fill trend.

Fill color fillcolor Fill color of the trend.

Curves

After clicking Collection you’ll see window: 

 

Where:
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§ Tag -  tag that you want to bind to this

curve.

§ Name - name of the curve.

§ Line with - curve's line width.

§ Color - curve's line color.

§ Type - line's type:

1. Type 1 -  just draw the line.

2. Type 2 -  draw line with ? lling till axis

X.

3. Type 3 -  draw a ladder line.

4. Type 4 -  draw a ? lled ladder line. 

Default period

(min)
defaultperiod

Default time period of the trend (end time - begin

time).

History DB *
History database name of the HTTP server for

HTTP history DB trend.

Auto refresh *
Check it if you want to auto refresh HTTP history

DB trend.

* Available only in HTTP history DB trend.

Also Trend object has several properties that you can’t setup by using settings dialog window,

but you can setup by using ST script: 

1. begin - start time for trend information. Time represented in minutes from current

period. (start time = current time - begin). 

2. end - ?nish time for trend information. Time represented in minutes from current period.

(?nish time = current time - end). 

3. title - title for the trend’s report representation. 

4. ? lename - name of the report’s ? le. 

5. number - report’s frequency of writing values. 

6. savereport - when this value become true trend’s report will be created.

7. begindatetime - start time for trend information. Time represented in milliseconds from

1 January 1970. 

8. enddatetime - ?nish time for trend information.  Time represented in milliseconds from

1 January 1970.

9. disablesavereport - disable "Save report" button in the dialog.

      10. disableprint -  disable "Print" report button in the dialog.  
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6.2.3.15.1.1  Grid

Property ST script field Description

Line width  Width of grid’s lines . 

Color Color of grid's lines.

Line style linestyle

Style of the line:

§ Solid

§ Dash

§ Dot

§ DashDot

Horizontally horizontally Number of trend’s horizontal grid lines.

Vertically vertically Number of trend’s vertical grid lines.

Maximum maximum Maximum of the trend's value. 

Minimum minimum Minimum of the trend's value.

Font size fontsize Font size of the trend's marks.

Mark color markcolor Color of the marks.

Time format timeformat Time format of the trend's time.
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6.2.3.15.2  Pie chart

Property ST script field Description

Sectors

After clicking Collection you’ll see window: 

 

Where:

§ Tag -  tag that you want to bind to this

chart's sector.

§ Name - name of the sector.

§ Color - sector's color.

Use legends uselegends Check it if you want to add legends to the chart.

Donut donut Check it if you want to use ring type chart.
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6.2.3.15.3  Bar chart

Property ST script field Description

Fill fill Select fill or not fill bar chart.

Fill color fillcolor Fill color of the bar chart.

Bars

After clicking Collection you’ll see window: 

 

Where:

§ Tag -  tag that you want to bind to this bar.

§ Name - name of the bar chart.

§ Color - bar's color.

Use legends uselegends
Check it if you want to add legends to the bar

chart.
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6.2.3.15.3.1  Grid

Property ST script field Description

Line width Width of grid’s lines . 

Color Color of grid's lines.

Line style linestyle

Style of the line:

§ Solid

§ Dash

§ Dot

§ DashDot

Vertically vertically Number of trend’s vertical grid lines.

Maximum maximum Maximum of the bar chart's value. 

Minimum minimum Minimum of the bar chart's value.

Font size fontsize Font size of the trend's marks.

Mark color markcolor Color of the marks.
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6.2.3.15.4  Wind chart

Property ST script field Description

Sectors

After clicking Collection you’ll see window: 

 

Where:

§ Tag -  tag that you want to bind to this

chart's sector.

§ Name - name of the sector.

§ Color - sector's color.
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Use legends uselegends Check it if you want to add legends to the chart.

Vertically vertically Enter number of scale ticks.

Minimum minimum Minimum of chart's value.

Maximum maximum Maximum of chart's value.

Row number number Number of wing's directions.

Legends legends Legends for wing's directions.

6.2.3.16Events library

Events library contains the following object: 

§ Events log  

§ HTTP Events log

§ Events ticker

Events log collects tag’s events (check Enable alarms  and check events you want to collect in

Tags properties). Events will be collected in events database. You can setup it in Project

properties->Events/History tab .

211
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6.2.3.16.1  Events log

Property ST script field Description

Use title usetitle Use title for the table or not.

Title title Title of the table.

Font size fontsize Size of the text's font.

 Acknowledge

color 
ackcolor

Row’s background color of the acknowledged

events

Unacknowledge

color 
unackcolor

Row’s background color of not unacknowledged

events

Priority colors

After clicking Collection button you’ll see the

window: 
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Where:

§ From -  the priority  of the event from

which be used this color.

§ To -  the priority  of the event to which be

used this color.

§ Color - color of the event text.

§ Add - add a new color priority range.

§ Edit - edit selected color priority range.

§ Remove - remove selected color priority

range.

Time format timeformat Time format of the text in time column.

Only active state onlyactivestate Display only active state of the events.

Only

unacknowledged
onlyunack

Display only unacknowledged events.

HTTP server* Choose HTTP server.

*Only for HTTP History DB table

Also Event log object has several properties that you can’t setup by using settings dialog box,

but you can setup by using ST script:

1. begin - start time for log information. Time represented in minutes from current

period. (start time = current time - begin). 

2. end - ?nish time for log information. Time represented in minutes from current

period. (?nish time = current time - end). 

3. ? lename - name of the report’s ? le. 

4. savereport - when this value become true trend’s report will be created.

5. enbegin - enable start time for the filter of the event log information.

6. enend - enable finish time for the filter of the event log information.

7. enprbegin - enable priority begin for the filter of the event log information.

8. enprend - enable priority end for the filter of the event log information.

9. beginpriority - begin priority for the filter of the event log information.

10. endpriority - end priority for the filter of the event log information.

378

378



Project 213

© 2023 LLC Tesla

11. begindatetime - start time for trend information. Time represented in milliseconds

from 1 January 1970. 

12. enddatetime - ?nish time for trend information.  Time represented in milliseconds

from 1 January 1970.  

      13. disablesavereport - disable "Save report" button in the dialog.

14. disableprint -  disable "Print" report button in the dialog.

6.2.3.16.1.1  Columns

Property ST script field Description

Enable (not shown)

Enable or disable correspondent column:

§ Name

§ Time 

§ Type

§ Priority

§ Message

§ Value

§ Ack.time

Title

nametitle

timetitle

typetitle

prioritytitle

messagetitle

valuetitle

Title of the corresponding column.
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acktimetitle

Width

namewidth

timewidth

typewidth

prioritywidth

messagewidth

valuewidth

acktimewidth

Width of the corresponding column.

6.2.3.16.2  Events ticker

Property ST script field Description

Speed(ms) speed Speed of the running text.

From priority beginpriority Begin priority of the shown events.

To priority endpriority End priority of the shown events.

Text defaulttext
Default text displayed. It's shown if events in

selected priority range are not available.
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Font type fonttype Type of the text's font.

Underline underline Check if you want to underline the text.

Font size fontsize Size of the text's font.

Text color textcolor Color of the text.

Border useborder Select use or not use border for the text.

Border width linewidth Width of the border's line. 

Border color bordercolor Color of the border's line.

Fill fill Select fill or not fill text's background.

Fill color fillcolor Color of the text's background.

Also for all text/editfield objects you can use fields in ST scripts:

§ eventscount - number of events are shown in the events ticker.

6.2.3.17Recipes library

Recipes library contains the following objects that works with recipes  databases: 

§ Recipe table

§ Recipe selector

§ Parameter table

§ Schedule table

386
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6.2.3.17.1  Recipe selector

Property ST script field Description

Recipe recipename

Choose Recipe  you want to bind to the

selector. During running you can select ?elds of

the recipe database by clicking on the recipe

selector.

Text color textcolor Color of the text.

Fill color fillcolor Color of the selector.

386
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6.2.3.17.2  Recipe table

Property ST script field Description

Recipe recipename

Choose Recipe  you want to bind to the table. 

During running you can add, edit and delete ?elds

of the recipe database by clicking right button on

the table and choosing operation.

Use title usetitle Use title for the table.

Title title Title of the table.

Font size fontsize Size of the text's font.

Name column

width
namecolumnwidth

Set width of the name’s column.

Other column

width
othercolumnwidth

 Set width of other columns.

Also Recipe Table object has several properties that you can’t setup by using settings dialog

window, but you can setup by using ST script:  

1. rownumber - number of the row is choosen (clicked) by user.

386
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6.2.3.17.3  Parameter table

Property ST script field Description

Parameter column parametercolumn Parameter column name.

Value column valuecolumn Value column name.

Use DB value usedb Check it if you want to use DB value column.

DB value column dbcolumn DB value column name.

Recipe recipename Choose Recipe  you want to bind to the table

Row number rownumber
Row number of the database which be used in DB

value column.

Font size fontsize Size of the text's font.

Name column

width
namecolumnwidth

Set width of the name’s column.

Other column

width
othercolumnwidth

 Set width of other columns.

386
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Parameters

After clicking Collection button you’ll see the

window:

Where:

§ Tag - tag you want to bind to the table's

parameter.

§ Name - name of the parameter.

§ Decimal position - decimal position for the

tag's value.

§ Add - add parameter.

§ Edit - edit parameter.

§ Remove - remove parameter.
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6.2.3.17.4  Schedule table

Property ST script field Description

Default schedule recipename

Choose default schedule from Recipes  you

want to bind to the table. During running you can

add, edit and delete ?elds of the recipe database

by clicking right button on the table and choosing

operation 

Title title Title of the table.

Font size fontsize Size of the text's font.

Name column

width
namecolumnwidth

Set width of the name’s column.

Other column

width
othercolumnwidth

 Set width of other columns.

Time interval timertagname

Choose time interval tag. Depending of this tag’s

value will be duration of the next step(row) of the

schedule table. 

386
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Repeat repeat
Check it if you want to repeat all schedule steps

(rows).

6.2.3.18History DB library

History DB library contains the following objects that works with History DB  databases:

§ History DB table

§ History DB trend

§ XY Trend

§ History Excel Report

§ History Max and Min Report

§ HTTP history DB trend

§ HTTP XY Trend

§ HTTP History DB table

388
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6.2.3.18.1  History DB table

Property ST script field Description

History DB historydbname
Choose History DB  you want to bind to the

table. 

Use title usetitle Use title for the table or not.

Title title Title of the table.

Font size fontsize Size of the text's font.

Date and Time

type
type

Date and time type representation (2 columns or 1

column)

Format timeformat Date and time format

Date column width datecolumnwidth Set width of the date’s column.

Time column width timecolumnwith Set width of the time’s column.

388
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Other column

width
othercolumnwidth

Set width of other columns.

Decimal position decimalpos
Decimal position of tag’s values entered in the

table.

Auto refresh autorefresh
Check it if you want to update table every time

when new tag’s value added into database.

Time order by orderby

Choose time order by of the database rows:

§ ASC

§ DESC 

*HTTP server Choose HTTP server

*Only for HTTP History DB table

Also History DB Table object has several properties that you can’t setup by using settings

dialog window, but you can setup by using ST script: 

1. begin - start time for table information. Time represented in minutes from current period.

(start time = current time - begin). 

2. end - ?nish time for table information. Time represented in minutes from current period.

(?nish time = current time - end). 

3. ? lename - name of the report’s ? le. 

4. savereport - when this value become true trend’s report will be created.

5. begindatetime - start time for trend information. Time represented in milliseconds from 1

January 1970. 

6. enddatetime - ?nish time for trend information.  Time represented in milliseconds from 1

January 1970.  

7. disablesavereport - disable "Save report" button in the dialog.

8. disableprint -  disable "Print" report button in the dialog.
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6.2.3.18.2  History DB trend

Property ST script field Description

History DB historydbname
Choose History DB  you want to bind to the

trend. 

Line width linewidth Width of the border's line. 

Color color Color of the border's line.

Fill fill Select fill or not fill trend.

Fill color fillcolor Fill color of the trend.

Auto refresh autorefresh
Check it if you want to update trend every time

when new tag’s value added into database.

Curves

After clicking Collection you’ll see window: 

388
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Where:

§ Tag -  tag that you want to bind to this

curve.

§ Name - name of the curve.

§ Line with - curve's line width.

§ Color - curve's line color.

§ Type - line's type:

1. Type 1 -  just draw the line.

2. Type 2 -  draw line with ? lling till axis

X.

3. Type 3 -  draw a ladder line.

4. Type 4 -  draw a ? lled ladder line. 

Default period

(min)
defaultperiod

Default time period of the trend (end time - begin

time).

Also History DB Trend object has several properties that you can’t setup by using settings

dialog box, but you can setup by using ST script: 

1. begin - start time for trend information. Time represented in minutes from current

period. (start time = current time - begin). 

2. end - ?nish time for trend information. Time represented in minutes from current

period. (?nish time = current time - end). 

3. ? lename - name of the report’s ? le. 

4. savereport - when this value become true trend’s report will be created. 

          5. begindatetime - start time for trend information. Time represented in milliseconds

from 1 January 1970. 

          6. enddatetime - ?nish time for trend information.  Time represented in milliseconds

from 1 January 1970.  

          7. disablesavereport - disable "Save report" button in the dialog.

          8. disableprint -  disable "Print" report button in the dialog.
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          9. duration - duration of the history time line in minutes. It works only when auto refresh

is enabled. End time will be current time and begin time will be current time minus duration in

minutes.

6.2.3.18.2.1  Grid

Property ST script field Description

Line width  Width of grid’s lines . 

Color Color of grid's lines.

Line style linestyle

Style of the line:

§ Solid

§ Dash

§ Dot

§ DashDot

Horizontally horizontally Number of trend’s horizontal grid lines.

Vertically vertically Number of trend’s vertical grid lines.

Maximum maximum Maximum of the trend's value. 

Minimum minimum Minimum of the trend's value.

Font size fontsize Font size of the trend's marks.

Mark color markcolor Color of the marks.
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Time format timeformat Time format of the trend's time.

6.2.3.18.3  XY Trend

Property ST script field Description

History DB* historydbname
Choose History DB  you want to bind to the

trend.

Line width linewidth Width of the border's line. 

Color color Color of the border's line.

Fill fill Select fill or not fill trend.

Fill color fillcolor Fill color of the trend.

Auto refresh autorefresh
Check it if you want to update trend every time

when new tag’s value added into database.

Curves
After clicking Collection you’ll see window: 

388
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Where:

§ Tag -  tag that you want to bind to this

curve.

§ Name - name of the curve.

§ Line with - curve's line width.

§ Color - curve's line color.

§ Type - line's type:

1. Type 1 -  just draw the line.

2. Type 2 -  draw line with ? lling till axis

X.

3. Type 3 -  draw a ladder line.

4. Type 4 -  draw a ? lled ladder line. 

Default period

(min)
defaultperiod

Default time period of the trend (end time - begin

time).

Axis X tag tagxname Bind tag to axis X of the trend.

 *For HTTP XY Trend you have to enter History DB manually.

Also History DB Trend object has several properties that you can’t setup by using settings

dialog box, but you can setup by using ST script: 

1. begin - start time for trend information. Time represented in minutes from current

period. (start time = current time - begin). 

2. end - ?nish time for trend information. Time represented in minutes from current

period. (?nish time = current time - end). 

3. ? lename - name of the report’s ? le. 

4. savereport - when this value become true trend’s report will be created. 
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6.2.3.18.3.1  Grid

Property ST script field Description

Line width  Width of grid’s lines . 

Color Color of grid's lines.

Line style linestyle

Style of the line:

§ Solid

§ Dash

§ Dot

§ DashDot

Horizontally horizontally Number of trend’s horizontal grid lines.

Vertically vertically Number of trend’s vertical grid lines.

Maximum maximum Maximum of the trend's value. 

Minimum minimum Minimum of the trend's value.

Maximum X maximumx Maximum of the axis X trend's value. 
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Minimum X minimumx Minimum of the axis X trend's value.

Font size fontsize Font size of the trend's marks.

Mark color markcolor Color of the marks.

Time format timeformat Time format of the trend's time.

6.2.3.18.4  History Excel report and History Max and Min report

Property ST script field Description

History DB historydbname
Choose History DB  you want to bind to the

table. 

Title title Title of the table of the report.

Title 2 title2 Second title of the table of the report.

Decimal position decimalpos
Decimal position of tag’s values entered in the

report's table.

Transparent

background 
transparent

Check it if you want to make background of the

button invisible.

Fill color fillcolor Fill color of the report's button.

Also reports object has several properties that you can’t setup by using settings dialog window,

but you can setup by using ST script: 

388
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1. begin - start time for report information. Time represented in minutes from current

period. (start time = current time - begin). 

2. end - ?nish time for report information. Time represented in minutes from current

period. (?nish time = current time - end). 

3. ? lename - name of the report’s ? le. 

4. savereport - when this value become true trend’s report will be created.

6.2.3.19Odoo ERP

Odoo ERP library contains the following object: 

§ Odoo ERP table

Odoo ERP table collects rows of Odoo ERP.

232
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6.2.3.19.1  Odoo ERP table

Property ST script field Description

Odoo ERP odooerpname Choose Odoo ERP  bind to this table. 

Model modelname Choose model of the Odoo ERP.

Title title Title of the table.

Font size fontsize Font size of the table's texts.

Fields

After clicking Fields Collection button you’ll see

the window:

390
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Where:

· Name - name of the ?eld. 

· Field - field of the Odoo ERP model.

· Width -  width of the ?eld’s column.

· Use relation -  check it to get data from the

relation model.

· Read only - check it if you don’t want to let

change ?eld. 

Filters

After clicking Filters Collection button you’ll see

the window:

Where:

§ Name - name of the ? lter. 

§ Field - field of the Odoo ERP model.

§ Comparison -  choose comparison

operation for the ? lter. 

§ Value -  value for the comparison.

§ Use -  check it if you want to use this ? lter

for the table by default. 
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§ Color - choose color for rows that ?ts for

this ? lter conditions.

Functions

After clicking Functions Collection button you’ll

see the window: 

Where:

§ Name - name of the function. 

§ Function - function of the Odoo ERP model.

§ Bind tag - check it if you want to bind the

tag to the button. 

§ Tag - choose tag for the function. 

§ Value -  value that will be written to the tag.

§ Use ? lter - check it to bind button of the

function to the ? lter (if check the button

enable if ? lter condition is TRUE). 

§ Filter - choose filter bind to the function.

 Auto refresh autorefresh  Check it to refresh table automatically.

When you click on the row of the table you will select the row and you can use it in the script by

using ?elds: selectrow? eld and selectrowvalue. At the beginning ?rst you should select ?eld

of the row and then get or set value of the row. 
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6.2.3.20Databases library

Databases library contains the following object:

§ Database table 236
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6.2.3.20.1  Database table

Property ST script field Description

Database databasename

Database name. If database name contains

“jdbc:mysql” it means address of MySQL

database. If database name contains "jdbc:mssql"

it means address of MSSQL  database. If

database name contains "jdbc:postgresql" it

means address of PostgreSQL  database.  If

database name doesn't contain "jdbc" it means

address of SQLLite  database. 

Username username Username for MySQL  database.

Password password Password for MySQL  database.

Table name tablename Name of the table.

Use title usetitle Use title for the table or not.

Title title Title of the table.

Font size fontsize Size of the text's font.

Column width columnwidth Set width of the columns.

28
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Also Database Table object has several properties that you can’t setup by using settings dialog

window, but you can setup by using ST script:  

1. disablesavereport - disable "Save report" menu item in the context menu.

2. disableprint -  disable "Print" menu item in the context menu.

3. columnwidtharray - use this value to setup different column widths. Example:

 Objects.Databasetable.columnwidtharray = "[10, 150, 150, 200]";

4. rownumber - number of the row is choosen (clicked) by user.

5. resultset - if you want to fill data from Result set , set name of the result set here.

6. csv - if you want to fill data from .csv file set name of the file here (if you use just name the

file will be gotten from the DB  folder. You can use the full path also).

resultset and csv don't works on iOS version.

6.2.3.21Widgets library

Widgets library contains the following object: 

§ WebView

§ Video

§ Analog Clock

§ Digital Clock

§ Date and time

§ Date and time selector

347
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§ Color picker

§ Color rectangle

6.2.3.21.1  WebView

Property ST script field Description

Url url  Url of the internet resource.

243
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6.2.3.21.2  Video

Property ST script field Description

Url url  Url of the internet resource.

Type type

Type of the video signal: 

§ MP4,FXM,FLV,HLS

§ MJPEG

§ JPEG

§ RTSP*

Authentication security
Check it if your video camera use username and

password for login.

Username username Username of the authentication.

Password password Password of the authentication.

Motion detect motiondetect Check it for detecting motion by using this camera.

Time interval interval Time interval in ms for comparing 2 frames.
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Tag
Choose tag for writing the value of comparing 2

frames in %. 

Auto save image autosaveimage
Check it if you want to save images from video

camera depending on the value of motion detect.

Save condition savecondition Choose save condition.

Difference diff
Difference between 2 frames in % during motion

detect.

Properties Authentication, Username, Password, Motion detect, Time interval, Tag, Auto

save image, Save condition, Difference  is used only PC versions. These features doesn’t

work on Android and iOS.

* RTSP protocol can be used only on PC. You should install VLC media player for your OS to

have possibility to use this protocol.

6.2.3.21.3  Analog clock

Property ST script field Description

Text text Text of the clock's label.

https://www.videolan.org/
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6.2.3.21.4  Digital clock

Property ST script field Description

Text text Text of the label.

Text color textcolor Color of the clock's digits.

Fill color fillcolor Color of the clock's background.

Border color bordercolor Color of the clock's border.
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6.2.3.21.5  Date and time

Property ST script field Description

Font type fonttype Type of the text's font.

Text color textcolor Color of the text.

Date format timeformat Time format of the date and time object.
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6.2.3.21.6  Color picker and Color rectangle

Property ST script field Description

Red color redcolortagstring Choose Red color tag.

Green color greencolortagstring Choose Green color tag.

Blue color bluecolortagstring Choose Blue color tag.

Opacity
opacitycolortagstrin

g

Choose Opacity tag.
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6.2.3.21.7  Date and time selector

Property ST script field Description

Format text Date and time format of the selector.

Font type fonttype Type of the text's font.

Underline underline Check if you want to underline the text.

Font size fontsize Size of the text's font.

Text placement textplacement

Placement of the text:

§ Left

§ Center

§ Right

Text color textcolor Color of the text.

Border useborder Select use or not use border for the text.

Border width linewidth Width of the border's line. 

Border color bordercolor Color of the border's line.
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Fill fill Select fill or not fill text's background.

Fill color fillcolor Color of the text's background.

6.2.4 User-defined library

Create user-defined library

You can create your own library by clicking right button on User-defined section of the Add

graphical object  window and choosing New library menu item:

 You can add graphical object in your library by clicking right button on the object on

Canvas  or Screen window  and choosing Add to Library->You library menu item:

121
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 You can Select, Rename or Delete created object in your library by clicking right button on it

and selecting correspondent menu item.

Rename user-de? ned library

To rename library right click on the library you want to rename and choose Rename library

menu item. 

 

Delete user-de? ned library

To delete library right click on the library you want to delete and choose Delete library menu

item. 

Export user-de? ned library 

To export library: 

1. Right click on the library you want to export and choose Export library menu item. 

2. Now select the location and click the button Save (TeslaSCADA library extension

.tsp2lib). 

Library with all objects are exported in the the file. You can use this file to import library with all

objects in a new project.

If you want to export your library with all objects and scripts that used these objects and also

with screens that called from this object (for example button that call screen or popup screen)
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or with screens that called from the scripts bind to the object, you need to use Export library

plus menu item. In this case in exported file you'll have object, scripts and screens.

Import user-de? ned library

 To import library: 

1. Right click on the User-defined section and choose Import library menu item. 

2. Now select the library ? le and click Open (TeslaSCADA library extension .tsp2lib). 

If exported files contains only objects (you use Export library menu item during exporting

library) only library with objects are created in the Add graphical object. If exported file also

contains script and/or screens (you use Export library plus menu item during exporting library)

these scripts and screens are added in the project and you can see them in the Project

window .

Below you can find example how to create complex object with script and screen are bound to

it. And how to add this object to the user-defined library, how to export this library and how to

import it in the new project.

6.2.4.1 Example: How to create new graphical object.

Let's create an object pump that consists of 2 simple objects: Ellipse  and Polygon :

Let's group these objects:

Let's add 3 tags in our project:

66
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We want that color of the ellipse is bound to the tag with name like this: Pump{number}State.

Where {number} is number of the instance. And also we want that when user click on the object

popup window is appeared with state information and description. Popup window looks like

this:

Where objects with name PumpState and PumpDescription (texts of these objects are similar

objects names) will display state information of the pump and its description.

For the ellipse object let's create user-defined properties - number and description. To do this

you have to double click on the Ellipse object (or choose Object properties menu item from

context menu) in Screen window :

Object properties window is appeared:

84
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Click User-defined Collection button and add our properties:

Then close this window and close Object properties window by clicking OK to confirm your

changes. Now reopen Ellipse properties and open Fill color tab:
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To setup indirect tag's value click "..." and write Pump{number}State where {number} our user-

defined property:

Click OK and close Choose tag window. Because user-defined property "number" equal 1 the

property Fill color for the object is bound to the Pump1State tag:
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 Click OK to close Object properties window. Now let's test functionality. Run simulation and

change Pump1State value from false to true:

To call popup window let's create object type script:
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This script we add to the scripts of the ellipse:

The text of the script looks like this:



Project 253

© 2023 LLC Tesla

Now when you click on the ellipse of the pump you'll see the window (depending on the tag

value). You can create other pump instance and change user-defined property number to 2 or 3

to bind pumps to Pump2State and Pump3State tags. And you can change description property

for every pump's ellipse:

Attention! Maybe it's better to use Polygon for holding user-defined properties and click action,

because it's over the Ellipse. Or like option you can use transparent rectangle over the whole

group object and use it's click action.

Now we can add this graphical object to our library:

Now let's open Add graphical object window and find our library. Right click on it and choose

Export library plus menu item. File dialog box will be appeared. Enter name of the library and

click Save. This library will be save with out object and also saved script we created in this

project and popup window. Now if you want to use this object with these popup window and

script just import to other project.
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Important! In the new project you have to create the same tag names.

6.2.5 Properties

Every graphical object has several group of properties. To use property of the graphical object

check Enable Property. You can select tag  that be bound to the property by using

ComboBox (you can choose it by beginning entering name of the tag when ComboBox

focused) or use Button (…). Every object has Flash, Rotation, Motion and Visibility properties.

Other properties depend on the object. 

By clicking (…) when you bind tag to the property you’ll get to the “Choose tag” dialog where

you can choose tag from the hierarchy tree or enter its name in the ?eld “Tag name”. In the

?eld you can use indirect names enclosed in curly braces {group}, {name} and {user-defined

property} of the object. It’s useful if you use many the same type objects and want to bind to

the group of the same type tags. 

6.2.5.1 Flash

Flash property lets object to ?ash when conditions is TRUE or FALSE. To edit ?ash property click

Flash tab on the object property window. 

74
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Property Description

Tag Select the tag value of which will be compared. 

Value  Enter the comparison value.

Type

 Select type of comparison:

§ Tag.PV==Value - tag's value is equal to the comparison value.

§ Tag.PV>=Value - tag's value is equal to or greater than the

comparison value.

§ Tag.PV<=Value - tag's value is equal to or less that the

comparison value.

§ Tag.PV>Value - tag's value is greater than the comparison

value.

§ Tag.PV<Value - tag's value is less than the comparison value.

§ Tag.PV!=Value - tag's value is not equal to the comparison

value.

§ Tag.PV in the range - tag's value compares to the values in the

ranges. To setup ranges click Collection button.

Duration TRUE(ms)*

Write period’s time in milliseconds of objects ?ashing if the

comparison is true in the Duration TRUE(ms) ?eld. If you enter 0 the

object will not ?ashing. 

Duration FALSE(ms)*

Write period’s time in milliseconds of objects ?ashing if the

comparison is false in the Duration FALSE(ms) ?eld. If you enter 0

the object will not ?ashing. 

Ranges
 If you select Tag.PV in the range in the Type combobox and click

Collection button. You’ll see the window:
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Where:

· From - enter the value from which the object will ?ash with this

periodicity in the ?eld. 

· To - enter the value to which the object will ?ash with this

periodicity in the ?eld. 

· Duration(ms) -  enter period of ?ashing in the ?eld. 

You can Add, Edit or Remove collection element of ?ashing

conditions. 

* This properties you can use in ST scripts by using trueflashduration and falseflashduration

property keywords. For example: Objects.Button.trueflashduration = 1000;

6.2.5.2 Rotation

Rotation property lets to rotate the object proportional to the value of the tag. To edit rotation

property click Rotation tab on the object property window.
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Property Description

Tag Select the tag value of which will be compared. 

Rotation angle(min) Enter the minimum of rotation angle in the ?eld. 

Rotation angle(max) Enter the maximum of rotation angle in the ?eld. 

Rotation value(min) Write the minimum of the tag’s value in the field. 

Rotation value(max) Write the maximum of  the tag’s value in the field. 

PivotX Enter X coordinate of the pivot in the ?eld.

PivotY Enter Y coordinate of the pivot in the ?eld.

6.2.5.3 Motion

Motion property lets to move the object depending on value of the tag. To edit motion

property click Motion tab on the object property window. 

Property Description

Tag
 Select the tag depending on value of which the object will change

location coordinates. 

Hotspots

Click Collection button to edit move conditions coordinates. After

clicking you’ll see the window: 
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§ From - enter the value from which the object will change

coordinates in the ?eld. 

§ To -  enter the value to which the object will change coordinates

in the ?eld. 

§ TranslationX -  write X coordinate (X offset of the object

position on the screen). 

§ TranslationY - write Y coordinate (Y offset of the object

position on the screen).

6.2.5.4 Visibility

Visibility property lets to make the object visible or not depending on the tag’s value. To edit

visibility property click Visibility tab on the object property window. 
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Property Description

Tag Select the tag value of which will be compared. 

Value*  Enter the comparison value.

Type

 Select type of comparison:

§ Tag.PV==Value - tag's value is equal to the comparison value.

§ Tag.PV>=Value - tag's value is equal to or greater than the

comparison value.

§ Tag.PV<=Value - tag's value is equal to or less that the

comparison value.

§ Tag.PV>Value - tag's value is greater than the comparison

value.

§ Tag.PV<Value - tag's value is less than the comparison value.

§ Tag.PV!=Value - tag's value is not equal to the comparison

value.

* This property you can use in ST scripts by using visibilityvalue property keyword. For

example: Objects.Button.visibilityvalue = false;

6.2.5.5 Line color

Line color property lets object to change color of its line when conditions is TRUE or FALSE. To

edit line color property click Line color tab on the object property window. 

Property Description

Tag Select the tag value of which will be compared. 
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Value  Enter the comparison value.

Type

 Select type of comparison:

§ Tag.PV==Value - tag's value is equal to the comparison value.

§ Tag.PV>=Value - tag's value is equal to or greater than the

comparison value.

§ Tag.PV<=Value - tag's value is equal to or less that the

comparison value.

§ Tag.PV>Value - tag's value is greater than the comparison

value.

§ Tag.PV<Value - tag's value is less than the comparison value.

§ Tag.PV!=Value - tag's value is not equal to the comparison

value.

§ Tag.PV in the range - tag's value compares to the values in the

ranges. To setup ranges click Collection button.

Color TRUE Choose a color that will result if the comparison is TRUE in this field.

 Color FALSE Choose a color that will result if the comparison is FALSE in this field.

Ranges

 If you select Tag.PV in the range in the Type combobox and click

Collection button. You’ll see the window:

Where:

· From -  enter the value from which the object will change color in

the ?eld. 

· To - enter the value to which the object will change color in the

?eld. 

· Color -  choose color for this range. 

You can Add, Edit or Remove collection element of line color

conditions. 
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6.2.5.6 Fill color

Fill color property lets object to change color of its ? lling when conditions is TRUE or FALSE. To

edit ? ll color property click Fill color tab on the object property window. 

Property Description

Tag Select the tag value of which will be compared. 

Value Enter the comparison value.

Type

Select type of comparison:

§ Tag.PV==Value - tag's value is equal to the comparison value.

§ Tag.PV>=Value - tag's value is equal to or greater than the

comparison value.

§ Tag.PV<=Value - tag's value is equal to or less that the

comparison value.

§ Tag.PV>Value - tag's value is greater than the comparison

value.

§ Tag.PV<Value - tag's value is less than the comparison value.

§ Tag.PV!=Value - tag's value is not equal to the comparison

value.

§ Tag.PV in the range - tag's value compares to the values in the

ranges. To setup ranges click Collection button.

Color TRUE Choose a color that will result if the comparison is TRUE in this field.

 Color FALSE Choose a color that will result if the comparison is FALSE in this field.
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Ranges

If you select Tag.PV in the range in the Type combobox and click

Collection button. You’ll see the window:

Where:

· From -  enter the value from which the object will change color in

the ?eld. 

· To - enter the value to which the object will change color in the

?eld. 

· Color -  choose color for this range. 

You can Add, Edit or Remove collection element of fill color

conditions. 

6.2.5.7 Filling

Filling property lets to control ? lling of the object depending on value of the tag. To edit ? lling

property click Filling tab on the object property window. 
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Property Description

Tag Select the tag value of which will be used to control ? lling. 

Minimum* Enter minimum value of the object’s ? lling in the ?eld.

Maximum* Enter maximum value of the object’s ? lling in the ?eld. 

* These properties you can use in ST scripts by using minimum or maximum properties

keywords. For example: 

Objects.Rectangle.maximum = 200;

6.2.5.8 Text color

Text color property lets object to change color of text when conditions is TRUE or FALSE. To

edit text color property click Text color tab on the object property window.
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Property Description

Tag Select the tag value of which will be compared. 

Value  Enter the comparison value.

Type

 Select type of comparison:

§ Tag.PV==Value - tag's value is equal to the comparison value.

§ Tag.PV>=Value - tag's value is equal to or greater than the

comparison value.

§ Tag.PV<=Value - tag's value is equal to or less that the

comparison value.

§ Tag.PV>Value - tag's value is greater than the comparison

value.

§ Tag.PV<Value - tag's value is less than the comparison value.

§ Tag.PV!=Value - tag's value is not equal to the comparison

value.

§ Tag.PV in the range - tag's value compares to the values in the

ranges. To setup ranges click Collection button.

Color TRUE Choose a color that will result if the comparison is TRUE in this field.

 Color FALSE Choose a color that will result if the comparison is FALSE in this field.

Ranges
If you select Tag.PV in the range in the Type combobox and click

Collection button. You’ll see the window:
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Where:

· From -  enter the value from which the object will change color in

the ?eld. 

· To - enter the value to which the object will change color in the

?eld. 

· Color -  choose color for this range. 

You can Add, Edit or Remove collection element of text color

conditions. 

6.2.5.9 Control (for buttons)

Control property lets to write value to the tag. To edit control property click Control tab on the

object property window. 
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Property Description

Tag Select the tag to which the value will be written. 

Function

Select button's function:

§ Set - write TRUE(1) to the tag.

§ Reset - write FALSE(0) to the tag.

§ Toggle -  if current tag’s value TRUE(1) write FALSE(0), if

currents tag’s value FALSE(0) write TRUE(1).

§ Push -  during pressing button write TRUE.

§ Set value - write Value to the tag.

§ Enter value -  call dialog that lets you enter value to the tag.

§ Call screen - call selected screen.

§ Call popup - call selected popup screen.

§ Close popup - close popup screen.

§ Call external software - lets call external software by using

command and arguments of OS.

§ Close application - close application.

§ Build report - build and show report of the project.

§ Login - login user of the project.

§ Logout - logout current user from the project. User with the less

access level is login.

§ Show/hide main menu - show/hide the main menu.
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Value
When you select Set value function enter value that will be written to

the tag. 

Title
When you select Enter value function write title of the called dialog

that lets you enter value. 

Screen

 When you select Call screen or Call popup function choose screen

that will be called after clicking button. It's possible to bind button for

calling Previous Screen.

Command and args 

This field is used in 2 ways:

1. When you select Call screen, Call popup or Close popup function

this field is used to enter global arguments separated by semicolons.

Example:

name=pump; description=pump 1 description;

It's useful if you want to use some arguments in ST scripts. You can

get them by using getglobalargument script command. Example:

string name = getglobalargument("name", "");

string description = getglobalargument("description","");

2. When you select Call external software function this field is used to

enter OS commands and arguments to call external software.

Example:

§ for MacOS: open /Applications/TextEdit.app 

§ for Windows: C:/Progra~1/somesoftware.exe 

§ for Android: opc.tesla.scada (name of the Android application

package) 

§ for iOS: http://www.youtube.com/watch?v=VIDEO_IDENTIFIER

(youtube scheme for calling in iOS). 

6.2.5.10Text input

Text input property lets object to control display tag’s value or text when conditions is TRUE or

FALSE. To edit text input property click Text input tab on the object property window.
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Property Description

Tag Select the tag value of which will be compared. 

Value  Enter the comparison value.

Type

 Select type of comparison or displaying:

§ Tag.PV - tag's value is displayed.

§ Tag.PV==Value - tag's value is equal to the comparison value.

§ Tag.PV>=Value - tag's value is equal to or greater than the

comparison value.

§ Tag.PV<=Value - tag's value is equal to or less that the

comparison value.

§ Tag.PV>Value - tag's value is greater than the comparison

value.

§ Tag.PV<Value - tag's value is less than the comparison value.

§ Tag.PV!=Value - tag's value is not equal to the comparison

value.

§ Tag.PV in the range - tag's value compares to the values in the

ranges. To setup ranges click Collection button.

 Text TRUE Enter text that will be written if the comparison is TRUE(1) in this field. 
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Text FALSE 
Enter text that will be written if the comparison is FALSE(0) in this

field. 

Ranges

 If you select Tag.PV in the range in the Type combobox and click

Collection button. You’ll see the window:

Where:

· From - enter the value from which the object will change text in the

?eld. 

· To - enter the value to which the object will change text in the ?eld. 

· Text -  enter text in the ?eld. 

You can Add, Edit or Remove collection element of input text

conditions. 

Text before Write the text that will be displayed before the input text.

Text after Write the text that will be displayed after the input text.

 Before decimal

position 

If the input text is the numeric value of the tag enter number of digits

before decimal position.

 Decimal position If the input text is the numeric value of the tag enter decimal position.

6.2.5.11Output value

Output value property lets to write value to the tag. To edit output property click Output value

tab on the object property window. 
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Property Description

Tag Select the tag to which the value will be written. 

Title Enter title of the dialog that will be used to write value to the tag.

6.2.5.12Indicator

Indicator property lets to indicate object depending on value of the tag. To edit indicator

property click Indicator tab on the object property window. 
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Property Description

Tag Select the tag value of which will be compared. 

Value  Enter the comparison value.

Type

 Select type of comparison:

§ Tag.PV==Value - tag's value is equal to the comparison value.

§ Tag.PV>=Value - tag's value is equal to or greater than the

comparison value.

§ Tag.PV<=Value - tag's value is equal to or less that the

comparison value.

§ Tag.PV>Value - tag's value is greater than the comparison

value.

§ Tag.PV<Value - tag's value is less than the comparison value.

§ Tag.PV!=Value - tag's value is not equal to the comparison

value.

6.2.5.13Rotation indicator

Rotation Indicator property lets to rotate object around its center depending on value of the

tag. To edit indicator property click Rotation ind. tab on the object property window. 
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Property Description

Tag Select the tag value of which will be compared. 

Value  Enter the comparison value.

Type

 Select type of comparison:

§ Tag.PV==Value - tag's value is equal to the comparison value.

§ Tag.PV>=Value - tag's value is equal to or greater than the

comparison value.

§ Tag.PV<=Value - tag's value is equal to or less that the

comparison value.

§ Tag.PV>Value - tag's value is greater than the comparison

value.

§ Tag.PV<Value - tag's value is less than the comparison value.

§ Tag.PV!=Value - tag's value is not equal to the comparison

value.

Speed(ms)  Enter rotation speed in the field.

6.2.5.14Image

Image property lets object to change image when conditions is TRUE or FALSE. To edit image

property click Image tab on the object property window.
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Property Description

Tag Select the tag value of which will be compared. 

Value  Enter the comparison value.

Type

 Select type of comparison:

§ Tag.PV==Value - tag's value is equal to the comparison value.

§ Tag.PV>=Value - tag's value is equal to or greater than the

comparison value.

§ Tag.PV<=Value - tag's value is equal to or less that the

comparison value.

§ Tag.PV>Value - tag's value is greater than the comparison

value.

§ Tag.PV<Value - tag's value is less than the comparison value.

§ Tag.PV!=Value - tag's value is not equal to the comparison

value.

Image TRUE
Choose image that will be result if the comparison is TRUE by clicking

Image TRUE button. 

Image FALSE
Choose image that will be result if the comparison is FALSE by clicking

Image FALSE button. 
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6.2.5.15Color

Color property lets object to change color of its when conditions is TRUE or FALSE. To edit

color property click Color tab on the object property window. 

Property Description

Tag Select the tag value of which will be compared. 

Value Enter the comparison value.

Type

Select type of comparison:

§ Tag.PV==Value - tag's value is equal to the comparison value.

§ Tag.PV>=Value - tag's value is equal to or greater than the

comparison value.

§ Tag.PV<=Value - tag's value is equal to or less that the

comparison value.

§ Tag.PV>Value - tag's value is greater than the comparison

value.

§ Tag.PV<Value - tag's value is less than the comparison value.

§ Tag.PV!=Value - tag's value is not equal to the comparison

value.

§ Tag.PV in the range - tag's value compares to the values in the

ranges. To setup ranges click Collection button.

Color TRUE Choose a color that will result if the comparison is TRUE in this field.

 Color FALSE Choose a color that will result if the comparison is FALSE in this field.

Ranges

If you select Tag.PV in the range in the Type combobox and click

Collection button. You’ll see the window:
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Where:

· From -  enter the value from which the object will change color in

the ?eld. 

· To - enter the value to which the object will change color in the

?eld. 

· Color -  choose color for this range. 

You can Add, Edit or Remove collection element of color conditions. 

6.2.5.16Control (for sliders)

Control property lets object to write value to the tag. To edit control property click Control tab

on the object property window.
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Property Description

Tag  Select the tag value of which will be changed.

Minimum* Enter minimum value of the object’s control in the ?eld.

Maximum* Enter maximum value of the object’s control in the ?eld. 

Snap to ticks Check it if you want to bind control’s value to scale ticks. 

Decimal position Enter decimal position of displayed numeric text in the ?eld.

* These properties you can use in ST scripts by using minimum or maximum properties

keywords. For example: 

Objects.Slider.maximum = 200;

6.2.5.17Control (for counters)

Control property lets object to write value to the tag. To edit control property click Control tab

on the object property window.

 

Property Description

Tag  Select the tag value of which will be changed.

Minimum* Enter minimum value of the object’s control in the ?eld.

Maximum* Enter maximum value of the object’s control in the ?eld. 

 Delta 
This is the value by which the control value will change when the plus

and minus buttons are pressed. 

Decimal position Enter decimal position of displayed numeric text in the ?eld.
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6.2.5.18Value (for meters)

Value property lets to control values of analog and digital meters depending on value of the

tag. To edit value property click Value tab on the object property window. 

Property Description

Tag  Select the tag value of which will be changed.

Minimum* Enter minimum value of the meter in the ?eld.

Maximum* Enter maximum value of the meter in the ?eld. 

Decimal position* Enter decimal position of displayed numeric text in the ?eld.

* These properties you can use in ST scripts by using minimum, maximum  and decimalpos

properties keywords. For example: 

Objects.Meter.maximum = 200;

6.2.5.19Value (for range indicators and gauges)

Value property lets to indicate depending on value of the tag. To edit value property click

Value tab on the object property window. 
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Property Description

Tag
Select the Tag value of which will be used to control value of the

indicator or gauge.

Minimum* Enter minimum value of the indicator or gauge in the ?eld.

Maximum* Enter maximum value of the indicator or gauge in the ?eld. 

Ranges

Click Collection button. You’ll see the window:

Where:

· From -  enter the value from which the object will change color in

the ?eld. 

· To - enter the value to which the object will change color in the

?eld. 
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· Color -  choose color for this range. 

You can Add, Edit or Remove collection element of color conditions. 

Show value  Check it if you want to make visible number representation. 

Decimal position* Enter decimal position of displayed numeric text in the ?eld.

Show history 
Check Show history if you want to make visible history information of

the tag. 

Period Choose period of the history information. 

Color Choose color of the history information. 

* These properties you can use in ST scripts by using minimum, maximum  and decimalpos

properties keywords. For example: 

Objects.Gauge.maximum = 200;

6.2.5.20Switch control

Switch control property lets to switch boolean value of  the tag. To edit switch control property

click Switch control tab on the object property window. 

Property Description

Tag  Select the tag value of which will be controlled by the switch.
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6.2.5.21Switch control (3 position)

Switch control property lets to switch boolean values of the tags. To edit switch control

property click Switch control tab on the object property window. 

Property Description

Tag ON  Select the Tag ON value of which will be controlled by the switch. 

Tag OFF  Select the Tag OFF value of which will be controlled by the switch. 

When the value of Tag ON is TRUE and the value of Tag OFF is FALSE the switch position will

be ON. When the value of Tag ON is FALSE and the value of Tag OFF is TRUE the switch

position will be OFF. In other situations the switch position will be Neutral. To switch click (or

touch on mobile devices) on the position you want.

6.2.5.22Selector

Selector property lets to enter values by clicking selector buttons. To edit selector property click

Selector tab on the object property window. 
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Property Description

Tag  Select the tag value of which will be controlled by the selector.

Ranges

Click Collection button. You’ll see the window:

Where:

· Value - enter the value which will be written after clicking the button

of the selector. 

· Text -  enter text of the selector's button. 

You can Add, Edit or Remove collection element of the selector

buttons. 
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6.2.5.23Row number

Row number property lets to choose row number of the Recipe  database in Parameter

table  object. To edit property click Row number tab on the object property window. 

Property Description

Tag
 Select the tag which value will choose row number of the Recipe

database. 

6.3 Servers

Create server

To create a new server select the menu item Project -> New Server  ->Server you want or

choose Servers  tab on the Project Window, click right button on it and choose New

Server ->Server you want item. List of servers:

· Modbus RTU  - create new Modbus RTU server and open window to edit its

properties.

· Modbus TCP(UDP)  - create new Modbus TCP(UDP) server and open window to

edit its properties.

· Siemens  - create new Siemens server and open window to edit its properties.

· Allen Bradley  - create new Allen Bradley server and open window to edit its

properties.

· OPC UA  - create new OPC UA server and open window to edit its properties.

· MQTT  - create new MQTT server and open window to edit its properties.
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· Omron  - create new Omron server and open window to edit its properties.

· BACnet/IP  - create new BACnet server and open window to edit its properties.

· Common RTU  - create new Common RTU server and open window to edit its

properties.

· Common TCP  - create new Common TCP server and open window to edit its

properties.

· Raspberry GPIO  - create new Raspberry GPIO server and open window to edit its

properties.

Open server properties

To open server properties on Servers  tab:

1. Double click on the server properties which you want to open.

 or 

2. Right click on the server properties which you want to open and choose Server

properties item. 

Copy server

To copy server on Servers  tab right click on the server you want to copy and choose Copy

server item.

Delete server

To delete server on Servers  tab right click on the server you want to delete and choose

Delete server item.

6.3.1 Modbus RTU

To create a new Modbus RTU server select the menu item Modbus RTU. You’ll see the following

window: 
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List of properties:

Property ST script

field*

Description

Name  Name of the Modbus RTU server. 

Port ID portid

ID of the COM port.  If this port can not be

open in TeslaSCADA2 Runtime other port

will be tried to ?nd and open. 

Baud rate baudrate Baud rate of the Modbus RTU.

Flow control
flowcontro

l

Flow control of the port. It can be NONE,

RTSCTS and XONXOF. 

Data bits databits Number of data bits.  It can be 5, 6, 7 and 8. 

Stop bits stopbits Number of stop bits. It can be 1, 1.5 and 2. 

Parity parity
Parity of the Modbus RTU.  It can be NONE,

EVEN, ODD, MARK and SPACE.

Request type
requesttyp

e

Choose request type:

- Maximum registers - if you choose this

type the application during polling will send

maximum modbus pointers in 1 polling

request.
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- Consecutive registers - if you choose this

type the application during polling will send

only consecutive modbus pointers in 1

polling request. 

- 1 pointer registers - if you choose this type

the application during polling will send only

registers used by 1 pointer in 1 polling

request. 

Without function 6 withoutfun
 Check Without function 6 if your controller

doesn’t support Modbus writing function 6.

* This field is used in ST scripts. For example: Servers.Server1.requesttype = 0. In this script

command request type of the Server1 become Maximum registers. Also for all servers you can

use fields:

§ connect - connect to the server.

§ connected - check connection of the server.

§ lostconnection - check lost or not connection of the server.

6.3.2 Modbus TCP

To create a new Modbus TCP(UDP) server select the menu item Modbus TCP(UDP). You’ll see

the following window: 

List or properties:

Property ST script

field*

Description

Name  Name of the Modbus TCP server. 
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IP or DNS ipaddress
 IP address or DNS of the Modbus TCP

server.

Port port Port of the Modbus TCP server.

Poll interval interval
Polling interval (period) of the server's

requests.

Type type
Communication protocol of Modbus server -

TCP or UDP.

Request type
requesttyp

e

Choose request type:

- Maximum registers - if you choose this

type the application during polling will send

maximum modbus pointers in 1 polling

request.

- Consecutive registers - if you choose this

type the application during polling will send

only consecutive modbus pointers in 1

polling request. 

- 1 pointer registers - if you choose this type

the application during polling will send only

registers used by 1 pointer in 1 polling

request. 

RTU via TCP(UDP) rtuviatcp
 Check it if you use Modbus converter from

serial into TCP(UDP) protocol.

Without function 6 withoutfun
Check Without function 6 if your controller

doesn’t support Modbus writing function 6.

* This field is used in ST scripts. For example: Servers.Server1.requesttype = 0. In this script

command request type of the Server1 become Maximum registers. Also for all servers you can

use fields:

§ connect - connect to the server.

§ connected - check connection.

§ lostconnection - check lost or not connection.
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6.3.3 Siemens

To create a new Siemens server select the menu item Siemens. You’ll see the following window:

List of properties:

Property ST script

field*

Description

Name  Name of the Siemens server. 

IP or DNS ipaddress  IP address or DNS of the server.

Port port Port of the server.

Poll interval interval
Polling interval (period) of the server's

requests.

Controller type plctype Type of the Siemens PLC.

Request type
requesttyp

e

Choose request type:

- Maximum registers - if you choose this

type the application during polling will send

maximum modbus pointers in 1 polling

request.

- 1 pointer registers - if you choose this type

the application during polling will send only

registers used by 1 pointer in 1 polling

request. 

Rack rack Number of controller's rack
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Slot slot Number of controller's slot

* This field is used in ST scripts. For example: Servers.Server1.requesttype = 0. In this script

command request type of the Server1 become Maximum registers. Also for all servers you can

use fields:

§ connect - connect to the server.

§ connected - check connection.

§ lostconnection - check lost or not connection.

6.3.4 Allen Bradley

To create a new Allen Bradley server select the menu item Allen Bradley. You’ll see the following

window:

List or properties:

Property ST script

field*

Description

Name  Name of the Allen Bradley server. 

IP or DNS ipaddress  IP address or DNS of the server.

Port port Port of the server.

Poll interval interval
Polling interval (period) of the server's

requests.

Controller type plctype Type of the Allen Bradley PLC.

CPU slot cpuslot  PLC’s cpu slot number.
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Backplane
ethernetslo

t

PLC's backplane number.

* This field is used in ST scripts. For example: Servers.Server1.interval = 2000. In this script

command poll interval of the Server1 will be changed to 2000 ms. Also for all servers you can

use fields:

§ connect - connect to the server.

§ connected - check connection.

§ lostconnection - check lost or not connection.

6.3.5 OPC UA

To create a new OPC UA server select the menu item OPC UA. You’ll see the following window:

List of properties:

Property ST script

field*

Description

Name  Name of the OPC UA server. 

URI uri  OPC UA server address.

Poll interval interval
Polling interval (period) of the server's

requests.

Security mode mode
Security mode of the OPC UA server - None,

Sign, Sign and Encrypt.

Policy policy
Security policy of the OPC UA server -

Basic128RSA15, Basic256, Basic256SHA256
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Anonymous
anonymou

s

Check it if you don't want to use User's

token.

Username username
If you use user token enter username in this

field.

Password password
If you use user token enter password in this

field.

* This field is used in ST scripts. For example: Servers.Server1.interval = 2000. In this script

command poll interval of the Server1 will be changed to 2000 ms. For OPC UA server you have

to reconnect server. Also for all servers you can use fields:

§ connect - connect to the server.

§ connected - check connection.

§ lostconnection - check lost or not connection.

6.3.6 MQTT

To create a new MQTT server select the menu item MQTT. You’ll see the following window:

List of properties:

Property ST script

field*

Description

Name  Name of the MQTT server. 
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URI uri  MQTT server address.

Username username Username of the server.

Password password Password of the server.

Client ID

Client ID of the MQTT server. If you left

this field empty server will generate it

itself.

Enable TLS/SSL enablessl
 Check Enable TLS/SSL if you want to use

server certi?cate for encryption messages.

Certi? cate ? lename sslfilename

 File should be placed in /private /

folder in the directory where TeslaSCADA2

installed.

Enable Client Certificate
enableclientc

ert

 Check it if you want to use client

certi?cate for encryption messages.

Client certificate**
clientcertnam

e

File should be placed in /private / folder

in the directory where TeslaSCADA2

installed.

Client private key**
clientprivatek

ey

File should be placed in /private / folder

in the directory where TeslaSCADA2

installed.

Private key password**
privatekeypa

ssword

Private key password.

PEM formatted** pem
Check PEM formatted* if your certi?cate

and key ? les are PEM formatted

* This field is used in ST scripts. For example: Servers.Server1.username= Admin. In this script

command user name of the Server1 will be changed to Admin. For OPC UA server you have to

reconnect server. Also for all servers you can use fields:

§ connect - connect to the server.

§ connected - check connection.

§ lostconnection - check lost or not connection.

§ reconnect - when field's value become TRUE server is reconnected.

** If you use this project for iOS (iPhone or iPad) you should use .p12 format for the ? le of the

certi?cate. To create .p12 ? le you should in openssl utility use this type of command: 

openssl pkcs12 -export -out  [your ? le name].p12 -in [your ? le name].crt -inkey

[your ? le name].key 

For example:

openssl pkcs12 -export -out  client.p12 -in client.crt -inkey client.key 

17

17

17
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The name of your .p12 you should place in the Client certi?cate ?eld (client.p12 in our example).

Client Private Key you can left empty. In the Private key password you should enter password

of the .p12 ? le. PEM formatted you can left uncheck. All .p12 ? les are PEM formatted. 

6.3.7 Omron

To create a new Omron server select the menu item Omron . You’ll see the following window:

List or properties:

Property ST script

field*

Description

Name  Name of the Omron server. 

IP or DNS ipaddress  IP address or DNS of the server.

Port port Port of the server.

Poll interval interval
Polling interval (period) of the server's

requests.

Type type
Communication protocol of the server - TCP

or UDP.

Network address (DNA) dna Network address of the server.

Node address (DA1) da1

Node address of the server.  For TCP

protocol it will be chosen automatically

during communication.

Unit number (DA2) da2 Unit number.
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* This field is used in ST scripts. For example: Servers.Server1.interval = 2000. In this script

command poll interval of the Server1 will be changed to 2000 ms. Also for all servers you can

use fields:

§ connect - connect to the server.

§ connected - check connection.

§ lostconnection - check lost or not connection.

6.3.8 BACnet/IP

To create a new Bacnet/IP server select the menu item Bacnet/IP . You’ll see the following

window:

List or properties:

Property ST script

field*

Description

Name  Name of the Bacnet server. 

IP or DNS ipaddress  IP address or DNS of the local device.

Port port Port of the server.

Broadcast IP
broadcasti

p

Broadcast IP address

Poll interval interval
Polling interval (period) of the server's

requests and discover devices.

Device number devicenum Device number in BACnet network.
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* This field is used in ST scripts. For example: Servers.Server1.interval = 2000. In this script

command poll interval of the Server1 will be changed to 2000 ms. Also for all servers you can

use fields:

§ connect - connect to the server.

§ connected - check connection.

§ lostconnection - check lost or not connection.

6.3.9 Common RTU Server

Common RTU server lets you implement user-defined protocol in your project. To create a new

Common RTU server select the menu item Common RTU. You’ll see the following window: 

List of properties:

Property ST script

field*

Description

Name Name of the Common RTU server. 

Port ID portid

ID of the COM port.  If this port can not be

open in TeslaSCADA2 Runtime other port

will be tried to ?nd and open. 

Baud rate baudrate Baud rate of the Common RTU server.

Flow control
flowcontro

l

Flow control of the port. It can be NONE,

RTSCTS and XONXOF. 

Data bits databits Number of data bits.  It can be 5, 6, 7 and 8. 

Stop bits stopbits Number of stop bits. It can be 1, 1.5 and 2. 



Project 295

© 2023 LLC Tesla

Parity parity
Parity of the Common RTU.  It can be NONE,

EVEN, ODD, MARK and SPACE.

* This field is used in ST scripts. For example: Servers.Server1.baudrate = 9600. In this script

command server's baud rate is changed to 9600. Also for all servers you can use fields:

§ connect - connect to the server.

§ connected - check connection of the server.

§ lostconnection - check lost or not connection of the server.

6.3.10 Common TCP Server

Common TCP server lets you implement user-defined protocol in your project. To create a new

Common TCP server select the menu item Common TCP. You’ll see the following window: 

List of properties:

Property ST script

field*

Description

Name Name of the Common TCP server. 

IP or DNS ipaddress
 IP address or DNS of the Common TCP

server.

Port port Port of the Common TCP server.

* This field is used in ST scripts. For example: Servers.Server1.port = 502. In this script

command server's port changed into 502. Also for all servers you can use fields:

§ connect - connect to the server.

§ connected - check connection of the server.

§ lostconnection - check lost or not connection of the server.

6.3.11 Raspberry GPIO

Raspberry GPIO server lets you implement connection to GPIO of Raspberry PI. To create a new

Raspberry GPIO server select the menu item Raspberry GPIO. You’ll see the following window: 
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List of properties:

Property ST script

field*

Description

Name Name of the Raspberry GPIO server. 

6.3.12 HTTP-server

To create a new HTTP-server select the menu item HTTP-server . You’ll see the following

window:

List or properties:

Property ST script

field*

Description

Name  Name of the HTTP server. 

URI uri  URI of the HTTP server.

Username username Username of the HTTP server.

Password password Password of the HTTP server
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Poll interval interval
Polling interval (period) of the server's

requests .

* This field is used in ST scripts. For example: Servers.Server1.interval = 2000. In this script

command poll interval of the Server1 will be changed to 2000 ms. Also for all servers you can

use fields:

§ connect - connect to the server.

§ connected - check connection.

§ lostconnection - check lost or not connection.

6.3.13 Cloud

To create a new Tesla Cloud client select the menu item Cloud . You’ll see the following window:

List or properties:

Property ST script

field*

Description

Name  Name of the cloud server. 

Username Username of the Tesla Cloud user.

Password Password of the Tesla Cloud user.

6.4 Scripts

At the moment in TeslaSCADA2 you can use two languages for writing scripts - FBD

(Functional Block Diagram) and ST (Structured Text). They are similar to languages used in

PLC programming. Depending on the task at hand, you can choose one or another language.

For most tasks, it is better to use ST language as it is more functional. ST language script can be

bound to an object or tag as opposed to FBD language and ST language scripts has more call

301
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options. FBD language script is called only when tag's values used in this script are changed.

But FBD language is more descriptive and may be more familiar to PLC program developers.

Also, FBD language has functions that are not available in ST language. These functions are

mainly related to time management such as timers, multivibrators, etc. In any case, the choice

of the language in which your scripts will be written is yours. Below will be described how to

create a particular script and its properties.

Create script

To create a new script select the menu item Project -> New Script or choose Scripts  on the

Project Window, click right button on it and choose New Script item.

You’ll see the script properties  window: 

Open script

To open script on Scripts  tab of the Project window: 

1. Right click on the script you want to open and choose Open script item. 

or

2. Double click on the script you want to open.

Copy script

To copy script on Scripts  tab of the Project window right click on the script you want to

copy and choose Copy script item. 

62 70
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Delete script

To delete script on Scripts  tab of the Project window right click on the script you want to

delete and choose Delete script item.

Edit script properties

To edit script properties on Scripts  tab of the Project window right click on the script you

want to edit and choose Script properties item.

Export script

To export script on Scripts  tab of the Project window: 

1. Right click on the script you want to export and choose Export script item.

2.  Now select the location and click the button Save (TeslaSCADA2 screen extension

.tsp2script).

Import script

To import script on Scripts  tab of the Project window: 

1. Right click on the script window and choose Import script item. 

2. Now select the script ? le and click Open (TeslaSCADA script extension .tsp2script). 

See Project Window->Scripts  tab for more information about possible operation with

scripts.

70
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6.4.1 Script properties

List of script properties:

Property Description

Group Select group for the script.

Subgroup Select subgroup for the script.

Name Name of the script.

Comment Optionally specify a meaningful comment. 

Background color
Background color of the screen for developing script

using FBD language. It's not affect on script execution.

Script type

Select type of the script:

§ General - is tied to the whole project.

§ Screen - is tied to the screen.

§ Tag - is executed depending on tag's value.

§ Object - is tied to the object.

§ Report - is tied to the report.

Language
Choose language for the script - FBD or ST. Description

of the language you can find below in this document.

Dimension
Screen's dimension for developing script using FBD

language. It's not affect on script execution.

Every cycle
 Check Every cycle if you want this ST script is executed

every update period of the project. You can ?nd out this
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period in Project properties (Update interval (ms)). 

Execution

Choose it if you want to use ST script and don’t want it’s

executed every cycle:

· OnDataChange -  script is executed when tag’s values

used in this script are changed. 

· OnStart(OnOpen, OnCreate) -  script is executed

when project is started (for general script type) or

screen is opened (for screen script type) or object is

created (for object script type).

· OnStop(OnClose, OnDestroy) -  script is executed

when project is stopped (for general script type) or

screen is closed (for screen script type) or object is

destroyed (for object script type). 

· OnClick - script executed when screen is clicked (for

general and screen script types) or object is clicked (for

object script type)

6.4.2 FBD language

Design FBD script 

To start designing the script you want, you should double click on it or click right button on the

Project window ->Scripts  and choose Open script menu item. To develop a script in FBD

language you should use FBD objects. 

Create script object 

Add new object on the screen you can in this way: click right button on the Canvas  and

choose New object menu item:

 

You’ll see the Add script object window:

92
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Select library which object you want to use in your project (all libraries and their objects

described below). Object you can select in several ways: 

1. By double clicking on the object. 

2. By clicking on the object (select rectangle will appear) and then clicking OK

button. 

3. By clicking right button and choosing Select item. 

Add script object window will disappear and you can select the location on the screen where

you want to place an object.

Connect script objects 

To connect two objects, click the end of the ?rst (the end to paint over) and click start the

second. This will bring up a line connection.
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Bind script object to the tag

You can bind Input/Output script objects to the tag. To do this click on Input/Output script

object, dialog will appear. Select tag you want to bind.

Enter value to the value script object

You can enter value to value script objects. To do this click on value script object, dialog will

appear. Enter value you want to use with this object.

Duplicate script object

You can duplicate script object. Right click on the object you want to duplicate and select

Duplicate menu item.
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Erase script object

You can erase script object. Right click on the object you want to erase and select Erase menu

item.

Erase connection line 

You can erase connection line. Right click on the line you want to erase and select Erase menu

item.
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6.4.2.1 Script objects of FBD language

Below description of script libraries:

§ Input/Output library  - allows you to bind tags and constant values to the script.

§ Logical library  - contains objects for working with boolean logical operations.

§ Bitmap operations library  - contains objects for working with bits inside integer

variables.

§ Arithmetic library  - contains objects for arithmetic operations.

§ Compare library  - contains objects for comparison operations.

§ Select library  - contains objects for selection operations.

§ Arrays library  - contains objects for working with arrays.

§ Triggers/Counters library  - contains objects for working with triggers and counters.

§ Trigonometric library  - contains objects for trigonometric mathematical operations.

§ Hex operations library  - contains objects for converting decimal numbers to

hexadecimal and back.

§ Call screen library  - contains objects for calling screens and popup screens.

§ Strings library  - contains objects for working with strings.

§ Date and time library  - contains object for getting date and time parts (year, day,

hour, minute and etc).

§ Servers library  - contains objects for working with servers in the project.

§ Recipes library  - contains object for working with recipes.

§ Base64 library  - contains objects for converting array to base64 string and back.

6.4.2.1.1  Input/Output library
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§ Input tag - this script object used to bind input tag to the script. 

§ Output tag - this script object used to bind output tag to the script. 

§ Value - this script object used to bind input constant value to the script. 

Example:

Tag1's value = Tag's value + 34;

6.4.2.1.2  Logical library

§ Inverse - this script object used to inverse input boolean value (Output = ! Input). 

§ Logical AND - this script object used to logical operation AND for input boolean values

(Output = Input & Input2). 

§ Logical OR - this script object used to logical operation OR for input boolean values

(Output = Input || Input2). 

§ Logical XOR - this script object used to logical operation XOR for input boolean values

(Output = Input XOR Input2). 
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Example:

Tag2's value = Tag's value &(AND) Tag1's value;

Tag Tag1 Tag2

FALSE(0) FALSE(0) FALSE(0)

FALSE(0) TRUE(1) FALSE(0)

TRUE(1) FALSE(0) FALSE(0)

TRUE(1) TRUE(1) TRUE(1)

6.4.2.1.3  Bitmap operations library

§ Inverse - this script object used to inverse input integer value (Output = ~ Input). 

§ Bitmap AND - this script object used to logical operation AND for input integer values

(Output = Input & Input2). 

§ Bitmap OR - this script object used to logical operation OR for input integer values

(Output = Input || Input2). 

§ Bitmap XOR - this script object used to logical operation XOR for input integer values

(Output = Input XOR Input2). 
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§ Left Shift - this script object used to left shift bits of input value (Output = Input << ?

of bits). 

§ Right Shift - this script object used to right shift bits of input value (Output = Input >>

?  of bits). 

§ Bytes to Short - this script object used to pack 2 bytes in the short (Output =

Input<<8+Input2). 

§ Short to Bytes - this script object used to unpack short value in 2 bytes (Output =

Input[Input2]). 

§ Shorts to Int - this script object used to pack 2 shorts in the int (Output =

Input<<16+Input2). 

§ Int to Shorts - this script object used to unpack int value in 2 shorts (Output =

Input[Input2]). 

§ Read bit - this script object used to read bit of the input value (Output = Input[Input2]). 

§ Set bit - this script object used to set bit of the input value (Output = Input |

1<<Input2). 

§ Reset bit - this script object used to reset bit of the input value (Output = Input &

~(1<<Input2)). 

Example:

This operation set 0 bit of Tag's value and place result in Tag2's value. 

Tag Tag2

8 0 9
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6.4.2.1.4  Arithmetic library

§ Addition - this script object used to arithmetic operation addition for input values

(Output = Input + Input2). 

§ Subtraction - this script object used to arithmetic operation subtraction for input values

(Output = Input - Input2). 

§ Multiplication - this script object used to arithmetic operation multiplication for input

values (Output = Input * Input2). 

§ Division- this script object used to arithmetic operation division for input values (Output

= Input / Input2). 

§ Modulo - this script object used to arithmetic operation modulo for input values (Output

= Input % Input2).

§ Power - this script object used to arithmetic operation power for input values (Output =

Input^Input2). 

§ ABS - this script object used to arithmetic operation absolute for input value (Output = |

Input|). 

§ Sign - this script object used to arithmetic operation sign for input value (Output = -

Input). 

§ Int - this script object used to arithmetic operation for getting integer part of the input

value (Output = int(Input)). 

§ Sqrt - this script object used to arithmetic operation sqrt of the input value (Output =

Math.Sqrt(Input)). 
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§ Ln- this script object used to arithmetic operation ln (natural logarithm) of the input value

(Output = Ln(Input)). 

§ Log- this script object used to arithmetic operation log (logarithm) of the input value

(Output = LogInput2Input). 

Example:

This operation multiply Tag's value by constant value 5 and place result in Tag2's

value. 

Tag Tag2

2 5 10

6.4.2.1.5  Compare library

§ Equal - this script object used to comparison operation equal for input values (Output

= Input == Input2). 
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§ Not Equal - this script object used to comparison operation not equal for input values

(Output = Input != Input2). 

§ Greater - this script object used to compare operation greater for input values (Output

= Input > Input2). 

§ Less - this script object used to compare operation less for input values (Output =

Input < Input2). 

§ Equal or Greater - this script object used to compare operation equal or greater for

input values (Output = Input >= Input2). 

§ Equal or Less - this script object used to compare operation equal or less for input

values (Output = Input <= Input2). 

Example:

This operation compare Tag's value and Tag1's value and place result in Tag2's value. If

Tag's value greater than Tag1's value Tag2's value equal TRUE(1).

Tag Tag1 Tag2

5 9 FALSE(0)

12 8 TRUE(1)
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6.4.2.1.6  Select library

§ Selectable enable - this script object used to select value form Input2 if Input1 is true (IF

Input==true THEN Output=Input2). 

§ Selectable negate - this script object used to select value form Input2 if Input1 is false

(IF Input==false THEN Output=Input2). 

§ Minimum - this script object used to select minimum value of Input2 and Input1

(Output=Min(Input, Input2)). 

§ Maximum - this script object used to select maximum value of Input2 and Input1

(Output=Max(Input, Input2)). 

Example:

This operation compare Tag's value and Tag1's value and place result in Tag2's value. If

Tag's value greater than Tag1's value, Tag2's value equal Tag's value.
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Tag Tag1 Tag2

5 9 9

12 8 12

6.4.2.1.7  Arrays library

§ Index read - this script object used to select array’s element. Input1 is an array. Input2 is

index of element (Output = Input1[Input2]). 

§ Index write - this script object used to change array’s element. Input1 is an element.

Input2 is index of element (Output[Input2] = Input1). 

Example:

This operation get value from the array in Tag's value and index in Tag1's value and

place result in Tag2's value.

Tag Tag1 Tag2
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[34, 23, 4, 7, 12] 0 34

6.4.2.1.8  Triggers/Counters library

§ Rising edge trigger- this script object used to generate rising impulse duration PV ms

when Input1 get TRUE from FALSE. 

§ Falling edge trigger- this script object used to generate rising impulse duration PV ms

when Input1 get FALSE from TRUE. 

§ RS trigger- this script object used to imitate RS trigger. 

§ Timer ON- this script object used for delay timer for the duration PV when Input1 get

TRUE from FALSE. 

§ Timer OFF- this script object used for delay timer for the duration PV when Input1 get

FALSE from TRUE. 

§ Counter- this script object used to count impulses of boolean value in Input1. Counter

resets when Output become equal PV. 

§ Counter Down- this script object used to count impulses of boolean value in Input1.

Counter starts from value PV. Counter resets when Output become equal 0. 

§ Multivibrator - this script imitates impulse generator with PV period. It starts when IN1

changed from FALSE to TRUE.

Example:
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This operation set Tag2's value to TRUE(1) in 5000 ms when Tag's value become TRUE(1)

from FALSE(0). 

6.4.2.1.9  Trigonometric library

§ Degrees to radians - this script object used to convert degrees to radians. 

§ Radians to degrees - this script object used to convert radians to degrees. 

§ Sine - this script object used to calculate sin of Input value. (Output = sin(Input)). 

§ Cosine - this script object used to calculate cos of Input value. (Output = cos(Input)). 

§ Tangent - this script object used to calculate tag of Input value. (Output = tag(Input)). 

§ Arc Sine - this script object used to calculate arc sin of Input value. (Output = arc

sin(Input)). 

§ Arc Cosine - this script object used to calculate arc cos of Input value. (Output = arc

cos(Input)). 
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§ Arc Tangent - this script object used to calculate arc tag of Input value. (Output = arc

tag(Input)). 

Example:

This operation counts sine of Tag's value and place result in Tag2's value.

Tag Tag2

1 0.8414709848078965066525023216303

6.4.2.1.10  Hex operations library

§ Hex to Integer - this script object converts hex value into integer. 

§ Integer to Hex - this script object converts integer value into hex. 

Example:
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This operation converts Tag's value from decimal integer into hexadecimal and place

result in Tag2's value.

Tag Tag2

255 0xFF

6.4.2.1.11  Call screen library

§ Call screen - this script object used to call screen when Input’s value turns from FALSE to

TRUE. 

§ Call popup - this script object used to call popup screen when Input’s value turns from

FALSE to TRUE. 

Example:
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When Tag's value become TRUE from FALSE Screen0 is opened.

6.4.2.1.12  Strings library

§ Equal Strings - this script object compare two strings in Inputs and if their are equal it

sets true into Output value. 

§ String to Double - this script object converts Input’s string value into Output’s double

value. 

§ Double to String - this script object converts Input’s double value into Output’s string

value. 

§ Strings concat - this script object concatenate Input’s strings values into Output’s string

value. (Output = Input1+Input2). 

§ String cut end - this script object cuts end of Input’s string value by the ?  of characters

and place result into Output’s string value. 

§ String cut begin - this script object cuts begin of Input’s string value by the ?  of

characters and place result into Output’s string value. 

Example:
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This operation concatenate Tag's value and Tag1's value and place result in Tag2's

value. 

Tag Tag1 Tag2

Hello World HelloWorld

6.4.2.1.13  Date and time library

§ Current date and time - this script object used to get date and time components

depending on Input value: 

0 - get seconds. 

1 - get minutes. 

2 - get hour of the day considering AM/PM.

3 - get hour of the day. 

4 - get day of the week (1-Sunday, 2-Monday…). 

5 - get day of month. 

6 - get month (0 - January, 1 - February…). 
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7 - get year. 

8 - get minutes of the day (hour*60 + minutes). 

Example:

Depending on Tag's value place parameter of the current date and time.

Tag Tag2

7 2020

6.4.2.1.14  Servers library

§ IP or URI address - this script object used to change server’s IP or URI address when

Input’s value changed. 

§ Reconnect - this script object used to reconnect server when Input’s value turns from

FALSE to TRUE.

Example:
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When Tag's value become TRUE from FALSE ModbusServer1 reconnect.

6.4.2.1.15  Recipes library

§ Select recipe - this script object used to choose recipe row. Input2 is an input that

contains name of the recipe. Input1 is number of the row (starting from 1). Output = true

if recipe row is chosen. 



TeslaSCADA2 IDE User manual322

© 2023 LLC Tesla

6.4.2.1.16  Base64 library

§ Decode Base64 to Array - this script object used to decode Base64 string to byte array.

Input contains base64 encoded string. In Output will be decoded byte array. 

§ Encode Array to Base64 - this script object used to encode byte array to Base64 string.

Input contains byte array. In Output will be encoded Base64 string. 

6.4.3 ST language

When you choose ST(Structured text) language in script properties and open this script you’ll

see two windows like in the picture:
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Top window is a Code area and below window is a Debug(or log) area. You can enter your

script program in the top window and compile this code by clicking Run  button on the

Toolbar . All debug and log information you can see in the below window. Later in this

chapter we will describe the rules of the ST language. 

6.4.3.1 What is Structured Text Programming?

Structured Text for TeslaSCADA2 is different from PLC programming language de?ned

by PLCOpen in IEC 61131-3. The programming language is text-based, compared to the

graphicsbased Function Block Diagram. If you are already familiar with high-level programming

languages like Java, PHP, Python and C, Structured Text will seem familiar to you. The syntax of

Structured Text is developed to look like the syntax of a high-level programming language with

loops, variables, conditions and operators. Before you read this tutorial I recommend that you

take a brief look at this TeslaSCADA2 program written in Structured Text:

 Try to see if you can understand the function of this program. Does Structured Text look

familiar to you? 

64

64
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6.4.3.2 Starting with the Syntax of Structured Text

The syntax of a programming language is the de?nition of how it is written. To be more

precise, what symbols is used to give the language its form and meaning.As you can see in the

example, Structured Text is full of colons, semicolons and other symbols. All these symbols has

a meaning and is used to represent something. Some of them are operators, some are

functions, statements or variables.All the details of the syntax will be explained as you move

through this tutorial. But there are some general rules for the syntax of Structured Text you

should know about. You don’t have to memorize all the syntax rules for now, as you will when

you get your hands into the programming: 

All statements are divided by semicolons

Structured Text consists of statements and semicolons to separate them. 

The language is case-sensitive 

It is good practice to use upper- and lowercase for readability.

Spaces have no function 

But they should be used for readability.

What’s really important to understand here is that, when you write a TeslaSCADA2 program in

IDE in Structured Text, your computer will translate that to a language the TeslaSCADA2

Runtime can understand. Before you use project that contains the Structured Text TeslaSCADA2

program to your TeslaSCADA2 Runtime, the IDE will compile your program. This means that it

will translate the code to a sort of machine code which can be executed by the TeslaSCADA2

Runtime. The compiler uses the syntax of the programming language to understand your

program. For example: Each time the compiler sees a semicolon, it will know that the end of the

current statement is reached. The compiler will read everything until it reaches a semicolon, and

then execute that statement.

Comment Syntax

In textual programming languages you have the ability to write text that doesn’t get executed.

This feature is used to make comments in your code.Comments are good, and as a beginner

you should always comment your code. It makes it easier to understand your code later. In

Structured Text you can make either one line comments or multiple line comments. 

Single line comment: 

//comment

Multiple line comment: 

/* start comment

 ...

end comment */ 

6.4.3.3 Making Statements with Structured Text

So, Structured Text consists of statements. But what is statements?A statement is you telling

the TeslaSCADA2 what to do. Let’s take the ?rst statement as an example: 

bool x;
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The compiler will read this as one statement, because when it reaches the semicolon, it knows

that this is the end of that statement. Remember, statements are separated by semicolons.

That’s the main syntax rule of this language. In this statement you are telling the TeslaSCADA2

to create a variable called X and that variable should be a BOOL type. By default value of the

variable is false. 

6.4.3.4 Types in Structured Text

Data types of Structured Text are similar to data types of TeslaSCADA2:

Data Type Format Range

bool Boolean FALSE(0)/TRUE(1)

byte Byte -128 … 127 

short Short -32768 … 32767 

int Integer -2^31 … 2^31-1

long Long Integer -2^63 … 2^63-1

float Float ±3.40282347E+38F

double Double ±1.79769313E+308

string Character string “My string”

array Array byte[], short[], int[], ?oat[]

Examples of variable initialisation: 

bool x=false; 

byte b = 2; 

short s = 45; 

int i = -4546; 

long l = 394394832; 

?oat f = 1.23; 

double d = -545.64; 

string str = “Hello”; 

byte bytes[10] = [1,2,3,4,5,6,7,8,9,10];

6.4.3.5 Operators and Expressions in STL

The next thing you should know about is operators. Operators are used to manipulate data and

is a part of almost any programming language. This leads us to the second thing you should

know about – expressions. Just like operators, expressions are a crucial part of programming

languages. An expression is a construct that, when evaluated, yields a value.This means that

when the compiler compiles an expression, it will evaluate the expression and replace the

statement with the result. Take this example with the two variables A and B. A contains the

value 10 and B contains 8. 

A+B 

The result of this expression is 18. So instead of A+B, the compiler will put in the value 18.

An expression are composed of operators and operands. So what are operators and operands?

Since, you just saw an example of an expression, you just saw both an operator and two
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operands. A and B are both operands and the + is an operator. Remember that operators are

used to manipulate data. That is exactly what the + is doing. It is taking the value of the variable

A and adding it to the value in B. The + is also called the addition operator because the

operation is addition.

6.4.3.5.1  Operators

There are several operators available in Structured Text language:

Operation Symbol Precedence

Parenthesization (expression) Highest

Negation 

Complement

-

!

Multiply

Divide 

Modulo

*

/

%

 

Add

Subtract

+

-

Left Shift

Right Shift

<<

>>

Comparison <, >, <=, >=,==,!=

Boolean AND

Boolean OR

Boolean XOR

&

||

^

Lowest

All the operators in the table above are sorted after precedence. This is also called order of

operations, and you may know about if from mathematics.The order of operations is the order

in which the operations are executed or calculated. Just take a look at this expression: 

A + B * C

How will this expression be evaluated by the compiler? There are two operations left: multiply

and addition. But since multiply has a higher precedence, that will be the ?rst to be evaluated. B

* C comes ?rst and then the result is added to A. Every time an expression is evaluated, the

evaluation follows the order of precedence as in the table above.

4 Types of Operators, 4 Types of Expressions

The operators used for expressions in Structured Text can be divided into four groups. Each

group of operators will have its speci?c function and will yield a speci?c data type:

1. Arithmetic Operators  

2. Relational Operators  

3. Logical Operators  

4. Bitwise Operators

327
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6.4.3.5.1.1  Arithmetic Operators

All the arithmetic operators are often just called mathematical operators because they represent

math. The result will always be the mathematical result of the expression.

§ + (add) 

§ – (subtract/negate) 

§ * (multiply) 

§ / (divide) 

§ % (modulo divide)

Example: 

15 % 4 

Result: 

3   

6.4.3.5.1.2  Relational Operators

To compare or ?nd a relation between two values you can use one of the relational operators.

They are used for comparison and the result will be a boolean value (BOOL type), either TRUE(1)

or FALSE(0).

§ == (equal) 

§ < (less than) 

§ <= (less than or equal) 

§ > (greater than) 

§ >= (greater than or equal) 

§ != (not equal)   

Example:

TEMPERATURE = 93.9; 

TEMPERATURE >= 100.0;

Result: 

false

6.4.3.5.1.3  Logical Operators

If you want to compare boolean values (BOOL) and make some logic out of it, you have to

use logical operators. These operators also yields a boolean value of TRUE(1) or FALSE(0) as a

result of the expression.

§ &&

§ ||

§ ^

§ !  

Example: 

limitswitch1 = true; 

limitswitch2 = false; 

limitswitch1 || limitswitch2 
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Result: 

true  

6.4.3.5.1.4  Bitwise Operators

The last group of operators are called bitwise operators because the operations are performed

bitwise. It simply means that a logic operation is performed for each bit of two numbers. The

result is a new number – the total result of the bitwise operations.

§ &

§ |

§ ^

§ <<

§ >> 

Example:

15 & 8 

Result: 

8 

Since this operation is bitwise the calculation will be per bit. So to understand what’s going on

here, you have to convert the numbers to binary values:

 15 = 1111 8 = 1000 

Now each bit in the number 1111 (15) can be used in a logical operation with the other number

1000 (8): 1111 AND 1000

Bit number 1111 (15) 1000 (8) Result

0 1 0 0

1 1 0 0

2 1 0 0

3 1 1 1

6.4.3.5.2  Operators and Statements

So, in the previous section you learned that expressions evaluate. Meaning that all expressions

will yield the result and the compiler will replace the expression with the result. But what if you

want the TeslaSCADA2 (compiler) not to evaluate something, but to DO something?

Statements are the answer. Let’s take a look at the actions or statements that you can make in

Structured Text.

6.4.3.5.2.1  Assignment Statement and Operator

There are several statements available in Structured Text. All of them represent an action or

a condition. Beginning with actions, the most fundamental statement in Structured Text is

the assignment statement. Here’s how an assignment statement looks like:

A = B;
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What does this statement tell the compiler to do? To take the value of the variable B and put it

in the variable A. The TeslaSCADA2 is assigning a value to a variable. Here’s an even simpler

example: 

A = 10;

This statement will take the value 10 and put it into the variable A. Or said in another way – the

variable A will be assigned the value 10.Since the value of A is now 10, we can make another

statement, but this time with an expression: 

B = A + 2; 

When this line of code is compiled, the expression A + 2 will be evaluated to 12. The compiler

will replace the expression with the result 12. The statement will now look like this to the

compiler: 

B = 12;

What will happen now, is that the compiler will assign the value 12 to the variable B. The last

thing is that the = symbol is called the assignment operator. You can have all sorts of

expressions in your assignment statements, from simple values like numbers to variables and

functions. Because all expressions will be evaluated ?rst, and then, the result of that evaluation

will be used in the assignment statement.

6.4.3.5.2.2  Conditional Statements

A TeslaSCADA2 program is a piece of logic and therefore has to make some decisions. So in

your TeslaSCADA2 program you need a way to make decisions. This brings us to conditional

statements. Conditional statements are used for exactly that: To make decisions. There are one

way of doing conditional statements in Structured Text: IF statement.

IF Statements 

IF statements are decisions with conditions. There’s a special syntax for IF statements. This

means, that you have to write it in a certain way for the compiler to understand it. Because just

like semicolons are used to end statements, there are special keywords to make an IF

statement. Here’s how the syntax for IF statements looks like in STL for TeslaSCADA2:

if (boolean expression) {

  <statement>; 

} 

else if (boolean expression){

  <statement>; 

} else {

  <statement>; 

} 

Statement starts with keyword IF. Then parentheses. Between those two brackets are the

condition, which is an expression. But not just any expression. A boolean expression.
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6.4.3.5.3  Boolean and Numeric Expressions

You can divide expressions into two groups depending on what they yield.

Boolean expressions evaluates to a BOOL type value, TRUE or FALSE.
Here’s an example of a boolean expression: 

1 == 1 

This expression will evaluate to or yield TRUE(1). A boolean expression could also look like this: 

1 > 2 

But this time the boolean expression will evaluate to FALSE(0), since 1 is not larger than 2.

Numeric expressions evaluates to an integer or a ? oating point number. 

A numeric expression could look as simple as this one: 

13.2 + 19.8 

This expression will evaluate to the ?oating point number 33.0, and therefore is a numeric

expression.

Boolean expressions are used in IF statements as conditions. IF the boolean expression

evaluates to TRUE, then the following statements will be executed. The TeslaSCADA2 will only

execute the statements after the open bracket {, if the expression evaluates to TRUE. This is

illustrated by the following example: 

A = 0; 

IF (A == 0) {  

B = 0; 

}

Line number 3 will only be executed if A is equal to 0. In this case it will. A 0 is assigned to the

variable A in a statement right before the IF statement. For now, you’ve seen a simple IF

statement, where statements are only executed if an expression is TRUE. If that expression

evaluates to FALSE the statements will simply not be executed. What to do if you want to use

multiple conditions? Just like most other programming languages you can use the ELSE

IF and ELSE keywords for multiple conditions in the same IF statement. Both ELSE IF and ELSE

are optional in IF statements, but this is how the syntax looks like:

if (boolean expression) {

  <statement>; 

} 

else if (boolean expression){

  <statement>; 

} else {

  <statement>; 

}

If the boolean expression on line 1 is FALSE, the statements below will simply not be executed.

Instead the compiler will check the boolean expression after the ELSE IF keyword.Here it works

just like with the IF keyword: If the boolean expression after the keyword is true, the following

statements will be executed.At last is the ELSE keyword. It works as a default option for your IF
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statement. If all the IF and ELSE IF boolean expressions are evaluated to FALSE, the statements

after the ELSE keyword will be executed.

Combining Operators for Advanced Conditions

Beside making multiple conditions you can also expand your conditions to include multiple

variables.  You can combine multiple expressions, typically done with a logical operator, to get

a larger expression.

What if you want not just 1 but 2 inputs to be TRUE before an output is set. The expression

would look like this: 

if (INPUT1 & INPUT2) {

  OUTPUT1 = TRUE; 

} 

Now the expression will evaluate to TRUE, only if INPUT1 and INPUT2 is TRUE. 

6.4.3.5.4  Iteration with Repeating Loops

Probably one of the most powerful features in Structured Text is the ability to make loops that

repeat lines of code. In relation to TeslaSCADA2 programming loops can be used for many

different purposes. You might have a function or a set of statements that you want to execute a

certain amount of times or until something stops the loop. In Structured Text for TeslaSCADA2

you will ?nd 2 different types of repeating loops:

• FOR  

• WHILE  

Common for all the types of loops is that they have a condition for either repeating or

stopping the loop. The condition in FOR and WHILE loops decides whether the loop

should repeat or not. 

6.4.3.5.4.1  FOR Loops

The ?rst loop is the FOR loop and is used to repeat a speci?c number of times.This is the syntax

of FOR loops in Structured Text for TeslaSCADA2: 

for (count = initial_value; condition; increment){ 

 <statement>; 

}

Keyword that starts the FOR loop statement. 

count = initial_value 

This assignment operation is where you set the initial value you want to count from. Count is

the variable name and initial_value is the value you want to start counting from. 

; 

Semicolon before condition statement. 

condition of the loop’s continuation. 

; 

Semicolon before incremental statement. 

increment statement. 

331
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Usually used to increment initial value - count in this case. Then you place statements between {}

that will execute during loops.  

6.4.3.5.4.2  While Loops

The while loop is a little different from the FOR loop, because it is used to repeat the loop as

long as some conditions are TRUE. A WHILE loop will repeat as long as a boolean expression

evaluates to TRUE.Here’s the syntax of WHILE loops: 

while (boolean expression){  

<statement>; 

}

Between the parentheses are the boolean expression. If that boolean expression evaluates to

TRUE, all the statements between braces {}will be executed. When } is reached, the boolean

expression will be evaluated again. This will happen over and over again until the expression

doesn’t evaluate to TRUE. But to make the loop stop at one point, you have to change a value

in the boolean expression. Only in that way can the boolean expression go from TRUE to

FALSE. Here’s an example of a WHILE loop in Structured Text:

counter = 0; 

while (counter < 10){ 

counter = counter + 1;

machine_status = counter * 10; 

} 

If you look at the third line you will see how the loop will eventually stop repeating.  The

boolean expression uses the counter variable and checks if its value is less than 10. But since the

value of counter is set to 0 right before the WHILE loop, the boolean expression will be TRUE

unless counter is changed. That is what’s happening in line 3. This is the ?rst statement in the

WHILE loop, and with the other statements, are executed each time the loop repeats. In the

third line the value of the counter variable is increased by 1. You can say that the incremental

value is 1. In the example above, the loop will repeat 10 times. When the value of count reaches

10, the boolean expression will be evaluated to FALSE (because 10 is not less than 10) and the

loop will stop. 

You can also use the BREAK keyword in the WHILE loop to stop repeating the loop before the

boolean expression is FALSE. The syntax is an IF statement with the BREAK keyword in. Place it

anywhere between braces {}. 

if  (boolean expression) { 

break; 

}

6.4.3.6 User-de?ned functions

Also you can use user-de?ned functions in Structured Text language for TeslaSCADA2. You can

?nd example below:

function fun(a,b){ 

int c; 
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if (a>b){

 c=a+b; 

}

else{

 c=b-a; 

} 

return c; 

} 

int d = fun(13,17);

print(d); 

 In this example user function starts with key word function. Then name of the function. Then

in parentheses arguments are listed. Inside braces {} statements of the function. User-de?ned

function must be announced before main program. In this example program text of function

fun is in the beginning. And only after statements of fun function, text of the main program.

Results of this script will be 4 in the log window.

6.4.3.7 Using Tags in Structured Text

Of course for our purposes we need to use Tags in our scripts written in Structured Text

language. How to do that? You can include Tags in your project’s scripts by using keyword

Tags. Then type dot (.) and name of your Tag. For possibility to compile this code the name of

the tag should contain only English letters without white spaces and any signs.

Example: 

int var = 10; 

Tags.Tag1 = var; 

In this example value of the variable var will be assigned to tag's value with name Tag1.

Other  Example:

?oat f = Tags.Float1; 

In this example value of the tag with name Float1 will be assigned to variable f.

Array Example:

byte bytes[10] = Tags.Array;

In this example value of the array tag with name Array will be assigned to the bytes array.

And you can use every element of the array for other operations. Like this:

for (int i=0;i<10;i++){

print(bytes[i]);

}

6.4.3.8 Using Object property ?elds in Structured Text

You can include Object property ?elds in your project’s scripts by using keyword Objects. Then

type dot (.), name of your Object (for object type you can use keyword - this), again type dot (.)

and name of property ?eld. For possibility to compile this code the name of the object and

object property ?elds should contain only English letters without white spaces and any signs.

Example: 
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int width = 100; 

Objects.Rectangle.width = var;

In this example value of the variable var will be assigned to Object with name Rectangle and

?eld property name width. Name of the property ?elds you can ?nd out in parentheses of

object and property descriptions above. 

Other Example: 

Objects.this.? llcolor=“0x66AA00FF”; 

Change color of the current object to which the script is attached. Color is represented in RGBA

format. Where: 

0x  - Hex format of the color. 

66  - Red color; 

AA - Green color; 

00  - Blue color; 

FF  - Transparency. 

Also it’s possible to use standard colours by using keyword Color.

Example: 

Objects.Button.? llcolor=Color.BLUE; 

List of colours: 

Color Code

Color.RED “0xFF0000FF”

Color.BROWN “0xA52A2AFF"

Color.GREEN "0x00FF00FF"

Color.BLUEVIOLET “0x8A2BE2FF"

Color.BLUE "0x0000FFFF"

Color.CORAL “0xFF7F50FF"

Color.AQUA “0x00FFFFFF"

Color.CYAN “0x00FFFFFF"

Color.AQUAMARINE "0x7FFFD4FF"

Color.DARKBLUE “0x00008BFF"

Color.AZURE “0xF0FFFFFF"

Color.DARKCYAN “0x008B8BFF"

Color.BLACK “0x000000FF”

Color.DARKGREY “0xA9A9A9FF"

Color.DARKGREEN “0x006400FF"

Color.DARKORANGE “0xFF8C00FF"

Color.DARKRED “0x8B0000FF"

Color.DARKVIOLET “0x9400D3FF"

Color.GOLD “0xFFD700FF"

Color.GREY “0x808080FF"

Color.INDIGO “0x4B0082FF"

Color.IVORY “0xFFFFF0FF"
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Color.KHAKI “0xF0E68CFF"

Color.LIGHTBLUE “0xADD8E6FF"

Color.LIGHTCORAL “0xF08080FF"

Color.LIGHTCYAN “0xE0FFFFFF"

Color.LIGHTGREEN “0x90EE90FF"

Color.LIGHTGREY “0xD3D3D3FF"

Color.MAROON “0x800000FF"

Color.NAVY “0x000080FF"

Color.OLIVE “0x808000FF"

Color.ORANGE “0xFFA500FF"

Color.PINK “0xFFC0CBFF"

Color.PURPLE “0x800080FF"

Color.SILVER “0xC0C0C0FF"

Color.VIOLET “0xEE82EEFF"

Color.WHEAT “0xF5DEB3FF"

Color.WHITE “0xFFFFFFFF"

Color.YELLOW “0xFFFF00FF”

6.4.3.9 Using Server parameter ?elds in Structured Text

You can include Server parameter ?elds in your project’s scripts by using keyword Servers. Then

type dot (.), name of your Server, again type dot (.) and name of parameter ?eld. For possibility

to compile this code the name of the server and server parameter ?elds should contain only

English letters without white spaces and any signs.

Example: 

Servers.ModbusServer.ipaddress = “192.168.0.102”;

In this example value “192.168.0.102” will be assigned to the server with name ModbusServer

and ?eld property name ipaddress. Name of the property ?elds you can ?nd out in

parentheses of server and parameter descriptions above. Also for parameters are written in

descriptions you can use: lostconnection, connect and connected.

6.4.3.10Using User parameter ?elds in Structured Text

You can include User parameter ?elds in your project’s scripts by using keyword Users. Then

type dot (.), name of your User or you can use key word current for choosing current user,

again type dot (.) and name of parameter ?eld. For possibility to compile this code the name of

the user and user parameter ?elds should contain only English letters without white spaces and

any signs.

Example: 

Users.Operator.controlfunctions = true;

In this example value true will be assigned to the user with name Operator and ?eld property

name controlfunctions. Name of the property ?elds you can ?nd out in parentheses of user

and parameter descriptions above. 
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6.4.3.11Embedded functions

In the Structured Text language for TeslaSCADA2 there are number of embedded functions. We

group all functions in libraries:

§ Print

§ Arithmetic  

§ Bitmap operations

§ Select

§ Trigonometric

§ Strings

§ Hex operations

§ Base64

§ Date and time

§ Server

§ Recipes

§ E-mail

§ Odoo ERP

§ Excel and screenshot

§ Database

§ HTTP

§ Global arguments

§ Tag properties

§ Dialog box

§ Trend's curve

§ Screen

§ Files

§ Common RTU

§ Call external software

§ User

§ Push

6.4.3.11.1  Print library

print(Input) -  print input in the log.

Example:

print("Some message");

This function will print "Some message" in Debug window in TeslaSCADA IDE and in the log in

TeslaSCADA2 Runtime.

6.4.3.11.2  Arithmetic library

sqrt(Input) - arithmetic operation square root of the input value. 

pow(Input1, Input2) - arithmetic operation power for input values. output = Input1^Input2. 
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log(Input1, Input2) - arithmetic operation logarithm of the input value (Output =

LogInput2Input). 

ln(Input1) - arithmetic operation ln(natural logarithm) of the input value (Output = Ln(Input)).

abs(Input) - used to arithmetic operation absolute for input value (Output = |Input|). 

sign(Input) - used to arithmetic operation sign for input value (Output = -Input). 

int(Input) - used to arithmetic operation for getting integer part of the input value (Output =

int(Input)).

Example:

int a = pow(5, 2);

print(a);

Response:

a = 25;

6.4.3.11.3  Bitmap operations library

bytestoshort(Input1, Input2) - used to pack 2 bytes into the short  (Output =

Input1<<8+Input2). 

bytestoint(Input1, Input2, Input3, Input4) - used to pack 4 bytes into the int (Output =

Input1<<24+Input2<<16+Input3<<8+Input4). 

bytestofloat(Input1, Input2, Input3, Input4) - used to pack 4 bytes into the float (Output =

IntToFloat(Input1<<24+Input2<<16+Input3<<8+Input4)). 

bytestolong(Input1, Input2, Input3, Input4, Input5, Input6, Input7, Input8) - used to pack

8 bytes into the long (Output =

Input1<<56+Input2<<48+Input3<<40+Input4<<32+Input5<<24+Input6<<16+Input7<<8+I

nput8). 

bytestodouble(Input1, Input2, Input3, Input4, Input5, Input6, Input7, Input8) - used to

pack 8 bytes into the double (Output = LongToDouble

(Input1<<56+Input2<<48+Input3<<40+Input4<<32+Input5<<24+Input6<<16+Input7<<8+I

nput8)). 

shorttobyte(Input1, Input2) - used to unpack short value in 2 bytes (Output = Input[Input2]). 

shortstoint(Input1, Input2) - used to pack 2 shorts in the int (Output = Input<<16+Input2). 

inttoshort(Input1,Input2) - used to unpack int value into 2 shorts (Output = Input[Input2]). 

inttobyte(Input1,Input2) - used to unpack int value into 4 bytes (Output = Input[Input2]). 

floattobyte(Input1,Input2) - used to unpack float value into 4 bytes (Output =(int)

Input[Input2]). 

longtobyte(Input1,Input2) - used to unpack long value into 8 bytes (Output =

Input[Input2]). 

doubletobyte(Input1,Input2) - used to unpack double value into 8 bytes (Output =(long)

Input[Input2]). 

readbit(Input1, Input2) - used to read bit of the input value (Output = Input[Input2]). 

setbit(Input1, Input2) - used to set bit of the input value (Output = Input | 1<<Input2). 
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resetbit(Input1,Input2) - used to reset bit of the input value (Output = Input &

~(1<<Input2)). 

Example:

int a = setbit(6, 0);

print(a);

Response:

a = 7;

6.4.3.11.4  Select library

min(Input1, Input2) - used to select minimum value of Input2 and Input1 (Output=Min(Input,

Input2)). 

max(Input1, Input2) - used to select maximum value of Input2 and Input1

(Output=Max(Input, Input2)). 

Example:

int a = max(6, 12);

print(a);

Response:

a = 12;

6.4.3.11.5  Trigonometric library

toradians(Input) - used to convert degrees to radians. 

todegrees(Input) - used to convert radians to degrees. 

sin(Input) - used to calculate sin of Input value. (Output = sin(Input)). 

cos(Input) - used to calculate cos of Input value. (Output = cos(Input)). 

tan(Input) - used to calculate tag of Input value. (Output = tag(Input)). 

asin(Input) - used to calculate arc sin of Input value. (Output = arc sin(Input)). 

acos(Input) - used to calculate arc cos of Input value. (Output = arc cos(Input)).

atan(Input) - used to calculate arc tag of Input value. (Output = arc tag(Input)). 

Example:

double angle = toradians(30);

double a = sin(angle);

print(a);

Response:

a = 0.5;

6.4.3.11.6  Strings library

stringsequals(Input1, Input) - compare two strings in Inputs and if there are equals it returns

true.

stringtodouble(Input) - converts Input’s string value into double value. 

doubletostring(Input) -converts Input’s double value into string value. 
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stringtoint(Input) - converts Input’s string value into integer value. 

inttostring(Input) - converts Input’s integer value into string value. 

substring(Input1, Input2, Input3) - used to cut begin and end of Input1’s string value by the

?  of characters de?ned in Input2 and Input3. 

cutbeginstring(Input1, Input2) - used to cut begin of Input1’s string value by the ?  of

characters de?ned in Input2. 

cutendstring(Input1, Input2) - used to cut end of Input1’s string value by the ?  of

characters de?ned in Input2. 

split(Input1, Input2, Input3) - used to split string in Input1 to string array. Input2 contains

split regular expression; Input3 contains number of elements in array (if this number greater

then number of elements that we get during operation, they will be ? lled by “”) 

Example: 

split(“hello;world”, “;”, 3); 

Response: 

string strarr[3] = ["hello", "world", “”]; 

Other Example:

string str = substring("Hello world", 2, 5);

print(str);

Response:

str ="llo";

6.4.3.11.7  Hex operations library

hextoint(Input) - converts hex value into integer. 

inttohex(Input) - converts integer value into hex.

Example:

string a = inttohex(255);

print(a);

Response:

a = "ff";

6.4.3.11.8  Base64 library

base64decode(Input) - used to decode Base64 string to byte array. Input contains base64

encoded string. In Output will be decoded byte array. 

base64encode(Input) - used to encode byte array to Base64 string. Input contains byte array.

In Output will be encoded Base64 string.

Example:

int arr[5] = [1,2,3,4,5];

string a = base64encode(arr);

print(a);
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Response:

a = "AQIDBAU=";

6.4.3.11.9  Date and time library

datetime(Input) -  used to get date and time components depending on Input value: 

0 - get seconds. 

1 - get minutes. 

2 - get hour of the day considering AM/PM. 

3 - get hour of the day. 

4 - get day of the week (1-Sunday, 2-Monday…). 

5 - get day of month. 

6 - get month (0 - January, 1 - February…). 

7 - get year. 

8 - get minutes of the day (hour*60 + minutes).

Example:

int a = datetime(7);

print(a);

Response:

a = 2020;

currentdatetime(Input1) - used to get current date and time in string format. Input1 contains

format of the date and time. Function returns formatted current date and time. 

Example: 

string date = currentdatetime(“yyyy-MM-dd HH:mm:ss”); 

Response:

date = "2020-09-15 14:22:12" 

currentdatetimeinmil() - used to get current date and time in milliseconds from 1 January

1970. 

Example: 

long date = currentdatetimeinmil(); 

Response:

date = 1627475044148 

datetimefrom(Input1, Input2) - used to convert date time in milliseconds since 1 January

1970 into string format. Input1 contains format of the date and time. Input2 contains date time

in milliseconds since 1 January 1970. Function returns formatted date and time in string. 
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Example: 

string date = datetimefrom(“yyyy-MM-dd HH:mm:ss”, 1603713302140); 

Response:

date = "2020-10-26 11:22:52" 

datetimeto(Input1, Input2) - used to convert date time in string format into milliseconds

since 1 January 1970. Input1 contains format of the date and time. Input2 contains date time in

string format. Function returns time in milliseconds since 1 January 1970.

Example: 

long date = datetimeto(“yyyy-MM-dd HH:mm:ss”, "2020-10-26 11:22:52"); 

Response:

date = 1603713302140

sleep(Input1) - used to make pause. Input1 contains time of the pause in milliseconds.

Example: 

sleep(1000); //script sleeps 1000 ms.

6.4.3.11.10  Server library

reconnect(Input1,Input2) - used to reconnect to server with name from Input1 to IP address

from Input2.

Example:

reconnect("ModbusServer1", "192.168.0.1");

Response:

Reconnect server with name ModbusServer1 to IP address 192.168.0.1.

opcuareadattribute(Input1, Input2, Input3) - used to read attribute of the OPC UA server

node. Input1 contains name of the server; Input2 contains name of the tag with de?ned

NodeId; Input3 contains number of the attribute. List of the attributes:

? Attribute

1 NodeId

2 NodeClass

3 BrowseName

4 DisplayName

5 Description

6 WriteMask
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7 UserWriteMask

8 IsAbstract

9 Symmetric

10 InverseName

11 ContainsNoLoops

12 EventNoti?er

13 Value

14 DataType

15 ValueRank

16 ArrayDimensions

17 AccessLevel

18 UserAccessLevel

19  MinimumSamplingInterval

20 Historizing

21 Executable

22 UserExcecutable

Example: 

string description = opcuareadattribute(“OPCUAServer”, “tagname”, 5); 

connect(Input1) - used to connect to server with name from Input1.

Example:

connect("ModbusServer1");

disconnect(Input1) - used to disconnect to server with name from Input1.

Example:

disconnect("ModbusServer1");

6.4.3.11.11  Recipes library

selrecipe(Input1, Input2) -  used to choose recipe row. Input2 is an input that contains name

of the recipe. Input1 is number of the row (starting from 1). Output = true if recipe row is

chosen.

Example:

selrecipe(2, "Recipe1");

Response:

Select row number 2 from recipe with name Recipe1.
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6.4.3.11.12  E-mail library

sendemail(Input1, Input2) - send email (if it setup in Project properties ) with subject from

Input1 and message from Input2. 

Example:

sendemail("Alarm", "Tag's alarm message");

Response:

Send E-mail to the addresses setup in project properties with subject "Alarm" and with body

"Tag's alarm message". 

setemailsubject(Input1) - set E-mail subject (if it setup in Project properties ) from Input1. 

Example:

setemailsubject("Alarm");

setnotificationpriority(Input1) - set notification priority from Input1. All event messages that

have priority less then Noti?cations(Priority<)  will be sent by E-mail, GSM modem, Telegram

bot and arise alarm box.

Example:

setnotificationpriority(100);

setemailaddresses(Input1) - set E-mail addresses (if it setup in Project properties ) from

Input1. To which E-mail addresses the mail will be sent. Use commas to separate addresses.

Example:

setemailaddresses("email1@gmail.com , email2@gmail.com");

addemailrange(Input1, Input2, Input3, Input4) - add E-mail range for the client (if it setup in

Project properties ) and if "Depends on priority" is checked. Input1 contains name of the

range. Input2 contains value of the range's start priority. Input3 contains value of the range's

end priority. To which E-mail addresses the mail will be sent is placed in Input4. Use commas to

separate addresses.

Example:

addemailrange("Emails" , 0, 100, "pochta@gmail.com);

removeemailrange(Input1) - remove E-mail range from the client (if it setup in Project

properties ) and if "Depends on priority" is checked. Input1 contains name of the range

Example:

removeemailrange("Emails" );

99
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addemailtorange(Input1, Input2) - add E-mail address to the range of the client (if it setup in

Project properties ) and if "Depends on priority" is checked. Input1 contains name of the

range. Input2 contains E-mail address.

Example:

addemailtorange("Emails" , "pochta@gmail.com);

removeemailfromrange(Input1, Input2) - remove E-mail address from the range of the client

(if it setup in Project properties ) and if "Depends on priority" is checked. Input1 contains

name of the range. Input2 contains E-mail address.

Example:

removeemailfromrange("Emails" , "pochta@gmail.com);

6.4.3.11.13  Odoo ERP library

odoogetmodelcount(Input1, Input2, Input3) - used is to get number of rows that you get

from Odoo ERP with name in Input1 (Example: “OdooERP0”) and model with name in Input2

(Example: “mrp.workorder”) that ?ts the ? lter in Input3. Filter is consisted with name of ?eld,

comparison and value to compare separated by commas (Example:”state,=,cancel” get rows

where state == cancel). 

Example:

Tags.orderscount = odoogetmodelcount("OdooERP0", “mrp.workorder","state,=,cancel"); 

odooreadmodel? eld(Input1, Input2, Input3, Input4, Input5) - used to read value of row’s

?eld that you get from Odoo ERP with name in Input1 (Example: “OdooERP0”) and model with

name in Input2 (Example: “mrp.workorder”) that ?ts the ? lter in Input3. Filter is consisted with

name of the ?eld, comparison and value to compare separated by commas

(Example:”state,=,cancel” get rows where state == cancel). Name of the ?eld you have to enter

in Input4 (Example:”production_id”). In Input5 you have to enter row position you want to read

(Example:1). 

Example: 

Tags.Field = odooreadmodel?eld("OdooERP0","mrp.workorder", "", “production_id",1); 

odoowritemodel? eld(Input1, Input2, Input3, Input4, Input5, Input6) - used to write value

to the row’s ?eld that you get from Odoo ERP with name in Input1 (Example: “OdooERP0”) and

model with name in Input2 (Example: “mrp.workorder”) that ?ts the ? lter in Input3. Filter is

consisted with name of the ?eld, comparison and value to compare separated by commas

(Example:”state,=,cancel” get rows where state == cancel). Name of the ?eld you have to enter

in Input4 (Example:”production_id”). In Input5 you have to enter row position you want to read

99

99
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(Example:1). And in Input6 you have to enter value should be written (Example:”20”). If write is

successful function return TRUE. 

Example: 

odoowritemodel?eld("OdooERP0","product.product", "id,=,2","list_price",0,Tags.Price); 

odoocallfunction(Input1, Input2, Input3, Input4) - used to call function in Odoo ERP with

name in Input1 (Example: “OdooERP0”) and model with name in Input2 (Example:

“mrp.workorder”) with name in Input3 (Example:”action_toggle_is_locked”), and with parameter

in Input4 (Example: 1). If call is successful function return TRUE.

Example: 

odoocallfunction("OdooERP0","mrp.production","action_toggle_is_locked",Tags.ID); 

6.4.3.11.14  Excel and screenshot library

saverecipeexcelreport(Input1, Input2, Input3, Input4) - used to save recipe report in Excel

format bind to row. Input2 is an input that contains name of the recipe. Input1 is number of

the row (starting from 1). Input3 contains ? le name of the report. Input4 contains title name.

Output = true if recipe row is saved in Excel format. Report is saved in the folder you setup in

Project properties->Report folder .

 

Example:

saverecipeexcelreport(1,”RecExcel","streport","Title"); 

excelopenworkbook(Input1) - used to open excel workbook. Input1 contains name of the

Excel file. Excel file is in the folder you setup in Project properties->Report folder .

 

Example:

excelopenworkbook(”reportfilename"); 

excelcreateworkbook() - this function create workbook for Excel ? le; 

excelsaveworkbook(Input1) - used to save workbook in the Excel with name in Input1.

Report is saved in the folder you setup in Project properties->Report folder .

Example: 

excelsaveworkbook(”? lename”); 

excelcreatesheet(Input1) - create sheet in the workbook of Excel ? le with name in Input1. 

Example:

99

99

99
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excelcreatesheet(”sheetname”); 

excelsetcolumnwidth(Input1, Input2, Input3) - set column width with name of the sheet in

Input1, number of the column in Input2 and width in Input3. 

Example: 

excelsetcolumnwidth(”sheetname”, 0, 5000); 

excelcreatestyle(Input1, Input2, Input3, Input4, Input5) - set cell style with name of the

style in Input1, horizontal type in Input2 (can be “CENTER”, “LEFT”, “RIGHT”), vertical type in

Input3 (can be “CENTER”, “TOP”, “BOTTOM”), font size in Input4 and bold or not in Input5. 

Example: 

excelcreatestyle(”stylename”,"CENTER", "CENTER", 14, false);

excelcreatecolorstyle(Input1, Input2, Input3, Input4, Input5, Input6) - set cell style with

name of the style in Input1, horizontal type in Input2 (can be “CENTER”, “LEFT”, “RIGHT”),

vertical type in Input3 (can be “CENTER”, “TOP”, “BOTTOM”), font size in Input4, bold or not in

Input5 and color of the background in Input6 (can be “GREY”, “GREEN”, “RED”, “BLUE”,

“YELLOW”). 

Example: 

excelcreatecolorstyle(”stylename”,"CENTER", "CENTER", 14, false,”GREY”); 

excelcreatecell(Input1, Input2, Input3, Input4, Input5) - create cell with name of the sheet

in Input1, number of the row in Input2 and position of the cell in Input3, style name in Input4

and text of the cell in Input5. 

Example: 

excelcreatecell(”sheetname”, 0, 0, ”stylename”,”Text”); 

excelreadcell(Input1, Input2, Input3) - read cell from the sheet with name in Input1, number

of the row in Input2 and position of the cell in Input3. 

Example: 

String cellvalue = excelreadcel(”sheetname”, 0, 0); 

excelcreatenumbercell(Input1, Input2, Input3, Input4, Input5, Input6) - create cell with

name of the sheet in Input1, number of the row in Input2 and position of the cell in Input3,

style name in Input4, numeric value in Input5 and decimal position for numeric value in Input6. 
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Example: 

excelcreatenumbercell(”sheetname”, 0, 0, ”stylename”,Tags.Value, 2); 

excelmergecells(Input1, Input2, Input3, Input4, Input5) - merge cells with name of the

sheet in Input1, start row in Input2 and end row in Input3, start column in Input4 and end

column in Input5. 

Example: 

excelmergecells(”sheetname”,0,1,0,1); 

makescreenshot(Input1) - used to save screenshot with name in Input1. Screenshot is saved

in the folder you setup in Project properties->Report folder .

Example: 

makescreenshot(”? lename”); 

6.4.3.11.15  Database library

createdbsqlliteconnection(Input1) - used to create create connection to SQLLite database

with name in Input1. Database file is created in DB  folder.

Example: 

createdbsqlliteconnection(”? lename”); 

createdbconnection(Input1, Input2, Input3) - used to create connection to database with

name in Input1, with username in Input2 and password in Input3. 

Example: 

createdbconnection(“jdbc:mysql://192.168.0.76:3306/test”, “username”, “password”); in this

example MySQL  database is created. (“jdbc:mysql” in the beginning means that MySQL

connection is created). 

closedbconnection(Input1) - used to close database connection with name in Input1. 

Example: 

closedbconnection(”? lename”); 

99
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createdbtable(Input1, Input2, Input3) - used to create table in database with name of

database in Input1, table name in Input2 and columns in Input3 (columns should be separated

by commas, every table has auto incremented column “_id”).

Example: 

createdbtable(“databasename”, “tablename”, “title, parameter1, parameter2”); 

insertvaluesintodb(Input1, Input2, Input3) - used to insert row into database with name of

database in Input1, table name in Input2 and values in Input3 (values should be separated by

commas).

Example: 

insertvaluesintodb(“databasename”, “tablename”, “Title, 10, 20”); 

readvaluefromdb(Input1, Input2, Input3, Input4) - used to read value from database with

name of database in Input1, table name in Input2,  name of the read column in Input3 and

condition of read row in Input4 (if several rows ?t to condition ?rst row is read). 

Example: 

string parameter = readvaluefromdb(“databasename”, “tablename”, “parameter1”,”_id=1”); 

readvaluefromdbinpos(Input1, Input2, Input3, Input4, Input5) - used to read value from

database with name of database in Input1, table name in Input2,  name of the read column in

Input3, condition of read row in Input4 and position of the row in Input5. 

Example: 

string parameter = readvaluefromdbinpos(“databasename”, “tablename”, “parameter1”,”title =

Title”, 1); 

updatevalueindb(Input1, Input2, Input3, Input4, Input5) - used to update value in

database with name of database in Input1, table name in Input2,  name of the updated column

in Input3, condition of the updated row in Input4 and updated value in Input5 (if several rows

?t to condition all rows values are changed) 

Example: 

updatevalueindb(“databasename”, “tablename”, “parameter1”,”title = Title”, “10”); 

deleterowindb(Input1, Input2, Input3) - used to delete row(s) in database with name of

database in Input1, table name in Input2 and condition that should ?t the row(s) in Input3. 
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Example: 

deleterowindb(“databasename”, “tablename”, “_id=1”); 

readvaluefromhistorydb(Input1, Input2, Input3, Input4, Input5) - used to read value from

history database with name of history database in Input1, begin time in Input2, end time in

Input3 (begin and end time in milliseconds since 1 January 1970 year, Input4 database name of

the parameter to read, Input5 decimal position of the read value. If several rows ?t to time

condition ?rst row is read. 

Example: 

string parameter = readvaluefromhistorydb(“History DB0”, 1636367879810,

1636367979810,”pressure”, 2); 

runsql(Input1, Input2) - used to execute SQL request with name of database in Input1 and

SQL query in Input2. 

Example: 

runsql(“databasename”, “create table if not exists param (_id INTEGER PRIMARY KEY

AUTOINCREMENT, temperature, pressure, humidity”); 

runsqlquery(Input1, Input2, Input3) - used to execute SQL request with name of database in

Input1 and SQL query in Input2. Input3 contains name of the Result set (table). This Result set is

place into global map where key is the name of the result set from the Input3.

Example: 

runsqlquery(“databasename”, “select * from param”, "resultname"); 

rsfirst(Input1) - used to move cursor of the result set (table) to the first row. Input1 contains

name of result set. Return TRUE if the moving is successful. This function doesn't work for SQL

lite database.

Example: 

rsfirst("resultname"); 

rslast(Input1) - used to move cursor of the result set (table) to the last row. Input1 contains

name of result set. Return TRUE if the moving is successful. This function doesn't work for SQL

lite database.

Example: 

rslast("resultname"); 
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rsnext(Input1) - used to move cursor of the result set (table) to the next row. Input1 contains

name of result set. Return TRUE if the moving is successful.

Example: 

rsnext("resultname"); 

rsisempty(Input1) - used to check availability of the data in result set (table). Input1 contains

name of result set. Return TRUE if the result set is empty. This function doesn't work for SQL lite

database.

Example: 

rsfempty("resultname"); 

rsmove(Input1, Input2) - used to move the cursor to position. Input1 contains name of result

set. Input2 contains position value. Return TRUE if the moving is successful.

Example: 

rsmove("resultname",3); 

rsbeforefirst(Input1) - used to move cursor of the result set (table) to the position before the

first row. Input1 contains name of result set. Return TRUE if the moving is successful. This

function doesn't work for SQL lite database.

Example: 

rsbeforefirst("resultname"); 

rsafterlast(Input1) - used to move cursor of the result set (table) to the position after last row.

Input1 contains name of result set. Return TRUE if the moving is successful. This function

doesn't work for SQL lite database.

Example: 

rsafterlast("resultname"); 

rspos(Input1) - used to return the position of the cursor . Input1 contains name of result set.

This function doesn't work for SQL lite database.

Example: 

int pos = rspos("resultname"); 
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rsreadstring(Input1, Input2) - used to read string value from the current cursor. Input1

contains name of result set. Input2 contains name of the column.

Example: 

string name = rsreadstring("resultname","name"); 

rsreadstringnum(Input1, Input2) - used to read string value from the current cursor. Input1

contains name of result set. Input2 index of the column.

Example: 

string name = rsreadstringnum("resultname",2); 

rsreaddouble(Input1, Input2) - used to read double value from the current cursor. Input1

contains name of result set. Input2 contains name of the column.

Example: 

double value = rsreaddouble("resultname","value"); 

rsreaddoublenum(Input1, Input2) - used to read double value from the current cursor.

Input1 contains name of result set. Input2 index of the column.

Example: 

double value = rsreaddoublenum("resultname",2); 

rsreadint(Input1, Input2) - used to read int value from the current cursor. Input1 contains

name of result set. Input2 contains name of the column.

Example: 

int value = rsreadint("resultname","value"); 

rsreadintnum(Input1, Input2) - used to read int value from the current cursor. Input1

contains name of result set. Input2 index of the column.

Example: 

int value = rsreadintnum("resultname",2); 

rsreadbool(Input1, Input2) - used to read bool value from the current cursor. Input1 contains

name of result set. Input2 contains name of the column.

Example: 

bool value = rsreadbool("resultname","value"); 

rsreadboolnum(Input1, Input2) - used to read bool value from the current cursor. Input1

contains name of result set. Input2 index of the column.

Example: 
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bool value = rsreadboolnum("resultname",2); 

rsgetcolnum(Input1) - used to get number of columns. Input1 contains name of result set.

Example: 

int num = rsgetcolnum("resultname"); 

rsgetcol(Input1, Input2) - used to get column name from the result set. Input1 contains name

of result set. Input2 index of the column. This function doesn't work for SQL lite database.

Example: 

string name = rsgetcol("resultname",2); 

rsremove(Input1) - used to remove result set from the global map memory. Input1 contains

name of result set.

Example: 

rsremove("resultname"); 

6.4.3.11.16  HTTP library

ifttttrigger(Input1, Input2, Input3, Input4, Input5) - used to send trigger event ifttt.com

service. Input1 contains key; Input2 contains event trigger name; Input3, Input4, Input5 contain

value1, value2 and value3 for ifttt.com  service. 

Example: 

ifttttrigger("yourkey", “tag_trigger", "Tag is become true", Tags.Tag_2, “current value"); 

httppostcreate(Input1, Input2) - used to create HTTP post request. Input1 contains name of

the request; Input2 contains url address. 

Example: 

httppostcreate("namehttppost", "https://hooks.zapier.com/hooks/catch/zapkey/otherzap/"); 

httppostaddvalue(Input1, Input2, Input3) - used to add value into HTTP post request.

Input1 contains name of the request; Input2 contains name of the value; Input3 contains value. 

Example: 

httppostaddvalue("namehttppost", “valuename”, “value”);

httppostexecute(Input1) - used to execute HTTP post request. Input1 contains name of the

request. Function returns HTTP post response. 

https://ifttt.com
https://ifttt.com
https://hooks.zapier.com/hooks/catch/zapkey/otherzap/");
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Example: 

httppostexecute(“namehttppost"); 

httppostgetvalue(Input1, Input2) - used to get value from the HTTP post response. Input1

contains response string; Input2 contains name of response value. Function returns value from

the HTTP post response.

Example: 

string value = httppostgetvalue(“{valuename: value}”, “valuename”); 

6.4.3.11.17  Global arguments library

TeslaSCADA IDE project has storage is RAM of the device with global arguments. You can add

and get arguments by using control property  of the button and functions described below:

getglobalargument(Input1, Input2) - used to get value from the global storage of the

software. Input1 contains name of the value; Input2 contains default value, if the value is not

available in the storage. 

Example: 

getglobalargument(“value”, “1”); 

putglobalargument(Input1, Input2) - used to put value into the global storage of the

software. Input1 contains name of the value; Input2 contains value that will be written in the

storage. 

Example: 

putglobalargument(“value”, “1”); 

6.4.3.11.18  Tag properties library

gettagvalue(Input1, Input2) - used to get value of the tag. Input1 contains name of the tag;

Input2 contains default value, if the tag is not exist. 

Example: 

string value = gettagvalue(“value”, “1”); 

gettagvalueorerror(Input1, Input2) - used to get value of the tag. Input1 contains name of

the tag; Input2 contains name of the error tag. If tag with name in Input1 doesn't exist TRUE is

placed in the tag with name in Input2.

Example: 

string value = gettagvalueorerror(“value”, “errortag”); 

267
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settagvalue(Input1, Input2) - used to set value of the tag. Input1 contains name of the tag;

Input2 contains value. 

Example: 

settagvalue(“value”, “1”);

gettagdescription(Input1, Input2) - used to get description of the tag. Input1 contains name

of the tag; Input2 contains default description, if the tag is not exist. 

Example: 

string description = gettagdescription(“value”, “description”); 

settagdescription(Input1, Input2) - used to set description of the tag. Input1 contains name

of the tag; Input2 contains description. 

Example: 

settagdescription(“value”, “1”); 

gettagenablealarms(Input1) - used to get tag information about enable or not alarms.

Input1 contains name of the tag.

Example: 

bool enablealarm = gettagenablealarms(“tagname”); 

settagenablealarms(Input1, Input2) - used to enable or disable alarms for the tag. Input1

contains name of the tag; Input2 contains value (true for enable or false for disable). 

Example: 

settagenablealarms(“tagname”, “true”); 

settagalarm(Input1, Input2, Input3) - used to enable or disable alarm for the tag. Input1

contains name of the tag; Input2 contains alarm’s type(“hihi”, “hi”, “lolo”, “lo”, “normal”); Input3

contains value (true for enable or false for disable). 

Example: 

settagalarm(“tagname”, ”hihi”, “true”);
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settagalarmlimit(Input1, Input2, Input3) - used to set alarm limit of the tag. Input1 contains

name of the tag; Input2 contains alarm’s type(“hihi”, “hi”, “lolo”, “lo”); Input3 contains limit’s

value. 

Example: 

settagalarmlimit(“tagname”, ”hihi”, 500); 

settagalarmpriority(Input1, Input2, Input3) - used to set alarm priority of the tag. Input1

contains name of the tag; Input2 contains alarm’s type(“hihi”, “hi”, “lolo”, “lo”,”normal”); Input3

contains priority’s value. 

Example: 

settagalarmpriority(“tagname”,”hihi”, 500); 

settagalarmmessage(Input1, Input2, Input3) - used to set tag’s alarm message. Input1

contains name of the tag; Input2 contains alarm’s type(“hihi”, “hi”, “lolo”, “lo”,”normal”); Input3

contains message value. 

Example: 

settagalarmmessage(“tagname”, ”hihi”, “Value is to high”);

settagalarmdeadband(Input1, Input2) - used to set tag’s alarm deadband. Input1 contains

name of the tag; Input2 contains deadband’s value. 

Example: 

settagalarmdeadband(“tagname”, 0.5); 

settagenablehistory(Input1, Input2) - used to enable or disable tag’s history. Input1 contains

name of the tag; Input2 contains value (true for enable or false for disable). 

Example: 

settagenablehistory(“tagname”, “true”); 

settagstorageperiod(Input1, Input2) - used to set tag’s storage period. Input1 contains

name of the tag; Input2 contains storage period’s value. 

Example: 

settagstorageperiod(“tagname”, 1000); 
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settagstoreindb(Input1, Input2) - used to enable or disable tag’s storage value in DB. Input1

contains name of the tag; Input2 contains value (true for enable or false for disable). 

Example: 

settagstoreindb(“tagname”, “true”); 

settaghistorydeadband(Input1, Input2) - used to set tag’s history deadband. Input1 contains

name of the tag; Input2 contains history deadband's value. 

Example: 

settaghistorydeadband(“tagname”, 1.0); 

6.4.3.11.19  Dialog box library

infodialogbox(Input1, Input2) - used to call information dialog. Input1 contains title of the

dialog box; Input2 contains message. 

Example: 

infodialogbox(“Title”, “Some message here”); 

setdialogbox(Input1, Input2, Input3, Input4) - used to call set tag’s value dialog box. Input1

contains title of the dialog box; Input2 contains message, Input3 tag’s name, Input4 contains

value to set. 

Example: 

setdialogbox("Value set", "Set value", "FanStartRotation", "true"); 

6.4.3.11.20  Trend's curve library

addcurve(Input1, Input2, Input3, Input4, Input5, Input6, Input7, Input8) - used to add

curve in the trend. Input1 contains name of the trend; Input2 contains name of the curve;

Input3 contains name of the tag; Input4 contains line width of the curve; Input5 red part of the

curve’s color (0-255); Input6 green part of the curve’s color (0-255); Input7 blue part of the

curve’s color (0-255); Input8 contain curve’s type (0-3). 

Example: 

addcurve("Trend", “curve”, “tagname”, 2, 255, 255, 0, 1); 

removecurve(Input1, Input2) - used to remove curve from the trend. Input1 contains name

of the trend; Input2 contains name of the curve; 

Example: 

removecurve("Trend", “curve”); 
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hidecurve(Input1, Input2, Input3) - used to hide or show curve on the trend. Input1 contains

name of the trend; Input2 contains name of the curve; Input3 contains information about hide

or not the curve in the trend. 

Example: 

hidecurve("Trend", “curve”, true); 

6.4.3.11.21  Screen library

callpopup(Input1) - used to call popup screen. Input1 contains name of the popup screen.

Example: 

callpopup(“Screen1").

callscreen(Input1) - used to call screen. Input1 contains name of the screen. 

Example: 

callscreen(“Screen1").

closepopup() - used to close popup screen. 

Example: 

closepopup().

currentscreenname() - used to get current screen name. 

Example: 

string screenname =  currentscreenname().

previousscreenname() - used to get previous screen name. 

Example: 

string screenname =  previousscreenname().

6.4.3.11.22  Files library

createfile(Input1) - used to create file. Input1 contains path to the file. If path contains "/" it

means we use the full path. If path doesn't contain "/" the file will be created in DB  folder of

the application. The function returns TRUE if the file is created.

Example: 

bool created = createfile(“filename.txt”);

Response:

 File is created in the DB  folder of the application.

17

17
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Example: 

bool created = createfile(“D:/filename.txt”);

Response:

File is created in the root of storage D.

deletefile(Input1) - used to delete file. Input1 contains path to the file. If path contains "/" it

means we use the full path. If path doesn't contain "/" the file will be created in DB  folder of

the application. The function returns TRUE if the file is deleted.

Example: 

bool created = deletefile(“filename.txt”);

Response:

File is deleted from the DB  folder of the application.

fileexists(Input1) - used to check file exist or not. Input1 contains path to the file. If path

contains "/" it means we use the full path. If path doesn't contain "/" the file will be created in

DB  folder of the application. The function returns TRUE if the file is exist.

Example: 

bool exist = fileexist(“filename.txt”);

Response:

Check the file with name "filename.txt" exist or not in the DB  folder of the application.

filedatetime(Input1) - used to get time of the file creation. Input1 contains path to the file. If

path contains "/" it means we use the full path. If path doesn't contain "/" the file will be created

in DB  folder of the application. The function returns time of the file creation in milliseconds

since 1 January 1970.

Example: 

Tags.datetime = datetimefrom("yyyy-MM-dd HH:mm:ss",filedatetime(Tags.filename));

Response:

In the tag with name datetime we'll get date time of the file creation with name in the tag with

name filename. (For example: "2020-10-26 12:12:34").

renamefile(Input1, Input2) - used to rename file. Input1 contains path to the file you want to

rename. Input2 contains new path with new name of the file. If path contains "/" it means we

use the full path. If path doesn't contain "/" the file will be created in DB  folder of the

application. The function returns TRUE if the file is renamed successfully.

17
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Example: 

renamefile(“filename.txt”,"D:/newfilename.txt");

copyfile(Input1, Input2) - used to copy file. Input1 contains path to the file you want to copy.

Input2 contains path where you want to copy file. If path contains "/" it means we use the full

path. If path doesn't contain "/" the file will be created in DB  folder of the application. The

function returns TRUE if the file is copied successfully.

Example: 

renamefile(“filename.txt”,"D:/filename.txt");

openfile(Input1) - used to open file. Input1 contains path to the file you want to open. If path

contains "/" it means we use the full path. If path doesn't contain "/" the file will be created in

DB  folder of the application. The function returns TRUE if the file is opened successfully.

Example: 

openfile(“filename.txt”);

closefile() - used to close file. File opened by openfile command is closed.

Example: 

closefile();

checkeof() - used to check end of file. File opened by openfile command is checked. Check

the cursor at the end of file or not.

Example: 

checkeof();

writeline(Input1) - used to write line into the file opened by openfile command. Input1

contains line is going to be written.

Example: 

writeline(“The line is written”);

readline() - used to read line from the file opened by openfile command. The function returns

line in string format.

Example: 

17
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string line = readline();

writebool(Input1) - used to write boolean value into the file opened by openfile command.

Input1 contains boolean value is going to be written.

Example: 

writebool(true);

readbool() - used to read boolean value from the file opened by openfile command. The

function returns boolean value.

Example: 

bool b = readbool();

writebyte(Input1) - used to write byte value into the file opened by openfile command.

Input1 contains byte value is going to be written.

Example: 

writebyte(-34);

readbyte() - used to read byte value from the file opened by openfile command. The function

returns byte value.

Example: 

byte b = readbyte();

writeshort(Input1) - used to write short value into the file opened by openfile command.

Input1 contains short value is going to be written.

Example: 

writeshort(934);

readshort() - used to read short value from the file opened by openfile command. The

function returns short value.

Example: 

short b = readshort();
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writeint(Input1) - used to write int value into the file opened by openfile command. Input1

contains int value is going to be written.

Example: 

writeint(-45934);

readint() - used to read int value from the file opened by openfile command. The function

returns int value.

Example: 

int b = readint();

writelong(Input1) - used to write long value into the file opened by openfile command.

Input1 contains long value is going to be written.

Example: 

writelong(8745934);

readlong() - used to read long value from the file opened by openfile command. The function

returns long value.

Example: 

long b = readlong();

writefloat(Input1) - used to write float value into the file opened by openfile command.

Input1 contains float value is going to be written.

Example: 

writefloat(8.34);

readfloat() - used to read float value from the file opened by openfile command. The

function returns float value.

Example: 

float b = readfloat();

writedouble(Input1) - used to write double value into the file opened by openfile command.

Input1 contains double value is going to be written.
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Example: 

writedouble(9.14);

readdouble() - used to read double value from the file opened by openfile command. The

function returns double value.

Example: 

double b = readdouble();

writestring(Input1) - used to write string value into the file opened by openfile command.

Input1 contains string value is going to be written.

Example: 

writestring("Hello world");

readstring() - used to read string value from the file opened by openfile command. The

function returns string value.

Example: 

string str = readstring();

seek(Input1) - used to move cursor's position in the file opened by openfile command.

Input1 contains offset of the cursor from the beginning.

Example: 

seek(10);

getfilepos() - used to get cursor's position in the file opened by openfile command. The

function returns cursor's position.

Example: 

long pos = getfilepos();

filelength() - used to get length of the file opened by openfile command. The function

returns length of the file in bytes.

Example: 

long len = filelength();



Project 363

© 2023 LLC Tesla

saveproject(Input1) - used to save project to the file. Input1 contains name of the file (works

only on desktop versions).

Example: 

saveproject(“filename.tsp2”);

6.4.3.11.23  Report library

reporttopdf(Input1, Input2) - used to save report to PDF format file. Input1 contains name of

the report. Input2 contains name of the pdf file. Report is saved in the folder you setup in

Project properties->Report folder .

 

Example:

reporttopdf(”Report1","reportfile"); 

reporttoxls(Input1, Input2) - used to save report to Excel format file. Input1 contains name of

the report. Input2 contains name of the Excel file. Report is saved in the folder you setup in

Project properties->Report folder .

 

Example:

reporttoxls(”Report1","reportfile"); 

reporttofile(Input1, Input2) - used to save report to any format file. Input1 contains name of

the report. Input2 contains name of the file. Report is saved in the folder you setup in Project

properties->Report folder . Possible formats: pdf, xls, html, docx, csv, jpg, png, gif, rtf, pptx,

ods, odt

 

Example:

reporttofile(”Report1","reportfile.jpg"); 

reportsendbyemail(Input1, Input2, Input3, Input4) - used to send report by email. Input1

contains name of the report. Input2 contains name of the file saved and then send by e-mail.

Report is saved in the folder you setup in Project properties->Report folder . Possible

formats: pdf, xls, html, docx, csv, jpg, png, gif, rtf, pptx, ods, odt. Input3 contain subject of the

E-mail message. Input4 body of the E-mail message. You E-mail client  should be setup

correctly.

 

Example:

reportsendbyemail(”Report1","reportfile.jpg", "Report title", "Here's report from TeslaSCADA"); 

mergepdffiles(Input1, Input2, Input3, Input4, Input5) - used to merge several pdf files.

Input1 contains name of the destination file. Input2-Input5 contain name of files to merge. Left

"" if you need to merge less then 4 files.

 

Example:

99
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mergepdffiles(”Report","Report1", "Report2", "Report3", "Report4"); 

mergexlsfiles(Input1, Input2, Input3, Input4, Input5) - used to merge several xls files.

Input1 contains name of the destination file. Input2-Input5 contain name of files to merge. Left

"" if you need to merge less then 4 files.

 

Example:

mergexlsfiles(”Report","Report1", "Report2", "Report3", "Report4"); 

6.4.3.11.24  Common RTU and TCP library

commonserverwrite(Input1, Input2) - used to write byte to the common server. Input1

contains name of the server. Input2 contains value to write.

 

Example:

commonserverwrite(”CommonServer", 1); 

commonserverwritearray(Input1, Input2) - used to write byte array to the common server.

Input1 contains name of the server. Input2 contains array to write.

 

Example:

byte bytes[8] = [01,04,00,01,00,02,32,11];

commonserverwritearray(”CommonServer", bytes); 

commonserverwritestring(Input1, Input2) - used to write string to the common server.

Input1 contains name of the server. Input2 contains string to write.

 

Example:

commonserverwritestring(”CommonServer", "Hello"); 

commonserverread(Input1) - used to read byte from the common server. Input1 contains

name of the server.

 

Example:

int value = commonserverread(”CommonServer"); 

commonserverreadarray(Input1) - used to read byte array from the common server. Input1

contains name of the server. 

 

Example:

byte bytes[8] = [00,00,00,00,00,00,00,00];

bytes = commonserverreadarray(”CommonServer"); 

commonserverreadstring(Input1, Input2) - used to read string from the common server.

Input1 contains name of the server.

 If Input2 is true ENTER (/r/n) value is excluded.
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Example:

string text = commonserverreadstring(”CommonServer". true); 

6.4.3.11.25  Call external software

callexternalsoftware(Input1) - used to call external software. Input1 contains command for

calling external software. It depends on OS.

 

Examples:

§ for MacOS: callexternalsoftware("open /Applications/TextEdit.app");

§ for Windows: callexternalsoftware("C:/Progra~1/somesoftware.exe"); 

§ for Android: callexternalsoftware("opc.tesla.scada"); (name of the Android application

package) 

§ for iOS: callexternalsoftware("http://www.youtube.com/watch?v=VIDEO_IDENTIFIER");

(youtube scheme for calling in iOS)

callexternalsoftware2(Input1,Input2) - used to call external software. Input1 contains

command for calling external software. Input2 separator for commands. It depends on OS.

 

Example:

§ for Windows: callexternalsoftware2("C:/Progra~1/somesoftware.exe",";"); 

6.4.3.11.26  User library

adduser(Input1, Input2, Input3, Input4, Input5) -  used to add User to the project. Input1

contains name of the user. Input2 contains password of the user. Input3 contains priority of the

user. Input4 contains access level of the use. Input5 contains other (boolean) user properties.

Input5 represented in Integer format, every bit of which is bound to property:

0 - Control functions. 

1 - Acknowledge events. 

2 - Delete events. 

3 - Insert events. 

4 - Insert history. 

5 - Settings. 

6 - Edit recipes. 

7 - Save control operations. 

8 - Can close.

9 - Can stop.

Example:

adduser("Operator", "111", 950, 200, 1023);

removeuser(Input1) - used to remove user from the project.
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Example:

removuser("Operator");

 

6.4.3.11.27  Push library

sendpush(Input1, Input2) -  send push notifications (Push notifications  should be enabled

and topic should be setup). Input1 contains title of the notification, Input2 contains message of

the notification.

Example:

sendpush("Alarm", "Temperature is too hight");

6.5 Tags

Create tag

To create a new tag select the menu item Project ->New tag or choose Tags  tab on the

Project Window, click right button on it and choose New tag item.

You'll see the tag properties window on tabs:

§ General  - general properties of the tag.

§ Scaling  - properties to setup scaling parameters.

§ Alarms  - properties to setup tag's alarms.

§ History  - properties to setup history parameters for collecting tag's value.

§ Script  - properties if you want to bind script to this tag.

§ Cloud  - properties for TeslaCloud tag representation.

Copy tag

To copy tag on Tags  tab right click on the tag you want to copy and choose Copy tag item. 

Delete tag

To delete tag on Tags  tab right click on the tag you want to delete and choose Delete tag

item. 

Open tag properties

To open tag properties on Tags  tab:

1. Double click on the tag properties which you want to open.

 or 

2. Right click on the tag properties which you want to open and choose Tag properties

item. 
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See Project Window->Tags  tab for more information about possible operation with tags.

6.5.1 General tab

 

List of properties:

Property Description

Group Select group for the tag.

Subgroup Select subgroup for the tag.

Name

Name of the tag.  The name should be unique for the project. You

can use indirect name by using group and subgroup names. To do

this use curve braces {}. For example if group's name is “group”

and subgroup’s name is “1” you can enter {group}{subgroup}

name and you’ll get name of the tag is “group1name”. 

74
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Data type

The user tells the program in what form to store information.

When declaring a new variable, you must specify its type

depending on the range of possible values ??that it can take. It is

especially important to specify the correct data types in very large

projects, as this will have a significant impact on performance. For

example, for a variable that stores integer values ??from 0 to 100,

correctly specify the Byte type instead of Integer. Although the

program will work with both types, in the case of using the Byte

type the variable will occupy 8 bits in memory, instead of 32 bits

when using the Integer type.

Data type
Memor

y
Description Range

Boolean
1 bit

Boolean True (1) or False

(0) values
0...1

Byte 8 bit Signed integers -128…127

Short 16 bit Signed integers -32768…32767

Int 32 bit Signed integers -2147483648…

2147483647

Long 64 bit Signed integers -

9223372036854775

808…

9223372036854775

807

Float 32 bit Floating point numbers 1.18 х 10Е-38…3.4 х

10Е38

Double
64 bit

Floating point numbers 2.23 x 10E-308 …

1.79 x 10E308

String - String

Array
-

Array of elements (Byte,

Short, Int, Float).

Number of elements 
If you select String or Array data types enter number of elements

(letters). 

1 element
 If you select String or Array data types choose data type of 1

element (letter). 

Access mode  Select access mode for the tag: Read, Write or ReadWrite. 

Initial PV
 Enter default tag’s value into Initial PV. In the Initial PV ?eld you

can also use indirect values:{group}, {subgroup} and {name}. 

Access level
If tag's access level greater then access level of the current user the

value couldn't be written to the current tag by this user.
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Input/Output

 In the Input/Output section bind tag to the server’s tag. In the PV

Input server choose server you want to bind. Then click «…»

button to set up server’s tag settings or enter it into the PV Input

tag. In the PV input tag you can use indirect values {group},

{subgroup} and {name}. 

Output differs from

input 

 If the output server’s tag differs from the input server’s tag check

Output differs from input and select PV Output server and enter

PV Output tag. In the PV output tag you can use indirect values

{group}, {subgroup} and {name}. When you check this property,

you can force data to be written to the tag even when it does not

differ from the previous one.

Description
 Description of the tag. In the description you can use indirect

values {group}, {subgroup} and {name}. 

Depending on the type of PV Input server or PV Output server you’ll see different server’s

tag (pointer) settings window:

§ Modbus tag settings.

§ Siemens tag settings .

§ Allen Bradley tag settings .

§ Micrologix tag settings .

§ OPC UA tag settings.

§ MQTT tag settings .

§ Omron tag settings.

§ BACnet tag settings.

§ Raspberry GPIO settings .
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6.5.1.1 Modbus tag settings

List of properties:

Property Description

SlaveID SlaveID of Modbus device.

Point type Point type of the register.

Offset Offset of the Modbus register.

Data type
Data type of the Modbus pointer. The tag's data type overrides the

data type of Modbus pointer during using in project.

Bit  Choose number of bit if the data type of the pointer is binary.

After clicking OK you’ll get pointer settings in PV Input tag encoded in String like:

s=1;pt=3;o=0;dt=2;

Where: 

§ s - SlaveID.

§ pt - Point type. 

§ o - Offset. 

§ dt - Data type.
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6.5.1.2 Siemens tag settings

List of properties:

Property Description

Storage area Choose storage area of the siemens tag: I,Q,M or DB.

DB? Write DB number in the DB?  ?eld if you choose DB storage area.

Data type
Data type of the Siemens pointer. The tag's data type overrides the

data type of Siemens pointer during using in project.

Byte?  Enter byte number of the area into Byte?  ?eld. 

Bit  Choose number of bit if the data type of the pointer is Bit.

After clicking OK you’ll get pointer settings in PV Input tag encoded in String like:

I0.0 [a=0;db=0;dt=0;bn=0;b=0;]

Where: 

§ a - Storage area.

§ db -  DB? . 

§ dt - Data type. 

§ bn - Byte? .

§ b - Bit

(I0.0 - its just for Siemens users and it’s not used in encoding)
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6.5.1.3 Allen Bradley tag settings

List of properties:

Property Description

Tag name Enter tag name.

Data type
Data type of the Allen Bradley pointer. The tag's data type

overrides the data type of AB pointer during using in project.

After clicking OK you’ll get pointer settings in PV Input tag encoded in String like:

type=0;name=Tag

Where: 

§ type - Data type.

§ name -  Tag name. 

6.5.1.4 Micrologix tag settings

If you choose Micrologix or SLC500 controller type in the Allen Bradley server settings you’ll see

the following window:
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List of properties:

Property Description

File type Choose file type of the server’s tag. 

File number Write file number in the ?eld. 

Element  Enter element of the servers tag. 

Word   Choose word for some ? le types. 

Bit  Choose number of bit.

After clicking OK you’ll get pointer settings in PV Input tag encoded in String like:

O0:0

Where: 

§ O - File type.

§ 0 - File number. 

§ 0 - Element.

6.5.1.5 OPC UA tag settings

After clicking «…» button when you choose OPC UA server you’ll get into the Address Space

window. Browse through the address space by double clicking on the nodes and choose the

tag(node) you need by clicking right button on it and choosing Select menu item on the popup

window. You’ll get NodeID in PV Input Tag.
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6.5.1.6 MQTT tag settings

List of properties:

Property Description

Topic Topic of the MQTT server.

QoS  Choose QoS of the MQTT tag. 

 Retained  Check retained if you want to use this property. 

JSON path 

If MQTT response contains JSON array enter JSON path to parse

the value. For example if response is: «{foo: bar, lat: 0.23443, long:

12.3453245}» to get long value enter «long» in the ?eld. If

response is not JSON format left ?eld empty. If response contains

multi dimension JSON format, separate keys by commas without

blank spaces. 

After clicking OK you’ll get pointer settings in PV Input tag encoded in String like:

t=temperature;qos=0;r=1;json= 

Where: 

§ t - Topic.

§ qos -  QoS. 

§ r - Retained. 

§ json - JSON path.
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6.5.1.7 Omron tag settings

List of properties:

Property Description

Area Choose address area.

Address  Address of the tag.

Data type
Data type of the Omron pointer. The tag's data type overrides the

data type of Omron pointer during using in project.

Bit Choose number of bit if the data type of the pointer is binary.

After clicking OK you’ll get pointer settings in PV Input tag encoded in String like:

D00000 [a=0;ad=0;dt=16;] 

Where: 

§ a - Area.

§ ad - Address.  

§ dt - Data type.

§ b - Bit.

(D0000 - its just for Omron users and it’s not used in encoding)

6.5.1.8 BACnet tag settings

After clicking «…» button when you choose BACnet server you’ll get into the Address Space

window. Browse through the address space by clicking on the remote devices and choose the

object you need by clicking right button on it and choosing Select menu item on the popup

window. You’ll get obect identifier in PV Input Tag.
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6.5.1.9 Raspberry GPIO tag settings

List of properties:

Property Description

Pin number Pin number of Raspberry PI GPIO.

Input/Output Use contact as Input or Output.

Type Type of the Input.

After clicking OK you’ll get pointer settings in PV Input tag encoded in String like:

pin=3;o=0;t=1; 

Where: 

§ pin - Pin number.

§ o - Output or Input.  

§ t - Type.
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6.5.2 Scaling tab

List of properties:

Property Description

Enable I/O scaling  Check it if you want to scale a value get from the server field.

Raw value minimum  Enter minimum server tag’s value into this property field. 

Raw value maximum  Enter maximum server tag’s value into this property field. 

EU value minimum
Enter minimum tag’s value in engineer units into this property

field. 

EU value maximum
 Enter maximum tag’s value in engineer units into this property

field.

EU value offset Write tag’s value offset in this property field.

When you get some value from the server application use this formula:

value = (value-rawmin)*(eumax-eumin)/ (rawmax-rawmin)+eumin + offset 
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6.5.3 Alarms tab

List of properties:

Property Description

Enable alarms Check this property if you want to use alarms for this tag. 

HiHi, Hi, Lo, LoLo,

Normal

Check HiHi, Hi, Lo, LoLo or Normal if you want to use the

correspondent alarm(event). 

Limit

Write this property for the correspondent alarm(event). If the value

of the tag plus Deadband will be more than HiHi or Hi limit the

correspondent alarm will be called and be written into Events

database . If the value of the tag minus Deadband will be less

than LoLo or Lo limit the correspondent alarm will be raised and be

written into Events database . 

Priority

Enter this property for the correspondent alarm(event). If the

priority of the alarm(event) is less than value of

Noti?cations(Priority<)  you set in the project properties the

noti?cation dialog will be called. 

Message
 Enter this property for the correspondent alarm(event). In the

message you can use indirect values {group}, {subgroup}, {name}
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and {description}. Also you can use keyword {value} for

displaying current value.

Deadband
Hysteresis to avoid triggering an alarms when the tag value

fluctuates slightly.

Enable OPC UA event 

Check this property if you bind this tag to the OPC UA server

tag(node) and you want to use EventNoti?er of this tag(node).

6.5.4 History tab

List of properties:

Property Description

Enable history Check this property if you want to use history for this tag. 

Storage period(ms)

Enter period of saving values in operating memory or in general

database that you can setup in Project properties->Events/History

tab . For History DB  that are configured in Databases  tab

it doesn't work. For History DB  you setup period of storage in

its properties. 

96 388 80
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Store in DB

Check this property if you want to store data in general history

database that you can setup in Project properties->Events/History

tab . For History DB  that are configured in Databases  tab

you have to add this tag in the Collection. To have possibility to

add tag in the Collection of History DB you no need to check

"Store in DB" property.

Use deadband

Check this property if you want to use hysteresis for storage

history information. If the tag's value minus the last saved tag's

value less than value set in Deadband property the tag's value will

not be saved in the general database. This property works only for

general database that you can setup in Project properties-

>Events/History tab . For History DB it doesn't work.

Deadband This property contains deadband (hysteresis) value.

6.5.5 Script tab

List of properties:

Property Description

96 388 80
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Enable script
Check this property if you want to use script bind to this tag's

value. 

Script Choose script you want to bind to this tag’s value. 

Value  Enter value you want to compare with current tag's value. 

Type
Choose type of the compare operation. Script is executed when

condition becomes TRUE from FALSE.

Deadband

Hysteresis for compare operation. If tag's value plus/minus

deadband greater/less Value (depends on type of the compare

operation) script will be executed.

6.5.6 Cloud

List of properties:

Property Description



TeslaSCADA2 IDE User manual382

© 2023 LLC Tesla

Enable cloud
Check this property if you want to use this tag on the cloud for

web-browser. 

Type Type of the tag's card to represent this tag's value. 

Unit Unit of the tag's value. 

Image
Icon image for the tag's card. You can choose it from the list or

enter name from Material icons list.

Description Description of the tag's card.

Group
Group of the tags. You can sort tags by these groups on the

dashboard.

Minimum Minimum of the tag's value. It's useful for some tag's cards.

Maximum Maximum of the tag's value. It's useful for some tag's cards.

Decimal position Decimal position of the tag's value.

Color

Color of the tag's card elements on the dashboard:

If you click Collection button. You’ll see the window:

Where:

· From -  enter the value from which the object will change color in

the ?eld. 

· To - enter the value to which the object will change color in the

?eld. 

· Color -  choose color for this range. 

You can Add, Edit or Remove collection element of color

conditions. 

Background color

Color of the tag's card background on the dashboard:

If you click Collection button. You’ll see the window:

https://fonts.google.com/icons?icon.set=Material+Icons
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Where:

· From -  enter the value from which the object will change color in

the ?eld. 

· To - enter the value to which the object will change color in the

?eld. 

· Color -  choose color for this range. 

You can Add, Edit or Remove collection element of color

conditions. 

6.6 Users

Create user

User is not a mandatory element of the project. You can use or not use in it. To create a new

user select the menu item Project -> New User or choose Users on the Project Window-

>Users , click right button on it and choose New User item.

You’ll see the following window: 

62
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List of properties:

Property ST script

field*

Description

Name name  Name of the user. 

Password password Write password for the current user.

Access level accesslevel

Access level of the current user. Depending of

this user can be restricted on writing values in

some tag and opening some screens.

Control functions
controlfunction

s

Check this property if you want the user can write

values into the server’s tags.

Acknowledge events 
acknowledgeev

ents

 Check this property if you want the user can

acknowledge events in events database .

Delete events deleteevents
 Check this property if you want the user can

delete events from events database . 

Insert events insertevents

Check this property if you want that during

running application events are inserted into

events database  when the user is logged in.

Insert history inserthistory

Check this property if you want that during

running application history information is

inserted into history database  when the user is

logged in.

Settings settings
 Check this property if you want the user can

enter Settings menu of TeslaSCADA2 Runtime

96
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application.

Edit recipes editrecipes
Check this property if you want the user can Add,

Edit and Delete recipes ?elds.

Save control operation 
savecontrolope

rations

 Check this property if you want to save this user

control operations in events database . (it will

be saved if you check Enable alarms in Tag

properties)

Can stop canstop
Check if you want to let this user to stop

execution of the project.

Can close canclose

Check if you want to let this user to close

application - TeslaSCADA2 IDE or TeslaSCADA2

Runtime

Priority priority
Priority of the user control operations events that

will be save in event database .

* This field is used in ST scripts. For example: Users.Operator0.controlfunctions = 0. After this

script command is executed user with name Operator0 can't write values in the tag.

Open user properties

To open user properties on Users  tab:

1. Double click on the user properties which you want to open.

 or 

2. Right click on the user properties which you want to open and choose User properties

item. 

Copy user

To copy user on Users  tab right click on the user you want to copy and choose Copy user

item.

Delete user

To delete user on Users  tab right click on the user you want to delete and choose Delete

user item.

6.7 Databases

Create database

Database is not a mandatory element of the project. You can use or not use it in the project.

Database consists of 3 types: 
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§ Recipe .

§ History .

§ Odoo ERP . 

Open database properties

To open database properties on Databases  tab:

1. Double click on the database properties which you want to open.

 or 

2. Right click on the database properties which you want to open and choose Database

properties item. 

Copy database

To copy database on Databases  tab right click on the database you want to copy and

choose Copy database item.

Delete database

To delete database on Databases  tab right click on the database you want to delete and

choose Delete database item.

6.7.1 Recipe

To create a new recipe select the menu item Project  and New Database  ->Recipe or

choose Databases  on the Project Window, click right button on it and choose New

Database>Recipe item. You'll see the following window:

List of properties:

Property Description
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Name Name of the recipe.

DB name

Write name of the database for the current recipe. If you

enter the simple name like recipes for example you will

connect to the SQLLite database. The SQLLite database

? le .db will be created in /DB/  folder. If you choose

names beginning with jdbc:mysql: like

jdbc:mysql://192.168.0.104:3306/test the application

will connect to MySQL*  database. if you choose names

beginning with jdbc:sqlserver: like

jdbc:sqlserver://192.168.1.17:1433;databaseName=tes

t where test name of the database you want to connect.

The application will connect to MSSQL*  database. If

you choose names beginning with jdbc:postgresql: like

jdbc:postgresql://192.168.1.17:5432/test where test

name of the database you want to connect. The

application will connect to PostgreSQL*  database.

Table name Write table name of the database for the recipe.

Username Username if needed for MySQL databases. 

Password Password if needed for MySQL database.

Ingredients

Click Collection to ? ll up ingredients of the recipe. After

clicking Collection button you’ll see the following

window:

Where: 

1. Choose Tag you want to bind to the ingredient. 

2. Enter Name of the ingredient. 

3. Enter DB column name for the database. 

4. Enter Unit of the DB ingredient. 

* for mobile device is possible to use only SQLLite databases.
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6.7.2 History DB

To create a new history db select the menu item Project  and New Database  ->History or

choose Databases  on the Project Window, click right button on it and choose New

Database>History item. You'll see the following window:

List of properties:

Property Description

Name Name of the history database.

DB name

Write name of the database for the current history. If you

enter the simple name like hisstory for example you will

connect to the SQLLite database. The SQLLite database

? le .db will be created in /DB/  folder. If you choose

names beginning with jdbc:mysql: like

jdbc:mysql://192.168.0.104:3306/test the application

will connect to MySQL*  database.if you choose names

beginning with jdbc:sqlserver: like

jdbc:sqlserver://192.168.1.17:1433;databaseName=tes

t where test name of the database you want to connect.

The application will connect to MSSQL*  database. If

you choose names beginning with jdbc:postgresql: like

jdbc:postgresql://192.168.1.17:5432/test where test

name of the database you want to connect. The

application will connect to PostgreSQL*  database. 
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Table name Write table name of the database for the recipe.

Username Username if needed for MySQL databases. 

Password Password if needed for MySQL database.

Storage type 

Choose storage type - Time or Tag. If you chose Time

every Save period values of tags included in Ingredients

will be saved into history database. If you choose Tag

values of tags will be saved when Tag's value become

True(1).

Archive since

Select an archive period. The data collected before the

archive period is stored in the archive database. The data

collected for the selected period is stored in the main

database. This improves performance when querying the

underlying database.

Save Period(ms)

Time interval of saving Ingredients tag values into

history database. This property used when you choose

Time Storage type.

Tag

Choose Tag dependent on which value (when value

become True(1)) Ingredients tag values will be saved in

history database. 

Ingredients

Click Collection to ? ll up ingredients of the history. After

clicking Collection button you’ll see the following

window:

Where: 

1. Choose Tag you want to bind to the ingredient. 

2. Enter Name of the ingredient. 

3. Enter DB column name for the database. 

4. Enter Unit of the DB ingredient. 

* for mobile device is possible to use only SQLLite databases.
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6.7.3 Odoo ERP

To create a new Odoo ERP connection (we've tested it only with Odoo 12 and Odoo14 version.

To work with new versions Odoo (13, 14) you have to use TeslaSCADA2 starting from version

2.45.1) select the menu item Project  and New Database  ->Odoo ERP or choose

Databases  on the Project Window, click right button on it and choose New Database>Odoo

ERP item. You'll see the following window:

List of properties:

Property Description

Name Name of the Odoo ERP connection.

Url Url of the Odoo ERP.

Port Port of the Odoo ERP.

DB name Name of the Odoo ERP database.

Username Username for connecting to the Odoo ERP databases. 

Password Password for connecting to the Odoo ERP database.

Refresh type Choose Refresh type to renew data information. 

Refresh period(ms) Refresh period of Odoo ERP information.

Tag
Choose Tag dependent on which value (when value

become True(1)) Odoo ERP information is refreshed.

Models

Click Collection to ? ll up model names of the Odoo ERP.

After clicking Collection button you’ll see the following

window:

62 64
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Where: 

1. Name of the model. 

6.8 Reports

Create report

To create a new report select the menu item Project -> New Report or choose Reports  on

the Project Window, click right button on it and choose New Report item.

You’ll see the report properties  window: 

Open report

To open report on Reports  tab of the Project window: 

1. Right click on the report you want to open and choose Open item. 

or

2. Double click on the report you want to open.

62 81
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Copy report

To copy report on Reports  tab of the Project window right click on the report you want to

copy and choose Copy item. 

Delete report

To delete report on Reports  tab of the Project window right click on the report you want to

delete and choose Delete item.

Open report properties

To open report properties  on Reports  tab of the Project window right click on the report

you want to open and choose Report properties item.

Export report

To export report on Reports  tab of the Project window: 

1. Right click on the report you want to export and choose Export report item.

2.  Now select the location and click the button Save (TeslaSCADA2 screen extension

.tsp2report).

Import report

To import report on Reports  tab of the Project window: 

1. Right click on the report window and choose Import report item. 

2. Now select the report ? le and click Open (TeslaSCADA script extension .tsp2report). 

See Project Window->Reports  tab for more information about possible operation with

reports.
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6.8.1 Report properties

List of report properties:

Property Description

Name Enter name of the report. It should be unique.

Format Select format of the report's pages (A5, A4, A3, A2, A1).

Orientation Orientation of the page - Landscape or Portrait.

Number of Columns Number of columns of the report's table. 

Column space Space between columns of the report's table.

Margin Page margins of the report.

Scripts

 Click  Collection to set up report's scripts . After clicking

you’ll see the window:
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Where:

· Scripts - list of available report type scripts in the

project.

· Add - add script to the collection.

· Remove - remove script from the collection.

Styles

Click  Collection to set up report's styles. After clicking

you’ll see the window:

 

Where:

· Name - name of the style.

· Border width - border width of the report object.

· Horizontal Alignment - horizontal alignment of the

report object.
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· Vertical Alignment - vertical alignment of the report

object.

· Foreground color - foreground color (text color,

border and etc).

· Background color - background color of the report

object.

· Border - border of the report object (Without, Left,

Right...).

· Font - name of the report object's font.

· Font style - style of the font (Bold, Italic...).

· Font size - size of the font.

6.8.2 Design report

To start designing the report you want, you need to double click on it or click right button on

the Project window ->Reports and choose Open report menu item.

You'll see report design window:

66
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Create report object

You can add new report object on the page by clicking  button. Depending on the page's

zone you'll see Add report object. In the table zone you'll see window with tables:

In other zones you'll window:
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Move report object 

You can move report objects by using Drag and Drop technology. You can also move objects

by using context menu and choose direction.
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Erase report object 

You can erase report objects by using context menu and choose Erase menu item.

6.8.3 Other report objects

You can add new report objects on the other (not table) zones of the page by clicking 

button. You'll see window: 
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 Every report object has the following properties:

Property Description

Name Name of the report object. 

Style Style of the report object.
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6.8.3.1 Common report library

Report common library contains:

§ Label  

§ Tag.PV

§ Two Tag.PV values

§ Date and time

§ Two DateTime values

§ Gap

§ Variable

§ Page number

§ Image

§ Object image
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6.8.3.1.1  Label

Property Description

Text Text of the label. 

Width Width of the label.

6.8.3.1.2  Tag.PV

Property Description

Tag Choose tag you want to bind to the object. 

Width Width of the object.

Format Format of tag's value.

Text before Text before tag's value.

Text after Text after tag's value.
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6.8.3.1.3  Two Tag.PV values

Property Description

Tag Choose tag you want to bind to the object. 

Tag Choose second tag you want to bind to the object. 

Width Width of the object.

Format Format of tag's values.

Text before Text before tag's values.

Text between Text between tag's values

Text after Text after tag's values.



Project 403

© 2023 LLC Tesla

6.8.3.1.4  Date and time

Property Description

Tag Choose date time tag you want to bind to the object. 

Width Width of the object.

Format Format of tag's value.

Text before Text before tag's value.

Text after Text after tag's value.
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6.8.3.1.5  Two DateTime values

Property Description

Tag Choose datetime tag you want to bind to the object. 

Tag Choose second datetime tag you want to bind to the object. 

Width Width of the object.

Format Format of tag's values.

Text before Text before tag's values.

Text between Text between tag's values

Text after Text after tag's values.
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6.8.3.1.6  Gap

Property Description

Height Height of the gap. 

Width Width of the gap.

6.8.3.1.7  Variable

Property Description

Variable Choose variable you want to bind to the object. 

Width Width of the object.
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Format Format of variable's value.

Text before Text before variable's value.

Text after Text after variable's value.

6.8.3.1.8  Page number

Property Description

Type Type of the page number. 

Width Width of the object.

6.8.3.1.9  Image

Property Description

Height Height of the image. 

Width Width of the image.
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Image Choose image of the report object.

6.8.3.1.10  Object image

Property Description

Height Height of the image. 

Width Width of the image.

Object
Choose object you want to display in the report. Useful for

trends.
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6.8.3.2 Container library

Container library contains two objects that lets you add other report objects in Vertical and

Horizontal lists.
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6.8.3.3 Chart library

Chart library objects contains objects:

§ Time chart .410
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6.8.3.3.1  Time chart

Property Description

Title Title of the chart.

Title font size Font size of the title's text.

Time period Choose column for time axis.

Time period type Choose period of the time. (Second, Minute, Hour....).

Height Height of the chart. 

Width Width of the chart.

Curves

 Click  Collection to set up chart's curves. After clicking you’ll see

the window:

Where:
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§ Column name - name of the column bind to the curve.

6.8.3.3.2  XY chart

Property Description

Title Title of the chart.

Title font size Font size of the title's text.

X value Choose column for X axis.

X label Enter label for X axis.

Y label Enter label for Y axis.

Height Height of the chart. 

Width Width of the chart.

Curves

 Click  Collection to set up chart's curves. After clicking you’ll see

the window:
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Where:

§ Column name - name of the column bind to the curve.

6.8.4 Table report objects

You can add new table report object on the table's zone of the page by clicking  button.

You'll see window: 

 Every table object has the following properties:

Property Description

Name Name of the report table object. 

Column title style Style of the column titles. 

Start Date and Time Initial time of data taken from the database. 

End Date and Time End time of data taken from the database. 

Highlight Even Row Highlight even rows of the table. 
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6.8.4.1 General history table

General history report table get data from the general history database .

Property Description

Time interval Time interval with which data is taken from the database. 

Columns
 Click  Collection to set up report's columns . After clicking you’ll

see the window:

96
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Where:

· Name - name of the column.

· Title - title of the column.

· Type - type of the column (Tag, DateTime, Row number).

· Tag - choose tag you want to bind to this column.

· Processing type - processing tag's columns values in interval. 

1. FIRST VALUE - take first value from the interval.

2. LAST VALUE - take last value from the interval.

3. MIN VALUE - take minimum value from the interval.

4. MAX VALUE - take maximum value from the interval.

5. AVG VALUE - take average value from the interval.

· Width - width of the column.

· Format - how to format value in the column.

· Styles - choose style for the column.

· Condition styles - condition styles. You can setup it by clicking

Collection:
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Where:

· Name - name of the condition style.

· Column name - name of the column.

· Type - type of the comparison.

· Value - value to the comparison.

· Color - color of the cell when the condition is right.

· Font style - text's font style of the cell when the condition is

right.

Condition styles

Click  Collection to set up condition styles . After clicking you’ll

see the window:

Where:

· Name - name of the condition style.

· Column name - name of the column.

· Type - type of the comparison.

· Value - value to the comparison.

· Color - color of the row when the condition is right.

· Font style - text's font style of the row's cells when the condition

is right.

Variables

Click  Collection to set up variables. After clicking you’ll see the

window:

Where:
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· Name - name of the variable.

· Column name - name of the column.

· Type - type of the variable. 

1. MIN VALUE - minimum value in the column.

2. MAX VALUE - maximum value in the column.

3. AVG VALUE - average value in the column.

4. SUM VALUE - summary value in the column.

6.8.4.2 General events table

General events report table get data from the general events database .

Property Description

Rows style Style of the table's rows. 

From priority The tag's value is used to determine the initial priority.

To priority The tag's value is used to determine the end priority.

Time format Format of the time displayed in the column.

Value format Format of the value displayed in the column.

Condition styles
Click  Collection to set up condition styles . After clicking you’ll

see the window:

96
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Where:

· Name - name of the condition style.

· Column name - name of the column.

· Type - type of the comparison.

· Value - value to the comparison.

· Color - color of the row when the condition is right.

· Font style - text's font style of the row's cells when the condition

is right.

6.8.4.2.1  Columns

General events columns:

Property Description
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Enable (not shown)

Enable or disable correspondent column:

§ Name

§ Time 

§ Type

§ Priority

§ Message

§ Value

§ Ack.time

Title Title of the corresponding column.

Width Width of the corresponding column.

6.8.4.3 History database table

History database report table get data from the history database .

Property Description

History DB Choose History DB you want to bind this history report table.

Time interval Time interval with which data is taken from the database. 

Columns
 Click  Collection to set up report's columns . After clicking you’ll

see the window:

388
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Where:

· Name - name of the column.

· Title - title of the column.

· Type - type of the column (Tag, DateTime, Row number).

· Tag - choose tag you want to bind to this column.

· Processing type - processing tag's columns values in interval. 

1. FIRST VALUE - take first value from the interval.

2. LAST VALUE - take last value from the interval.

3. MIN VALUE - take minimum value from the interval.

4. MAX VALUE - take maximum value from the interval.

5. AVG VALUE - take average value from the interval.

· Width - width of the column.

· Format - how to format value in the column.

· Styles - choose style for the column.

· Condition styles - condition styles. You can setup it by clicking

Collection:
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Where:

· Name - name of the condition style.

· Column name - name of the column.

· Type - type of the comparison.

· Value - value to the comparison.

· Color - color of the cell when the condition is right.

· Font style - text's font style of the cell when the condition is

right.

Condition styles

Click  Collection to set up condition styles . After clicking you’ll

see the window:

Where:

· Name - name of the condition style.

· Column name - name of the column.

· Type - type of the comparison.

· Value - value to the comparison.

· Color - color of the row when the condition is right.

· Font style - text's font style of the row's cells when the condition

is right.

Variables

Click  Collection to set up variables. After clicking you’ll see the

window:

Where:
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· Name - name of the variable.

· Column name - name of the column.

· Type - type of the variable. 

1. MIN VALUE - minimum value in the column.

2. MAX VALUE - maximum value in the column.

3. AVG VALUE - average value in the column.

4. SUM VALUE - summary value in the column.

6.8.5 Reports from trend's and event's dialog boxes

For some graphical objects like Events log , History trends , Recipe table  and others

you can create Reports during running project. You can create 2 types of Reports - Excel

reports and report for printing. See example window:

To get Excel report you have to click Save report… . Then choose ? le to save Excel report and

make some other settings like Title. To get report for printing you have to click Print button.

You’ll see Report settings window:

211 203 217
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In Report settings you can setup some parameters of the report: 

Paper, where: 

1. Format of the paper. 

2. Orientation of the paper. 

3. Paper width and Paper height. 

4. Set Pagination if you want to show page numbers.

Banner, where: 

1. Choose Image of the banner. 

2. Setup Width and Height of the banner. 

3. Setup Horizontal Alignment of the banner. 

4. Use banner For All Pages or not.

Report title, where: 

1. Title caption of the report. 

2. Font of the caption. 

3. Color of the caption. 

4. Horizontal Alignment of the caption.

Report subtitle, has the same Font, Color and Horizontal Alignment parameters like Report

title. Column headers, has the same Font, Color and Horizontal Alignment parameters like

Report title.

And has some other parameters, where: 
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1. Background color of the caption. 

2. Border of the caption. 

3. Vertical Alignment of the caption. 

4. Number of columns using in report. 

5. Group by tag if you want to use report’s grouping. 

Cell properties, has the same Font, Color and Horizontal Alignment parameters like Report

title and Background color, Border and Vertical Alignment parameters like Column

headers. And has some other parameters, where: 

1. Check Highlight Even Row if you want to do it. 

2. Choose Even Row Background. 

3. Set up Save every (…) sec for trends reports for choosing save period.

You can Save this report settings template for this graphical object and then Open… it. To

create report by using these settings click Print. You’ll see Preparing report window. After

some time you’ll see your Report. You can print directly by choosing your printer. Or you can

save this report in some format: pdf, html, csv and others. 

6.9 Simulation

You can simulate behavior of you project. To start simulation select the menu item Project-

>Run simulation  or click button on the Toolbar . If you use users in your project Login

dialog will appear:

Select user and enter password in the ?eld. Now you can simulate your project. 

You can change value of the tag by double clicking on it in the Project window  ->Tags .

Or you can click by right button on the tag and select  Simulate->Set value  menu item. Also

you can simulate behavior of the tag: 

1. Random value - periodically change the value of the tag randomly from 1 to 100.

2. Ramp value - periodically change the tag value from 1 to 100 by adding 1.

By selecting Simulate->Cancel  menu item you annul the task.

Also it’s possible to change value of the tag using control graphical objects of your project like

text , buttons , slider , counter  and etc. For example if you use Text object enable

output property and bind to the tag you want to use. During simulation click on it and enter

value you want.

Also you can simulate behavior of Trend  and Events log  objects. Place these objects on

the Canvas . Set properties of the object as describe in previous chapters. During simulation

trend will be look like this: 

62 64

66 74

76

76

140 157 190 192

203 211

82
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To select start and end time click on it. You’ll see the following dialog. Select times and click OK.

During simulation Events log will be look like this: 

1. To View message in the separate dialog double click on it or click right button on it

and select View menu item. 

2. To acknowledge record click by right button on it and select Acknowledge menu

item. 

3. To acknowledge all records on the table click by right button on the table and select

Acknowledge All menu item. 

4. To delete record click by right button on it and select Delete menu item. 

5. To delete all records on the table click by right button on the table and select Delete

All menu item. 
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You can select records that you want to see in the table. Click on the table's title. You’ll see

Select time and priority conditions dialog. Select start and end times of records displayed in

the table. You can also set records with what priorities will be displayed.
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7 Load on Device

When project is created (screens, servers, tags, scripts and users), the project can be loaded on

the mobile device or other PC. For this purpose, ?rst the corresponding TeslaSCADA Runtime

mobile app on the Android device or PC apps on the Windows, Linux or MAC OS must be

installed and started. 

If the app has now been installed on the mobile device or PC, there are 2 ways to load the

project to the device:

1. Network method. 

2. Manual method.

Network method

This method must, the PC on which the TeslaSCADA IDE is started, and the mobile device or PC

on which TeslaSCADA Runtime started and the project will be stored in a Wi-Fi network (note IP

addresses) are.

Procedure: 

1. Enable WiFi on your mobile device or PC where installed TeslaSCADA Runtime. 

2. Start the TeslaSCADA2 Runtime app. 

3. Open it in the editor TeslaSCADA2 IDE the desired project to be transferred. 

4. Select the menu item File->Load on Device. 

5. It now opens the dialog Load on Device and it will now search for mobile devices with

the active TeslaSCADA2 Runtime. You can start a broadcast search and browse the entire

network. However, since some routers do not forward broadcasts, there is also the

possibility of a speci?c device search on the IP address.  This search takes a normally 5-

10s. In individual cases it may happen that this search can take up to 3 minutes.  If you

can’t ?nd a device you can try to restart Load on Device dialog and TeslaSCADA2

Runtime application:
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6. After a successful search in this dialog box all found mobile devices with active

TeslaSCADA Runtime app will be shown. 

7. Now select the desired target device and press the Load on Device button. 

8. After a successful transfer, the target device with TeslaSCADA2 Runtime load new

project. 

Manual method

Another way to load a project on the mobile device is a ? le explorer such as: the Android File

Transfer for Mac OS. Once the TeslaSCADA Runtime installed mobile app and once started on

the sd card, a folder called Android/dat/tesla.scada2.android/files/Projects is created. Now,

if the project which has been stored as .tsp2 ? le from the Windows, Linux or MacOS system

TeslaSCADA IDE(The path was chosen when you ?rst save of the project) will be manually

copied to the folder of the sd card of the TeslaSCADA Runtime mobile device, the app can be

started normally. Now loads the app, the ? le from this folder by clicking Load on the main

menu of TeslaSCADA Runtime. There is no problem to manually copy to the PC where

TeslaSCADA Runtime is installed. You can use local network, ?ash driver or use any other

storage device.
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8 Import for iOS

When project is created, it can be imported for iOS mobile devices. To do import for iOS

devices you should enter File-> Import for iOS. When you do it Import for iOS window will

appear:

 

To do import project for iOS devices click Import, ? le dialog will appear, enter name of the ? le

and click OK. Import ? le has *.tsp2db extension. This ? le based on SQL database format and

you can open and check it by using software for working with SQL databases. You can also

open imported ? le by clicking Open button. Imported or opened ? le will be appeared in the

text ?eld. To activate project:

1. Choose license type. 

2. Enter license number. 

3. Click Activate button (it will change background colour to the green and «License

available for activation» message will appear). 

4. If you want to deactivate license click Deactivate button (it will change background

colour to the green). 

5. Load project on iOS device. 

6. When loading of the project is completed on iOS device «Activation completed»

message will appear (device should have an Internet access).

If TeslaSCADA2 Runtime has now been installed on the iOS mobile device (iPhone or iPad),

there are 2 ways to load the imported project on the device:

1. Network method. 

2. Manual method. 

Click Load on iOS device to use Network method to load imported ? le on your iOS device.

Network method

This method must, the PC on which the TeslaSCADA IDE is started, and the iOS mobile device

on which TeslaSCADA2 Runtime started and the project will be stored in a Wi-Fi network (note

IP addresses) are.

Procedure:

1. Enable WiFi on your mobile device where installed TeslaSCADA2 Runtime. 

2. Start the TeslaSCADA2 Runtime app. 

3. In TeslaSCADA2 IDE select the menu item File->Import for iOS. 
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4. Open the desired imported project. Click Load on iOS device. 

5. It now opens the dialog Load on iOS Device and it will now search for mobile

devices with the active TeslaSCADA2 Runtime. You can start a broadcast search and

browse the entire 

network. However, since some routers do not forward broadcasts, there is also the

possibility of a speci?c device search on the IP address.  This search takes a normally 5-

10s. In individual cases it may happen that this search can take up to 3 minutes.  If you

can’t ?nd a device you can try to restart Load on iOS Device dialog and TeslaSCADA2

Runtime application on iOS device. 

6. After a successful search in this dialog box all found mobile devices with active

TeslaSCADA2 Runtime app will be shown:

7. Now select the desired target device and press the Load on Device button. 

8. After a successful transfer, the target device with TeslaSCADA2 Runtime load new

project.

Manual method

Another way to load an project on the iOS mobile device is iTunes ->File Sharing. 

Important! For new MacOS versions it's possible to load an project on device by using

Finder.
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1. Open iTunes on your Mac or PC. 

2. Connect your iPhone or iPad to your computer using the USB cable that came with your

device. 

3. Click your device in iTunes.

4. In the left sidebar, click Apps. Then, scroll to the File Sharing section at the bottom of the

page. 

5. Select TeslaSCADA2 Runtime see which ? les are available for sharing in that app on your

device. 

6. Now you can copy your imported project (*.tsp2db) to the documents folder of

TeslaSCADA2 Runtime apps.
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9 Examples

This chapter provides examples of the most commonly used tasks.

Important! For all examples below we'll change properties in Object properties window, but you

can do it in Property sheet  if you want.

9.1 Change the color of an object

Let's consider the most common case when you want to change the color of an object when

the value of its associated variable changes. All of the examples below can be applied to

different colors - fills, borders, text, etc. Below you can find out several examples from common

to more complex with scripts:

§ Common color change

§ Common multiple color change

§ Common multiple color change with scripts

§ Complex color change

§ Complex color change with scripts

9.1.1 Common color change

We create tag with name State:

Depending on the tag's value we want to change fill color of the Rectangle  object (instead

of the Rectangle there can be other objects and instead of the fill color property there can be

other color properties):

82
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432

434

437

441

135
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For example we want to have fill color Red if our (State) tag's value equal 0, and fill color Green

if tag's value not equal 0. We need to enable Fill color property and fill it like this:

Click OK to confirm your changes and Run simulation  to check your settings:

You can download this project here.

9.1.2 Common multiple color change

If we want to multiple change color depending on tag's value we have to choose Tag.PV in

the range type in Fill color property. Let's create like in previous example tag - State:

64

https://teslascada.com/Downloads/Projects/Examples/FillObjectColor.zip
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In this example we use Valve ISA  and change its Fill color depending on the tag's value:

State Color

0 RED

1 GREEN

2 BLUE

3 YELLOW

To do this setup Fill color property:

And setup ranges like this:

170
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Click OK to confirm your changes and Run simulation  to check your settings:

You can download this project here.

9.1.3 Common multiple color change with scripts

If you have to change color depending on several tags you need to use scripts. For example

you have 2 tags for Motor object - State and Speed:

Depending on tag's values for every Motor object use fill color:

State Speed Color

64

https://teslascada.com/Downloads/Projects/Examples/FillMultipleObjectColor.zip
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0 Any RED

1 0...500 GREEN

1 500...1000 YELLOW

1 >1000 BLUE

Let's create Motor  graphical object for our example:

Let's open Object properties window by double clicking on it:

Now we have to create Object type ST script with Execution type - OnDataChange:

174
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Now open Object properties for our Motor object and click Script's collection and add our

script:

Now close Collection window and Object properties by clicking OK to confirm our changes.

And now we can write our script:

Click OK to confirm your changes and Run simulation  to check your settings:64
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You can download this project here.

9.1.4 Complex color change

If your project contains several objects of the same type, then to speed up project

development, it is advisable to use non-unambiguous names when binding tags, but tag

names associated with keywords based on user-defined properties. Let's create several tags for

our example:

Let's create Motor  graphical object for our example:

Let's open Object properties window by double clicking on it:

174

https://teslascada.com/Downloads/Projects/Examples/CommonColorWithScript.zip
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And let's create user-defined property - Number and make it's equal 1:

Close Collection window and then confirm creation of user-defined property by clicking OK on

Object properties window. Then reopen Object properties window and enable Fill color

property on the tab:
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Now we need to bind Tag to the tag with name depending on our property - Number. To do

this click "..." and in Choose tag window enter State{Number} in the Tag name field where

Number is our user-defined property:

Now Fill color property bind to State1 tag and we need to change color depending on this

tag's value:

State1 Color

0 RED
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1 GREEN

2 YELLOW

To do this change Type to Tag.PV in the range:

And fill Ranges:

Confirm changes and close Object properties window by clicking OK. Now we have Motor with

setup Fill color property. To copy this Motor and bind Fill color property to tags - State2 and

State3 you no need to setup Fill color property for every Motor you only have to duplicate

Motor:
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And change Number property of the new Motor in the Property sheet :

Click OK to confirm your changes and Run simulation  to check your settings:

You can download this project here.

9.1.5 Complex color change with scripts

If you have to change color depending on several tags you need to use scripts. For example

you have 2 tags for every Motor object - State and Speed:

82

64

https://teslascada.com/Downloads/Projects/Examples/ComplexColorChange.zip
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Depending on tag's values for every Motor object use fill color:

State Speed Color

0 Any RED

1 0...500 GREEN

1 500...1000 YELLOW

1 >1000 BLUE

Let's create Motor  graphical object for our example:

Let's open Object properties window by double clicking on it:

174
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And let's create user-defined property - Number and make it's equal 1:

Now we have to create Object type ST script with Execution type - OnDataChange:
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Now open Object properties for our Motor object and click Script's collection and add our

script:

Now close Collection window and Object properties by clicking OK to confirm our changes.

And now we can write our script:



Examples 445

© 2023 LLC Tesla

Now we have Motor with setup fill property by script. To copy this Motor and bind fill color

property to tags - State2, Speed2 and State3, State3 you no need to setup script for every

Motor you only have to duplicate Motor:

And change Number property of the new Motor in the Property sheet :

Click OK to confirm your changes and Run simulation  to check your settings:

82

64
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You can download this project here.

9.2 Object flashing

Let's consider the most common case when you want to flash and change its frequency of an

object when the value of its associated variable changes. Below you can find out several

examples from common to more complex with scripts:

§ Common flashing

§ Common multiple flashing

§ Complex flashing with scripts

9.2.1 Common flashing

We create tag with name State:

Depending on the tag's value we want to flash or not Rectangle  object (instead of the

Rectangle there can be other objects):

446

448

450

135

https://teslascada.com/Downloads/Projects/Examples/ComplexColorChangeWithScripts.zip
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For example we want object is not flashing if our (State) tag's value equal 0, and flash with

1000ms frequency if tag's value not equal 0. We need to enable Flash property and fill it like

this:

Click OK to confirm your changes and Run simulation  to check your settings:64
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You can download this project here.

9.2.2 Common multiple flashing

If we want to multiple change flashing depending on tag's value we have to choose Tag.PV in

the range type in Flash property. Let's create like in previous example tag - State:

In this example we use Valve ISA  and change its Flash depending on the tag's value:

State Flash

0 0

1 1000

2 500

3 250

To do this setup Flash property:

170

https://teslascada.com/Downloads/Projects/Examples/CommonFlash.zip
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And setup ranges like this:

Click OK to confirm your changes and Run simulation  to check your settings:64
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You can download this project here.

9.2.3 Complex flashing with scripts

If you have to change flash frequency depending on several tags you need to use scripts. For

example you have 2 tags for every Pump object - State and Speed:

Depending on tag's values for every Motor object use flash frequency:

State Speed Flash frequency

0 Any Not flashing

1 0...500 1000

1 500...1000 500

1 >1000 250

Let's create Motor  graphical object for our example:174

https://teslascada.com/Downloads/Projects/Examples/CommonMultipleFlash.zip
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We need intermediate tags to enable or disable object's flashing - Flash1, Flash2 and Flash3:

Let's open Object properties window by double clicking on it:
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And let's create user-defined property - Number and make it's equal 1:

Close Collection window and click OK to Object properties window. Now reopen Object

properties of the Motor and setup its Flash property. First we need to setup tag and bind it to

Flash tag dependent on the User-defined property - Number. To do this click "..." and setup

Tag name - Flash{Number}:

Flash property setup like in the picture:



Examples 453

© 2023 LLC Tesla

Now we have to create Object type ST script with Execution type - OnDataChange:

Now open Object properties for our Motor object and click Script's collection and add our

script:
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Now close Collection window and Object properties by clicking OK to confirm our changes.

And now we can write our script:

Now we have Motor with setup flash property by script. To copy this Motor and bind flash

property to tags - State2, Speed2 and State3, State3 you no need to setup script for every

Motor you only have to duplicate Motor:

And change Number property of the new Motor in the Property sheet :82
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Click OK to confirm your changes and Run simulation  to check your settings:

You can download this project here.

9.3 Object visibility

Let's consider the most common case when you want to make an object visible or not when

the value of its associated variable changes. Below you can find out several examples from

common to more complex with scripts:

§ Common visibility

§ Complex visibility with scripts

64

456

457

https://teslascada.com/Downloads/Projects/Examples/ComplexFlashWithScripts.zip
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9.3.1 Common visibility

We create tag with name State:

Depending on the tag's value we want to make Rectangle  object visible or not (instead of

the Rectangle there can be other objects):

For example we want object is not visble if our (State) tag's value equal 0, and not visible if

tag's value not equal 0. We need to enable Visibility property and fill it like this:

Click OK to confirm your changes and Run simulation  to check your settings:

135

64



Examples 457

© 2023 LLC Tesla

You can download this project here.

9.3.2 Complex visibility with scripts

If you have to change visibility depending on several tags you need to use scripts. For example

you have 2 tags for every Pump object - State and Speed:

Depending on tag's values every Motor object make visible or not:

State Speed Visibility

0 Any Not visible

1 0...500 Visible

1 500...1000 Visible

1 >1000 Not visible

Let's create Motor  graphical object for our example:174

https://teslascada.com/Downloads/Projects/Examples/CommonVisibility.zip
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We need intermediate tags to enable or disable object's visibility - Visible1, Visible2 and

Visible3:

Let's open Object properties window by double clicking on it:
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And let's create user-defined property - Number and make it's equal 1:

Close Collection window and click OK to Object properties window. Now reopen Object

properties of the Motor and setup its Visibility property. First we need to setup tag and bind it

to Visible tag dependent on the User-defined property - Number. To do this click "..." and setup

Tag name - Visible{Number}:
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Visibility property looks like this:

Now we have to create Object type ST script with Execution type - OnDataChange:
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Now open Object properties for our Motor object and click Script's collection and add our

script:

Now close Collection window and Object properties by clicking OK to confirm our changes.

And now we can write our script:
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Now we have Motor with setup fill property by script. To copy this Motor and bind fill color

property to tags - State2, Speed2 and State3, State3 you no need to setup script for every

Motor you only have to duplicate Motor:

And change Number property of the new Motor in the Property sheet :

Click OK to confirm your changes and Run simulation  to check your settings:

82

64
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You can download this project here.

9.4 Change the text of an object

Let's consider the most common case when you want to change the text of an object when the

value of its associated variable changes. Below you can find out several examples from

common to more complex with scripts:

§ Common text change

§ Common multiple text change

§ Display tag's value

§ Enter tag's value

§ Complex text change with scripts

9.4.1 Common text change

We create tag with name State:

Depending on the tag's value we want to change text of Text/EditField  object (instead of the

Text/EditField there can be other objects with text property):

463

465

467

469

471

140

https://teslascada.com/Downloads/Projects/Examples/ComplexVisibilityWithScripts.zip
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For example we want to have text "Automat" if our (State) tag's value equal 0, and text

"Manual" if tag's value not equal 0. We need to enable Text input property and fill it like this:

Click OK to confirm your changes and Run simulation  to check your settings:64
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You can download this project here.

9.4.2 Common multiple text change

If we want to multiple change text depending on tag's value we have to choose Tag.PV in the

range type in Text input property. Let's create like in previous example tag - State:

In this example we use Text/Edit Field  and change its text depending on the tag's value:

State Text

0 STOP

1 START

2 WARNING

3 DAMAGE

To do this setup Text input property:

140

https://teslascada.com/Downloads/Projects/Examples/CommonText.zip
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And setup ranges like this:

Click OK to confirm your changes and Run simulation  to check your settings:64
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You can download this project here.

9.4.3 Display tag's value

We create tag with name State:

In this example we'd like to display tag's value in Text/EditField  object:

We need to enable Text input property and fill it like this:

140

https://teslascada.com/Downloads/Projects/Examples/CommonMultipleText.zip
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Click OK to confirm your changes and Run simulation  to check your settings:

You can download this project here.

64

https://teslascada.com/Downloads/Projects/Examples/DisplayTextValue.zip
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9.4.4 Enter tag's value

We create tag with name State:

In this example we'd like to enter tag's value in Text/EditField  object:

We need to enable Output value property and fill it like this:

140
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Click OK to confirm your changes and Run simulation  to check your settings:

You can download this project here.

64

https://teslascada.com/Downloads/Projects/Examples/EnterTagsValue.zip
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9.4.5 Complex text change with scripts

If you have to change text depending on several tags you need to use scripts. For example you

have 2 tags for every object - State and Speed:

Depending on tag's values for every Text/EditField object use texts:

State Speed Text

0 Any Pump is stopped

1 0...500 Pump speed is normal: PV

1 500...1000 Warning! Pump speed is high: PV 

1 >1000 Dangerous!!! Pump speed is too high.

Let's create Text/EditField  graphical object for our example:

Let's open Object properties window by double clicking on it:

140
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And let's create user-defined property - Number and make it's equal 1:

Now we have to create Object type ST script with Execution type - OnDataChange:
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Now close Collection window and Object properties by clicking OK to confirm our changes.

And now we can write our script:

Now we have Text with setup text by script. To copy this Text and bind text property to tags -

State2, Speed2 and State3, State3 you no need to setup script for every Text you only have

to duplicate Text:

And change Number property of the new Text in the Property sheet :82
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Click OK to confirm your changes and Run simulation  to check your settings:

You can download this project here.

9.5 Call popup

This chapter contains examples of project to call popup windows:

§ Complex call popup with scripts

9.5.1 Complex call pupup with scripts

For example we've got some complex group object:

64

474

https://teslascada.com/Downloads/Projects/Examples/ComplexTextChangeWithScripts.zip
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Let's name it - FBMotorAOVentil. It consists from several primitives objects - Rectangle ,

Ellipse , Polygon , Image , Text/EditField  and over these objects we've placed

transparent Button  - CallPopup:

How to group object you can find out in the chapter - Example: How to create new graphical

object . In our current example this object is bound to several tags:

To make the scaling of this project more easy and have possibility to copy this group of tags

faster for next similar object we've bound name of tags to the group by using {group}

keyword. Example:

135

135 137 142 140

158

247
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We'd like to call popup screen by click on this group object (click on transparent button -

CallPopup to be exactly) and display all properties in proper fields. Our popup window looks

like this:

We also create tags for this popup window:
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To have possibility to send some information from group object to popup window we can

create user-defined properties:

The main user-defined property is objectname. In our case it's equal VE01. For other objects

you can change only this property to bind to other group of tags. Now we have to call popup

window and send our user-defined properties to it. To do this enable Control property:
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In Command and args field we put our user-defined tags into bundle of global arguments.

Now we can create first script that will be called when our popup window is opened:

Text of this script here:
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Next script we create to catch changes in popup tags and set value of group object's tag, and

reverse to catch changes value of group object's tag and set value of popup tags:

Text of this script here:

Now add this script add to our popup window:
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And now let's check how it works:

You can download this project here.

9.6 HTTP requests

In TeslaSCADA2, you can make HTTP POST / GET requests to third-party servers to read data

from them. Below are examples of receiving data from some popular HTTP servers. To use this

possibilities you can study HTTP library . Below examples of working this with this library:

§ Weather from weatherstack.com

9.6.1 Weather from weatherstack.com

weatherstack.com has a convenient API for reading weather data. After registering on the site,

you will receive a unique access key (API Access Key), which must be used in GET requests to

352

480

https://teslascada.com/Downloads/Projects/Examples/ComplexPopupExampleWithScripts.zip
https://weatherstack.com
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obtain weather data. In the weatherstack documentation, we look at examples of requests and

compose a request, for example, for Berlin it should be like this:

http://api.weatherstack.com/current?
access_key=API_ACCESS_KEY&query=Berlin

instead of API_ACCESS_KEY, you need to insert the access key received during registration.

Note, if you need to pass a parameter containing a space, for example "New York", then the

space must be replaced with "% 20", i.e. "New% 20York". You can verify the correctness of the

request by pasting it into the address bar of your browser:

The browser displayed a response with correct data, which means the request was composed

correctly. As you can see, the response is sent in JSON format, later we will extract the

properties we need from it. Now you can start solving the problem in TeslaSCADA2. First, let's

create an interface in the project. The temperature, pressure, wind, humidity and local time will

be displayed in the Text/EditField  components. In the CityName Text/EditField component

we enable Output value  property to have possibility to change city name. The image below

shows the created interface and the names we gave to the components:

Every Text  object we bound to the tags:

140

269

140

http://api.weatherstack.com/current?access_key=API_ACCESS_KEY&query=Berlin
http://api.weatherstack.com/current?access_key=API_ACCESS_KEY&query=Berlin
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Now we can create ST script that we'll be executed when you click on every screen:

 

The text of ST script below:
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Change API_ACCESS_KEY to your key that you get from site. And now let's check how it works:

You can download this project here.

9.7 Trends

Below examples how to work with history and trends:

§ Common trend example

§ Trend example with Y axis change

§ Add and remove curve to/from trend dynamically

484

488

491

https://teslascada.com/Downloads/Projects/Examples/weather.zip
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9.7.1 Common trend example

Let's create tag with name Tag1 that will collect all information in general SQLLite database :26
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We want to display this history information on the database Trend. Let's place on the screen

Trend DB  object:203
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Let's add our tag to the Trend. To do this open Trend DB properties by double clicking on the

object:

And click Curves->Collection button:
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Click Close to close Collection window and OK to confirm your changes and Run simulation

to check your settings:

You can download this project here.

9.7.2 Trend example with Y axis change

In trends we can choose time interval by clicking on it during running project and calling "Select

the start and end time":

64

https://teslascada.com/Downloads/Projects/Examples/TrendSimpleExample.zip
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If we want to change Y axis range we need to use scripts.

Let's use the project from our previous example . 

Let's create tag max to change maximum of trend's range:

Let's place on our screen Slider  on the screen and bind tag max to the Control property of

this object:

484

190
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And now let's bind tag max to the Trend's maximum property by using ST script. Let's create

script:

This script will be called when value of the tag max is changed. The text of the script below:

 Let's Run simulation  to check your settings:64



Examples 491

© 2023 LLC Tesla

You can download this project here.

9.7.3 Add and remove curve to/from trend dynamically

If we want to add and remove curves to/from trend dynamically you also have to use scripts.

First let's create 2 tags based on Tag1 from previous example . Name them Tag2 and Tag3.

Second let's create 2 tags - Add and Remove. When value of these tags are changed from

FALSE to TRUE we add or remove curve.

Third let's create tag - Number. This tag will contain information about which tag we want to

add or remove. All our tags looks like below:

Let's bind Add and Remove tags to the Control property  of the Button :

484

265 158

https://teslascada.com/Downloads/Projects/Examples/TrendAxisY.zip
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Let's bind tag Number to the ComboBox  object and fill up ranges collection by tag's names:193
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Now let's create 2 scripts for adding and removing curves:
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Below text of the script to add curve. We use addcurve function from Trend's curve library :356
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Below text of the script to remove curve:

We need to bind these scripts to the tags- Add and Remove:

Now when we click buttons Add and Remove we call correspondent scripts. 

Let's Run simulation  to check your settings:64
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You can download this project here.

9.8 Change tag's value

The simplest way to change tag's value is to use Buttons. Also you could use Text/EditField. The

example you can find here . Also you could use for this purposes objects from Controls

library . For more complex task you could use scripts:

§ Change values of 2 tags by one click

§ Write value when screen is opened and closed

9.8.1 Change values of 2 tags by one click

In this example we will show how to change values of 2 tags by one click. Let's create 2 tags -

Tag2 and Tag3. We will change the values of these tags at the same time by clicking buttons.

These buttons will toggle other tags - write0 and write10. Tags look like below:

Let's bind the tags write0 and write10 to two buttons:

469

189

496

499

https://teslascada.com/Downloads/Projects/Examples/TrendAddRemoveCurve.zip
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Let's create 2 scripts that will be called when values of these 2 tags toggled from FALSE to

TRUE:

And let's bind these 2 scripts to tags - write0 and write10:
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Now when tags write0 and write10 are toggled from FALSE to TRUE the appropriate script is

called.  

Let's Run simulation  to check the settings:

You can download this project here.

64

https://teslascada.com/Downloads/Projects/Examples/write2tags.zip
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9.8.2 Write value when screen is opened and closed

In this example we will show how to write value when screen is opened and closed. Let's create

tag with name Tag:

Let's create 2 screens - General and Popup. On the general screen let's place button that will

open Popup screen and on the popup screen let's place button to close popup screen:

Let's create 2 Screen type scripts. One is executed when popup screen is opened. Second is

executed when popup is closed:
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Texts of the scripts:

Let's add these scripts to the Collection of the Popup screen:
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Let's Run simulation  to check the settings:

You can download this project here.

9.9 IOT clouds

Examples of working with clouds:

· IBM Watson IOT

· Yandex cloud

64

502

523

https://teslascada.com/Downloads/Projects/Examples/closepopup.zip
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9.9.1 IBM Watson IOT

IBM Cloud is a variety of different services. In this example we'll require only one service is
Watson IoT. In the given example TeslaSCADA2 Runtime reads data from Modbus device and
sends them to IBM Cloud via MQTT protocol in JSON format by using MQTT publisher.

Free (Lite) plan of "Watson IoT" can be used for testing. It includes:
· up to 500 devices,
· up to 500 connections,
· monthly limits
o up to 200 Mb of traffic,
o up to 200 Mb of analized data
o up to 200 MB of locally analized data (Edge).

More:
· Watson IoT (in English)

Setting IBM Watson IoT

To connect to IBM Watson IoT platform, it is required: to get IBM Cloud (IBMid) account.

Creating IBM Watson IoT instance

1 Enter your account and go to Dashboard. Click «Create Resource» button.

https://console.bluemix.net/catalog/services/internet-of-things-platform
https://console.bluemix.net/registration/
https://console.bluemix.net/dashboard/apps
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2 Select Internet of Things category and click Internet of Things Platform.

3 Select a region in the parameters, for example, US South (more functions are available for
this region).

4 Select buying plan (for example, Lite) and click «Create» button:
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5 The added service is displayed in the list on the dashboard. Click «Launch» button in the
window that appears.
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6 A panel to control IoT Platform opens in a new window.
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Adding devices

1 Go to Devices tab on the dashboard of IoT Platform.

2 Click «Add Device» buttom to add a device.
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3 Set Device Type and Device ID in the window that appears and click «Next».

4 Enter information about the device and click «Next».
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5 Add a group (you can skip this step), click «Next».

6 Create a token in Security window for authentification (if the fields is left empty, the token is
generated automatically). Click «Next».
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7 See the result of creating a device and click «Done».
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8 A message appears that a device was registered and you'll get information to connect the
device to the platform. It the token field was left empty, you'll get an automatically generated
token.
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 Authentification token (password) is given only once. Save it.
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Setting MQTT publisher

1. Enable MQTT publisher. And setup it:

· Broker URL - address and port of the IoT cloud interface, it is coded the following way:
ssl://<your_orgID>.messaging.internetofthings.ibmcloud.com:8883

· Username - login, use-token-auth fixed value must be entered here

· Password - created or generated Authentication Token

· Client ID - client identificator is coded this way:
d:<your_orgID>:<your_Type>:<your_Device>

· Write topic format - format of writing tags in the topic:
iot-2/evt/{tagname}/fmt/txt  
{tagname} - name of tags in your project. 

· Read topic format - format of reading tags in the topic:
iot-2/cmd/{tagname}/fmt/txt  
{tagname} - name of tags in your project.
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· QoS - type of the MQTT message.

2. Create Modbus server. And setup it:
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3. Create 2 tags and bind to 2 first registers. And setup it:
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Now when you run this project in TeslaSCADA2 Runtime. It's connecting to the cloud and

publish tags values in the cloud:

In the simulator:
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In the project:

In the cloud:
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Setting MQTT server

1. For getting information from the cloud we have to create Application in IOT Watson

(russian language):

2. Now we can create MQTT server in the new project:
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· URI - address and port of the IoT cloud interface, it is coded the following way:
ssl://<your_orgID>.messaging.internetofthings.ibmcloud.com:8883

· Username - login, It is coded in the following way:
{api key} - you can see it in the picture. It contains a -{your_orgID}-{code}. In the picture

other {your_orgID}. Should be eeptot.
· Password - created or generated Authentication Token

· Client ID - client identificator is coded this way:
d:<your_orgID>:<name of the application>

3.Create 2 tags for reading from the cloud:
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The format of the topic is interesting for us:

iot-2/type/{device_type}/id/{device_id}/evt/{event_id}/fmt/{format_string}
device_type - type of the device
device_id - ID of the device
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event_id - name of the Tag you setup in project with publisher.
format_string - format of the topic.(txt in our case).

For writing topic should like this: 
iot-2/type/{device_type}/id/{device_id}/cmd/{cmd_id}/fmt/{format_string}

4. In some reasons when you connect to IBM cloud and subscribe to the topics values
are not renew.
We create some possibility to renew values. You have to create tag in the MQTT to
refresh publisher:
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Topic should look like this: iot-2/type/TeslaSCADA/id/1/cmd/refreshpublisher/fmt/txt
cmd_id -  refreshpublisher
5. After starting project with MQTT client and refresh values we'll get:
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9.9.2 Yandex cloud

Yandex IoT Core is a cloud-based fail-safe MQTT broker that ensures secure two-way
communication between devices and local or cloud resources.

Devices and registries interact using X.509 certificates:

· If you have a certificate, just add it to the device in the registry.

· If don't have one, you can create a certificate, for example, with OpenSSL:

openssl req -x509 \

-newkey rsa:4096 \

-keyout key.pem \

-out cert.pem \

-nodes \

-days 365 \

-subj '/CN=localhost'

Create registry

https://www.openssl.org/
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You also have to add certificate you created.

Create device

Setup MQTT publisher
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Where:

Username - Device ID

Password - password of the device.

Write topic format - in our case $devices/arei326ajtmuvr4v26ve/events/{tagname}. 

It contains ID of the device and keyword {tagname} for publishing tag's values.

Read topic format - in our case $devices/arei326ajtmuvr4v26ve/commands/{tagname}

It contains ID of the device and keyword {tagname} for subscribing to tag's values.

Certificate filename - you have to download certificate file from here: 

https://cloud.yandex.com/en/docs/iot-core/concepts/mqtt-properties

And place this file in the folder private where installed TeslaSCADA2 Runtime.

Now when you run the project created with this MQTT publisher settings all tags values used in this project will be published in the broker.

The published values don't have retain properties.

Setup MQTT client

To read data from the Yandex IOT we create new project and setup MQTT server:

https://cloud.yandex.com/en/docs/iot-core/concepts/mqtt-properties
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Where:

Username - Registry ID

Password - password of the registry.

Certificate filename - you have to download certificate file from here: 

https://cloud.yandex.com/en/docs/iot-core/concepts/mqtt-properties

And place this file in the folder private where installed TeslaSCADA2 Runtime.

Setup Tag

https://cloud.yandex.com/en/docs/iot-core/concepts/mqtt-properties


Examples 527

© 2023 LLC Tesla

PV Input tag
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It contains ID of the device you setup in Yandex IOT core, keyword events and name of the tag you want to read from the publisher project.

PV Output tag

It contains ID of the device you setup in Yandex IOT core, keyword commands and name of the tag you want to write to the publisher project.

Now you can read values from the Yandex cloud by using this project. And write commands also.
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